BenchCel Microplate Handler

User Guide

Original Instructions
Notice

Manual Part Number
G5880-90000 Revision B
November 2020

Copyright
© Agilent Technologies, Inc. 2020
No part of this manual may be reproduced in any form or by any means (including electronic storage and retrieval or translation into a foreign language) without prior agreement and written consent from Agilent Technologies, Inc., as governed by United States and international copyright laws.

Contact Information
Agilent Technologies Inc.
Automation Solutions
5301 Stevens Creek Blvd.
Santa Clara, CA 95051
USA
Web: https://www.agilent.com
Contact page: https://www.agilent.com/en/contact-us/page
Documentation feedback: documentation.automation@agilent.com

Acknowledgments
Microsoft® and Windows® are either registered trademarks or trademarks of the Microsoft Corporation in the United States and other countries.

Warranty
The material contained in this document is provided “as is,” and is subject to being changed, without notice, in future editions. Further, to the maximum extent permitted by applicable law, Agilent disclaims all warranties, either express or implied, with regard to this manual and any information contained herein, including but not limited to the implied warranties of merchantability and fitness for a particular purpose. Agilent shall not be liable for errors or for incidental or consequential damages in connection with the furnishing, use, or performance of this document or of any information contained herein. Should Agilent and the user have a separate written agreement with warranty terms covering the material in this document that conflict with these terms, the warranty terms in the separate agreement shall control.

Technology Licenses
The hardware and/or software described in this document are furnished under a license and may be used or copied only in accordance with the terms of such license.

Restricted Rights Legend
If software is for use in the performance of a U.S. Government prime contract or subcontract, Software is delivered and licensed as "Commercial computer software" as defined in DFAR 252.227-7014 (June 1995), or as a "commercial item" as defined in FAR 2.101(a) or as "Restricted computer software" as defined in FAR 52.227-19 (June 1987) or any equivalent agency regulation or contract clause. Use, duplication or disclosure of Software is subject to Agilent Technologies’ standard commercial license terms, and non-DOD Departments and Agencies of the U.S. Government will receive no greater than Restricted Rights as defined in FAR 52.227-19(c)(1-2) (June 1987). U.S. Government users will receive no greater than Limited Rights as defined in FAR 52.227-14 (June 1987) or DFAR 252.227-7015 (b)(2) (November 1995), as applicable in any technical data.

Safety Notices

WARNING
A WARNING notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in personal injury or death. Do not proceed beyond a WARNING notice until the indicated conditions are fully understood and met.

CAUTION
A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in damage to the product or loss of important data. Do not proceed beyond a CAUTION notice until the indicated conditions are fully understood and met.
# Contents

**Preface**  
About this guide                                      vi  
Accessing product user information                   viii

## 1. Safety guidelines

General safety information                            2
Safety and regulatory compliance                      3
Emergency stops                                       5
Safety equipment and features                         8
Potential safety hazards                               10

## 2. Introduction

BenchCel Microplate Handler description               14
Hardware overview                                     15
Integration options for workstations                  25
Labware considerations                                27
Software description                                  29

## 3. Installing BenchCel Microplate Handler

Installation workflow                                  36
Verifying laboratory requirements                     37
Unpacking BenchCel Microplate Handler                 42
Mounting the robot                                    44
About integrating devices in a BenchCel Workstation    47
Connecting the power source                           50
Connecting the pendant directly to the BenchCel device 51
Connecting the pendant through the Robot Disable Hub   53
Connecting and disconnecting the air source           55
Connecting the computer                               57
Installing the shield                                  61

## 4. Setting up the BenchCel device

Setup workflow                                         64
Starting up and shutting down                         66
Creating BenchCel device in the VWorks software       68
Opening BenchCel Diagnostics                          73
Creating profiles                                     76
Initializing the device                               82
Setting and managing teachpoints                      84
# Contents

5. Setting sensor thresholds ................................................................. 99
   - Overview for setting sensor thresholds ........................................ 100
   - Calculating the Plate presence threshold ................................... 102
   - Determining the optimum Orientation sensor offset ..................... 107
   - Calculating the Orientation threshold ....................................... 111
   - Worksheet for setting sensor thresholds .................................. 113

6. Preparing for a run ........................................................................ 115
   - Workflow for operating the BenchCel Microplate Handler ............. 116
   - Handling the labware racks ......................................................... 117
   - Filling and emptying the labware racks ..................................... 119
   - Installing and uninstalling the labware racks ............................ 123
   - Performing pre-run checks ......................................................... 128

7. Maintenance and troubleshooting .................................................. 129
   - Routine maintenance ................................................................. 130
   - Cleaning up after a protocol run ............................................... 132
   - Replacing the fuse ...................................................................... 134
   - Hardware problems .................................................................... 137
   - Software error messages ............................................................ 139
   - Diagnostic tools ......................................................................... 146
   - Adjusting the stacker gripper pressure ....................................... 158
   - Reporting problems .................................................................... 162

A. Quick reference ............................................................................. 165
   - Rack-release button indicator light ............................................ 166
   - BenchCel Diagnostics - Controls tab ........................................ 167
   - BenchCel Diagnostics - Jog/Teach tab ....................................... 170
   - BenchCel Diagnostics - Labware tab ......................................... 173
   - BenchCel Diagnostics - General Settings tab ............................. 178
   - BenchCel Diagnostics - Profiles tab .......................................... 179
   - Teachpoint Details dialog box ..................................................... 182
Preface

This preface contains the following topics:

- “About this guide” on page vi
- “Accessing product user information” on page viii
About this guide

Who should read this guide

This user guide is for people with the following job roles:

<table>
<thead>
<tr>
<th>Job role</th>
<th>Responsibilities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installer</td>
<td>Unpacks, installs, and tests the device before it is used.</td>
</tr>
<tr>
<td>Integrator</td>
<td>Configures hardware and writes software.</td>
</tr>
</tbody>
</table>
| Lab manager, administrator, or technician | • Manages the automation system that contains the device  
• Develops the applications that are run on the system  
• Develops training materials and standard operating procedures for operators |
| Operator                | Performs the daily production work on the device and solves routine problems.     |

What this guide covers

This guide describes the G5580A BenchCel Microplate Handler and earlier R-Series models. This guide covers installation, setup, operation, and maintenance.

This guide does not provide instructions for the following:

• Agilent devices that are integrated with the BenchCel Microplate Handler in a workstation configuration, such as the Bravo Platform, PlateLoc Thermal Microplate Sealer, Microplate Labeler, and Labware MiniHub
• Third-party devices

For more information about these topics, see the relevant user guides for these products.

Software version

This guide is applicable for the following software:

• BenchCel Diagnostics 21.3.0, which is included in VWorks software 14.0 and later.
• BenchCel Diagnostics versions included in VWorks software 12.3 – 13.1.x.

What is new in this edition

<table>
<thead>
<tr>
<th>Description</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Added descriptions for VWorks software 14.0.</td>
<td>“Software description” on page 29</td>
</tr>
</tbody>
</table>
Related guides

You should use this guide in conjunction with the following guides:

- **Automation Solutions Products General Safety Guide.** Provides general safety information and describes potential safety hazards that you might encounter when using Automation Solutions products. A copy of this safety guide is included with your shipment.

- VWorks software guides:
  - **VWorks Automation Control Setup Guide.** Explains how to define labware and labware classes, liquid classes, and pipetting techniques.
    The VWorks 14.0 version also explains the VWorks compliance features and how to set up an experiments databases.
  - **VWorks Automation Control User Guide.** Explains how to create protocols, and set task parameters for each device in the system.

- **BenchCel Microplate Handler Quick Guide.** The quick guide summarizes the instructions in this user guide.

- **Agilent Technologies device user guides.** These guides explain how to set up and use the devices that you integrate with the BenchCel Microplate Handler, such as the **Bravo Platform User Guide**.

- **Third-party device user documents, if applicable.** These guides explain how to set up and use the third-party devices.
Accessing product user information

About this topic

This topic describes the different formats of user information and explains how to access it for the Agilent Automation Solutions products.

Where to find user information

The user information is available in the following locations:

- **Knowledge base.** The help system for the Automation Solutions products is available from:
  - Help menu within the VWorks software: Select **Help > Knowledge Base** or press F1.
  - From the Windows desktop: Select **Start ( ) > All Apps > Agilent Technologies > VWorks Knowledge Base.**

  For guidelines on using the VWorks context-sensitive help and knowledge base features, see **Using the knowledge base**, below.

- **PDF files.** The PDF files of the user guides are installed with the VWorks software (C:\Program Files (x86)\Agilent Technologies\VWorks\UserGuides) and are available in the VWorks Knowledge Base.

- **Website.** You can search the online VWorks Knowledge Base or download the latest version of any PDF file from the Agilent website at www.agilent.com/chem/askb.

Accessing safety information

Safety information for the Agilent Automation Solutions devices appears in the **Automation Solutions Products General Safety Guide** and in the corresponding device safety guide or user guide.

You can also search the knowledge base or the PDF files for safety information.

Using the knowledge base

Knowledge base topics are displayed using web browser software such as Microsoft Edge.

**Note:** If you want to use Internet Explorer to display the topics, you might have to allow local files to run active content (scripts and ActiveX controls). To do this, in Internet Explorer, open the Internet Options dialog box. Click the Advanced tab, locate the Security section, and select Allow active content to run in files on my computer.
Opening the help topic for an area in the VWorks window

To access the context-sensitive help feature:

1. In the main window of the VWorks software, click the help button 🔄. The pointer changes to �<option>. Notice that the different icons or areas are highlighted as you move the pointer over them.
2. Click an icon or area of interest. The relevant topic or document opens.
### Features in the Knowledge Base window

1. **Contents pane.** Lists all the books and the table of contents of the books.

2. **Search.** Allows you to search the Knowledge Base (all products or selected products) using keywords.

3. **Topic area.** Displays the selected online help topic.

4. **Navigation buttons.** Enable you to navigate through the next or previous topics listed in the Contents tab.

5. **Toolbar buttons:** Enable you to:
   - Expand or collapse all the sections in a topic that has drop-down headings.
   - Print the topic.
   - Send feedback by email for a given topic.
1 Safety guidelines

This chapter contains the following topics for the BenchCel Microplate Handler:

- "General safety information" on page 2
- "Safety and regulatory compliance" on page 3
- "Emergency stops" on page 5
- "Safety equipment and features" on page 8
- "Potential safety hazards" on page 10
General safety information

Before installing and using the device

Before using the BenchCel Microplate Handler, make sure that you are properly trained in:

- General laboratory safety
- The correct and safe operation of the BenchCel Microplate Handler
- The correct and safe operation of devices used in combination with the BenchCel Microplate Handler

**WARNING**

Changing or modifying the BenchCel safety equipment may prevent the safe operation of the BenchCel Microplate Handler, invalidate its safety compliance, and lead to personal injury or property damage. Any customer who does not use the supplied safety equipment or who modifies the supplied safety equipment assumes full responsibility for providing an appropriate level of safety for its operators and for providing the applicable safety compliance marking and documentation.

General safety precautions

For the general safety precautions, the intended product use statement, and the list of safety labels, see the Automation Solutions Products General Safety Guide.

The following figure shows the location of the safety label on the BenchCel Microplate Handler.

*Figure*  Safety label location (front view and side view)
Safety and regulatory compliance

About this topic

This topic lists the compliance regulations and standards for the BenchCel Microplate Handler.

Note: Earlier models of the BenchCel Microplate Handler may not comply with all the standards listed in this topic.

Compliance information

The BenchCel Microplate Handler is considered partly completed machinery as defined by the Machinery Directive of the European Union. Therefore, the BenchCel Microplate Handler is provided with a Declaration of Incorporation and no CE marking. The BenchCel Microplate Handler is intended to be integrated into a conforming completed machine (workstation). A customer in the European Union (EU) that acquires a standalone BenchCel Microplate Handler is responsible for this integration and for CE marking the completed workstation. The BenchCel Microplate Handler is designed to comply with the standards listed in the table below.

Unless specifically requested by the customer, BenchCel Workstations provided by Agilent Technologies are configured to conform to the Machinery Directive and bear the CE marking. The Declaration of Conformity shipped with the BenchCel Workstation describes the specific configuration that has been evaluated for conformity. Any deviations from the specified configuration may invalidate the Declaration of Conformity. See the Declaration of Conformity for details.

An EU customer that requests Agilent Technologies to provide a nonconforming BenchCel Workstation must assume responsibility as the manufacturer for completing the workstation in conformity with the applicable directives, including the Machinery Directive. In the case of a nonconforming BenchCel Workstation, each component that Agilent Technologies supplies will carry a Declaration of Conformity or Declaration of Incorporation, as appropriate, to be used by the manufacturer to compile the technical construction file.
Electromagnetic compatibility
If the BenchCel Microplate Handler causes interference with radio or television reception, which can be determined by turning the device off and on, try one or more of the following measures:

- Relocate the radio or television antenna.
- Move the device away from the radio or television.
- Plug the device into a different electrical outlet, so that the device and the radio or television are on separate electrical circuits.
- Make sure that all peripheral devices are also certified.
- Make sure that appropriate cables are used to connect the device to peripheral equipment.
- Consult your equipment dealer, Agilent Technologies, or an experienced technician for assistance.

Changes or modifications not expressly approved by Agilent Technologies could void the user's authority to operate the equipment.

Sound emission declaration
Sound pressure: $L_p < 70\,\text{dB}$ according to EN ISO 779:2010.

Related information

<table>
<thead>
<tr>
<th>For more information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>General safety and labels</td>
<td>“General safety information” on page 2</td>
</tr>
<tr>
<td>Safety hazards</td>
<td>“Potential safety hazards” on page 10</td>
</tr>
<tr>
<td>Stopping in an emergency</td>
<td>“Emergency stops” on page 5</td>
</tr>
<tr>
<td>Safety equipment</td>
<td>“Safety equipment and features” on page 8</td>
</tr>
</tbody>
</table>

Emergency stops

The BenchCel Microplate Handler is equipped with an interlock circuit and emergency-stop pendant.

**WARNING**

To avoid potential injury, Agilent recommends that you install a main emergency stop button (Robot Disable Hub) that will stop the BenchCel robot and all other devices on the safety interlock circuit simultaneously. In addition, all operators must be instructed in the emergency stop procedure.

**CAUTION**

You might not be able to resume a protocol after an emergency stop. Do not use an emergency stop to pause a run. To pause and continue a run, use the appropriate commands in the automation software.

Stopping in an emergency

**WARNING**

After pressing the emergency-stop button, the robot arm might have momentum and continue to move until it comes to the end of its travel in the x-axis, z-axis, or theta-axis or until it bumps into an obstacle. Stay clear of the robot until it stops moving.

*To perform an emergency stop:*

Press the red button on the pendant. The safety interlock circuit is interrupted, disabling the robot motors. The BenchCel Microplate Handler operation stops.
Recovering from an emergency stop

After you press the button on the emergency-stop pendant, the robot stops. One of the following occurs:

- If you stopped a protocol run, a dialog box opens in the VWorks software.
- If you stopped the robot while diagnosing problems in BenchCel Diagnostics, a motor-disable message appears on the screen.

Use the following procedure to recover in either case.

**To recover the BenchCel device after an emergency stop:**

1. If the robot dropped labware before or during the emergency stop, remove labware that was dropped. Also remove labware at teachpoints or other locations.

2. If the BenchCel robot attempted to place labware at a location that was not free, a collision might have occurred resulting in misalignment of the robot gripper. Check the robot gripper alignment:
   - a Move the robot arms so that they are perpendicular to the x-axis.
   - b Make sure the bottom of the robot gripper pads are perpendicular to the robot arms. If they are not, contact Agilent Technical Support.

*Figure*  
Gripper alignment: (A) correct alignment, and (B) incorrect alignment

3. To re-enable the motors:
   - a At the emergency-stop pendant, turn the button clockwise to release it.
In the VWorks software message dialog box, select an appropriate option to continue:

<table>
<thead>
<tr>
<th>Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diagnostics</td>
<td>Opens the BenchCel Diagnostics dialog box. See step 4.</td>
</tr>
<tr>
<td></td>
<td>Note: This selection is available only when you are in the middle of a protocol run and not while you are in BenchCel Diagnostics.</td>
</tr>
<tr>
<td>Retry</td>
<td>Attempts to restart the current command or task in the run.</td>
</tr>
<tr>
<td>Ignore and</td>
<td>Ignores the current command or task and continues to the next command or task in the protocol sequence.</td>
</tr>
<tr>
<td>continue</td>
<td>Abort</td>
</tr>
</tbody>
</table>

For a full description of the selections, see the VWorks Automation Control User Guide.

4 Optional. In BenchCel Diagnostics, use the available commands to manually move the robot or other components, including:
- Release the microplate that the robot is currently holding.
- Upstack the microplate that the robot is currently holding.
- Replace the lid on the microplate.
- Home the robot.
- Verify teachpoints.

For details, see "Diagnostic tools" on page 146.

If a physical crash occurred, always start BenchCel Diagnostics to home the robot and verify teachpoints.

Related information

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pausing and resuming protocol runs</td>
<td>VWorks Automation Control User Guide</td>
</tr>
<tr>
<td>Using commands in BenchCel Diagnostics</td>
<td>&quot;Diagnostic tools&quot; on page 146</td>
</tr>
<tr>
<td>Complete list of available commands in BenchCel Diagnostics</td>
<td>&quot;Quick reference&quot; on page 165</td>
</tr>
<tr>
<td>Reporting a problem</td>
<td>&quot;Reporting problems&quot; on page 162</td>
</tr>
</tbody>
</table>
1 Safety guidelines
Safety equipment and features

Safety equipment and features

About this topic

This topic describes the safety equipment and features of the BenchCel Microplate Handler that are required to protect operators from moving-parts hazards.

**WARNING**
Changing or modifying the BenchCel safety equipment may prevent the safe operation of the BenchCel Microplate Handler, invalidate its safety compliance, and lead to personal injury or property damage. Any customer who does not use the supplied safety equipment or who modifies the supplied safety equipment assumes full responsibility for providing an appropriate level of safety for its operators and for providing the applicable safety compliance marking and documentation.

Shields

Make sure the BenchCel device is enclosed in the supplied shield. The shield restricts access to the BenchCel robot while the BenchCel Microplate Handler is operating.

*Figure* BenchCel front shield

Additional shields may be required on devices that are integrated with the BenchCel Microplate Handler, such as the Bravo Platform.

In addition, a light curtain connected to the safety interlock circuit may be required.
WARNING To reduce the risk of injury from moving parts, ensure that the BenchCel shield and the shields for any integrated devices are installed on the workstation.

WARNING Operating the Bravo Platform or Microplate Centrifuge with Loader without a safety shield or a light curtain connected to the safety interlock circuit increases the risk of injury.

Safety interlock circuit

WARNING To avoid potential injury, Agilent recommends that you install a main emergency stop button (Robot Disable Hub) that will stop the BenchCel robot and all other devices on the safety interlock circuit simultaneously. In addition, all operators must be instructed in the emergency stop procedure.

The BenchCel Microplate Handler has a safety interlock circuit that is designed to protect operators from moving-parts hazards. The safety interlock circuit must be closed for the device to operate. The pendant connects to the safety interlock circuit. Pressing the red button on the pendant trips the interlock circuit and causes the motion of the BenchCel operation to stop.

Figure Emergency-stop pendant

When the BenchCel device is integrated with another device that has a safety interlock circuit, such as the Bravo Platform, Agilent Technologies uses the Robot Disable Hub to connect all the devices on the interlock circuit. Pressing the red button on a pendant or interrupting a light curtain connected to the Robot Disable Hub will trip the safety interlock circuit and stop all the devices connected to the circuit.

Figure Robot Disable Hub

Related information

For information about... | See...
--- | ---
Stopping in an emergency | “Emergency stops” on page 5
Product compliance | “Safety and regulatory compliance” on page 3
### Potential safety hazards

#### About this topic

This topic contains precautions about potential hazards that are specific to the BenchCel Microplate Handler. In addition to the following potential hazards, make sure that you understand how to avoid the general hazards described in the *Automation Solutions Products General Safety Guide*.

The potential hazards that you can encounter when using the BenchCel Microplate Handler include the following:

- “Moving parts” on page 10
- “Sharp edges and pinch hazards” on page 11
- “Infrared LED injury hazard” on page 11
- “Static electricity” on page 12
- “Improper access or use” on page 12
- “Lifting hazard” on page 12

#### Moving parts

To minimize potential injury, the BenchCel device is designed to stop immediately if the robot head hits an obstacle while it is in operation. However, be aware that the robot moves with considerable force in the vertical or z-axis direction and could pierce your skin with one of its grippers.

Not all circumstances can be foreseen and serious injury is possible. It is the responsibility of every operator to follow warnings and safety labels and keep out of the robot’s workspace whenever it is likely to move.

**WARNING**

The BenchCel Microplate Handler has moving parts that can injure you if you deviate from the procedures given in this guide. Keep your fingers, hair, clothing, and jewelry away from the BenchCel Microplate Handler while it is in motion.

**WARNING**

To avoid potential injury, do not touch the BenchCel Microplate Handler as you start the software. The robot head moves when the device initializes.
**WARNING**

Never touch any of the moving parts or attempt to remove or add labware while the BenchCel Microplate Handler is in operation. The robot head moves with considerable force and can cause pinching, piercing, or bruising injury if you are in the path of the robot head or gripper.

---

**Sharp edges and pinch hazards**

**WARNING**

Pinch hazard! Keep your fingers out of the path of the labware racks when you mount the racks on the BenchCel device.

**WARNING**

Use the rack handle to carry the labware racks. Do not hold a rack by the interior edges. The interior edges might have sharp surfaces that could cause cuts if handled improperly.

*Figure*  Sharp surfaces on labware rack

---

**Infrared LED injury hazard**

**WARNING**

Do not stare directly at the light-emitting diodes (LEDs) inside the stacker heads when the device is on. Such exposure to the LEDs can cause eye injury.

Each BenchCel stacker head contains seven infrared LEDs that detect the presence of a labware rack, microplates, and microplate notches. The LEDs are capable of dissipating 100 mW of power. Do not stare directly at the LEDs when the BenchCel Microplate Handler is turned on.
1 Safety guidelines
Potential safety hazards

Static electricity

**CAUTION**
The rack-release button at the top of the stacker head on the BenchCel device is sensitive to static electricity. Static electricity can cause a potential loss of motor control and loss of communication with the BenchCel device. Ensure that you discharge any potential static electricity before touching the rack-release button. To discharge static electricity, you can touch the white painted or metal surface of the BenchCel device before touching the rack-release button.

Improper access or use

**CAUTION**
Improper use by an untrained user could damage the BenchCel Microplate Handler. For example, the robot gripper could collide with a stacker if a teachpoint is not defined properly.

Ensure that only fully trained BenchCel administrators have access to the user account passwords.

Lifting hazard

**WARNING**
The BenchCel device without labware racks weighs 28 – 51 kg (61.7 – 112.4 lb), depending on the configuration. Attempting to lift or move the BenchCel device without assistance could cause personal injury. Request assistance and use proper lifting techniques when lifting or moving the device.

**CAUTION**
If the BenchCel Microplate Handler is incorrectly packaged and moved by someone other than an Agilent employee, the device may be damaged. Such damage is not covered by the warranty.

Before moving a BenchCel Microplate Handler, ensure the new location meets the laboratory requirements.

Related information

<table>
<thead>
<tr>
<th>For more information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>General safety</td>
<td>“General safety information” on page 2</td>
</tr>
<tr>
<td>Stopping in an emergency</td>
<td>“Emergency stops” on page 5</td>
</tr>
<tr>
<td>Shields, pendants, and safety interlock circuit</td>
<td>“Safety equipment and features” on page 8</td>
</tr>
<tr>
<td>Locations of hardware components</td>
<td>“Hardware overview” on page 15</td>
</tr>
<tr>
<td>Site laboratory requirements</td>
<td>“Verifying laboratory requirements” on page 37</td>
</tr>
<tr>
<td>Reporting problems with the BenchCel Microplate Handler</td>
<td>“Reporting problems” on page 162</td>
</tr>
</tbody>
</table>
2 Introduction

This chapter contains the following topics:

- "BenchCel Microplate Handler description" on page 14
- "Hardware overview" on page 15
- "Integration options for workstations" on page 25
- "Labware considerations" on page 27
- "Software description" on page 29
BenchCel Microplate Handler description

Description

The BenchCel Microplate Handler is a microplate-processing automation device that:

- Stores stacks of labware (microplates, tip boxes, and tube racks) to be processed during a protocol run.
- Moves labware to and from integrated devices such as the Bravo Platform, PlateLoc Thermal Microplate Sealer, or Microplate Labeler for processing.

Figure  BenchCel Microplate Handler with safety shield and two labware racks

Configurations

The BenchCel Microplate Handler is available in three options:

- BenchCel 2R has two stackers that support two labware racks
- BenchCel 4R has four stackers that support four labware racks
- BenchCel 6R has six stackers that support six labware racks

The BenchCel Microplate Handler is included in the following standard Agilent workstations:

- G5590A BenchCel Workstation
- G5591A Bravo BenchCel Workstation
Related information

<table>
<thead>
<tr>
<th>For more information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agilent devices that you can integrate in a BenchCel Workstation</td>
<td>“Integration options for workstations” on page 25</td>
</tr>
<tr>
<td>Hardware component description</td>
<td>“Hardware overview” on page 15</td>
</tr>
<tr>
<td>Automation-ready labware</td>
<td>“Labware considerations” on page 27</td>
</tr>
<tr>
<td>Safety information</td>
<td>“Safety guidelines” on page 1</td>
</tr>
</tbody>
</table>

Hardware overview

About this topic

This topic describes the hardware features of the BenchCel device. Note that the figures in this topic show a BenchCel 2R device with two stackers that support two labware racks. All the major components and functions are the same for the BenchCel 4R (four stackers) and BenchCel 6R (six stackers).

**WARNING**

Do not operate the BenchCel Microplate Handler without the safety shield. Doing so increases the risk of injury.
Front view

<table>
<thead>
<tr>
<th>Item</th>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Labware rack</td>
<td>The accessory that stores labware to be processed in a run. For details, see “Labware racks” on page 24.</td>
</tr>
<tr>
<td>2</td>
<td>Stacker head</td>
<td>The structure at which:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• A labware rack is loaded. Two sensors inside of each stacker head detect the presence of the racks.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• A microplate is checked for type and orientation using a plate-presence sensor and four plate-orientation sensors.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• A microplate is lowered into the stacker grippers to begin a run.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Stacker head” on page 20 for the location and detailed descriptions of the sensors.</td>
</tr>
<tr>
<td>3</td>
<td>Air pressure regulator</td>
<td>The knob that you turn to adjust the air pressure inside the device. Compressed air is used to move components inside the stacker heads. Each regulator controls the air pressure to the two adjacent stacker heads. For details, see “Adjusting the stacker gripper pressure” on page 158.</td>
</tr>
<tr>
<td>4</td>
<td>Safety shield</td>
<td>The clear panel that is installed on the front of the BenchCel device to prevent access while it is in operation.</td>
</tr>
<tr>
<td>Item</td>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>5</td>
<td>Pendant</td>
<td>The component that is part of the safety interlock circuit, which must be closed for the BenchCel device to operate. Pressing the raised button on the pendant interrupts the safety circuit and disables the robot motors. Use this method of stopping the robot for emergencies only.</td>
</tr>
</tbody>
</table>
| 6    | Rack-release button | The button that unlocks the rack for removal. The rack-release button at the top of each stacker head displays different colors to indicate the state of the stacker head:  
  - *Green*. The labware rack is installed correctly on the BenchCel device and the microplates are unloaded. The stack of microplates are ready for processing or you can unlock and remove the labware rack.  
  - *Flashing green*. The labware rack is unlocked and can be removed.  
  - *Blue*. The stack of microplates is loaded. You cannot unlock and remove the labware rack.  
  - *Red*. The clamps are open without a rack installed. Do not install a rack until the clamps are closed. |
| 7    | Robot head | The component that moves horizontally along the x-axis and vertically along the z-axis. |
| 8    | Robot arms | Two parallel structures that are attached to and rotate about the robot head along the theta-axis. |
Introduction

Hardware overview

### Item Feature Description

<table>
<thead>
<tr>
<th>Item</th>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>Robot grippers</td>
<td>The structures inside the robot arms that close and open to hold and release a microplate. Using the provided software, you can adjust the distance between the grippers to hold a microplate loosely or tightly.</td>
</tr>
</tbody>
</table>

Back view
<table>
<thead>
<tr>
<th>Item</th>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Air-input fitting</td>
<td>Connects the air tubing to the BenchCel device. Compressed air is used to actuate components inside the stacker head.</td>
</tr>
<tr>
<td>2</td>
<td>Power switch</td>
<td>Turns on or off the power to the BenchCel device.</td>
</tr>
<tr>
<td>3</td>
<td>AC power entry</td>
<td>Connects the power cord to the BenchCel device.</td>
</tr>
<tr>
<td>4</td>
<td>Ethernet port</td>
<td>Connects the Ethernet cable from the controlling computer to the BenchCel device to allow communication between the computer and the device. Use this port as an alternative to the serial connection.</td>
</tr>
<tr>
<td>5</td>
<td>Serial port</td>
<td>Connects the serial cable from the controlling computer to the BenchCel device to allow communication between the computer and the device. Use this port as an alternative to the Ethernet connection.</td>
</tr>
<tr>
<td>6</td>
<td>Pendant port</td>
<td>Connects the emergency-stop pendant to the safety interlock circuit. The connection is made either directly or through an emergency-stop control, such as the Robot Disable Hub.</td>
</tr>
</tbody>
</table>

**IMPORTANT** The safety interlock circuit must be closed for the BenchCel Microplate Handler to operate.
Stacker head

At the top of the BenchCel device are stacker heads that contain infrared sensors and mechanical components that load and unload microplates during operation.

The following table lists and describes the various components inside the stacker head.
## Feature Description

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plate-presence sensor</td>
<td>Detects the presence of a microplate in the stack. One plate-presence sensor is on the back wall of each stacker head.</td>
</tr>
<tr>
<td>Rack-presence sensors</td>
<td>Detect the presence of labware racks. Two rack sensors are on the back wall of each stacker head.</td>
</tr>
</tbody>
</table>
### Plate-orientation sensors

Detect the presence of notches in microplates. Four sensors are in the inside corners of each stacker head. For details of how the sensors work, see "Setting sensor thresholds" on page 99.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plate-orientation sensors</td>
<td>Detect the presence of notches in microplates. Four sensors are in the inside corners of each stacker head. For details of how the sensors work, see &quot;Setting sensor thresholds&quot; on page 99.</td>
</tr>
</tbody>
</table>

![Diagram of Plate-orientation sensor](image)

---

### Clamps

Close and open the grippers at the bottom of the labware rack to hold and release microplates during loading, unloading, downstacking, and upstacking processes. Two clamps are inside each stacker head. Compressed air is used to open and close the clamps.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clamps</td>
<td>Close and open the grippers at the bottom of the labware rack to hold and release microplates during loading, unloading, downstacking, and upstacking processes. Two clamps are inside each stacker head. Compressed air is used to open and close the clamps.</td>
</tr>
</tbody>
</table>

![Diagram of Clamps](image)
## Feature Description

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shelves</td>
<td>Provide leveling surfaces for the microplates, thus ensuring accurate robot gripping, during the downstacking process. Two shelves (four leveling surfaces) are inside each stacker head. Compressed air is used to move the shelves.</td>
</tr>
</tbody>
</table>
Labware racks

The labware racks are available in two models:

- Front-load rack in 250-mm and 660-mm sizes
- Top-load rack in 660-mm and 860-mm sizes

Both rack models have the following basic components.

**Figure** Front-load rack components

<table>
<thead>
<tr>
<th>Item</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Carrying handle</td>
<td>The top-load and front-load racks have fold-down carrying handles.</td>
</tr>
<tr>
<td>2</td>
<td>Tabs</td>
<td>A pair of vertical tabs are located at the bottom on the rack sides. The tabs insert into slots on the device when you mount the rack onto the device.</td>
</tr>
<tr>
<td>3</td>
<td>Stacker grippers</td>
<td>A gripper is located on the interior bottom of each tab. The pair of grippers hold a microplate during the labware loading, unloading, downstacking, and upstacking processes. A clamp in the device opens and closes the grippers.</td>
</tr>
</tbody>
</table>
Integration options for workstations

About this topic

You can integrate Agilent devices with the BenchCel Microplate Handler to create a
BenchCel Workstation. The BenchCel robot can move labware to and from these
devices as specified by the protocol you create.

This topic lists some of the devices that can be integrated with the BenchCel
Microplate Handler.

Agilent devices

The following figure shows an example of a BenchCel Workstation.

Related information

For more information about...

Automation-ready labware
Software that controls the BenchCel Microplate Handler
Safety information
Installation requirements

See...

“Labware considerations” on page 27
“Software description” on page 29
“Safety guidelines” on page 1
“Verifying laboratory requirements” on page 37
The following Agilent devices can be integrated with the BenchCel Microplate Handler.

<table>
<thead>
<tr>
<th>Item</th>
<th>Device</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Bravo Platform</td>
<td>Dispenses liquids.</td>
</tr>
<tr>
<td>2</td>
<td>Labware MiniHub</td>
<td>Stores labware.</td>
</tr>
<tr>
<td>3</td>
<td>Microplate Labeler</td>
<td>Prints barcodes and applies the barcode labels to microplates.</td>
</tr>
<tr>
<td>4</td>
<td>Microplate Centrifuge with Automated Loader</td>
<td>Centrifuges microplates.</td>
</tr>
<tr>
<td>5</td>
<td>PlateLoc Thermal Microplate Sealer</td>
<td>Applies seal on microplates.</td>
</tr>
</tbody>
</table>

Related information

For more information about...

- BenchCel Microplate Handler features
- Safety information
- Installation requirements

See...

- "Hardware overview" on page 15
- "Safety guidelines" on page 1
- "Installing BenchCel Microplate Handler" on page 35
Labware considerations

About this topic

This topic provides guidelines for selecting automation-ready labware for use in the BenchCel Microplate Handler.

Acceptable microplates

The BenchCel device is designed to handle labware that comply with the standards ANSI/SLAS 1-2004 (R2012) through ANSI/SLAS 4-2004 (R2012). For use of nonconforming labware, contact Agilent Technical Support.

The BenchCel device uses gripping mechanisms to hold microplates securely and repeatably in the labware rack and in the robot arms. The BenchCel device typically holds the microplates halfway between the top of the microplate and the top of the microplate skirt (5 to 10 mm above the bottom of the microplate).

In the following figure, notice the gripper-microplate contact point.

Figure  Labware rack closeup view showing microplate held by the stacker grippers

Lidded microplates

Microplates that do not have lids or have shallow lids (lids that do not reach the microplate skirt) provide enough clearance to allow secure and repeatable gripping. Microplates with deeper lids can be more challenging, because the microplate must be held by the skirt. If the skirt is too flexible, the stacker grippers will bend the skirt. The bent skirt can grip the microplate lid stacked beneath, inadvertently removing the lid.

Note: Some labware vendors might offer alternative lids that are shallower. Contact the vendor for details.
Challenging microplate characteristics

Microplates that have the following characteristics might require additional setup time to ensure repeatable performance for the BenchCel device:

- **Microplate material.** Although you can adjust the robot grip distance to compensate for a microplate’s flexibility, some microplates are too soft and tend to bend in the robot grippers or become warped after thermal cycling. (for example, low-profile polypropylene PCR microplates).

- **Manufacturing variance.** Gross variations in microplate dimensions can reduce repeatability of secure gripping. In addition, because the BenchCel device uses reflected light to sense microplate presence and orientation, variations in the reflective properties of the microplates can affect optimal operation.

- **Microplate design.** Some microplates have special features specifically designed for particular instruments but are not optimized for the BenchCel device.

- **Thermal cycling effects.** Microplates that have been through thermal cycling might become warped.

- **Tall labware.** Especially tall tube racks and tip boxes that are taller than 65 mm might pose challenges in the BenchCel device. Contact Agilent Technical Support about acceptable tall labware.

- **Extra long lid.** Some microplates that have lids that extend past the microplate skirt tend to pose challenges for the BenchCel device. Contact Agilent Technical Support for guidance.

Related information

<table>
<thead>
<tr>
<th>For more information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Defining labware in the software</td>
<td>VWorks Automation Control Setup Guide</td>
</tr>
<tr>
<td>Location of plate-orientation sensors</td>
<td>&quot;Stacker head&quot; on page 20</td>
</tr>
<tr>
<td>How the plate-orientation sensors work</td>
<td>&quot;Setting sensor thresholds&quot; on page 99</td>
</tr>
</tbody>
</table>
Software description

About this topic

This topic describes the software that you can use to set up, control, and troubleshoot the BenchCel Microplate Handler.

VWorks software 13.1.x

VWorks 13.1.x enables you to:

• Set up user accounts and privileges
• Set up your devices
• Define labware, liquid classes, and pipetting techniques
• Manage labware inventory
• Create protocols and forms, and run the protocols

VWorks 13.1.x uses the Windows Registry to store records, such as labware definitions and device profiles, and uses the local file system to store VWorks files, such as device files and protocols.
VWorks software 14.0 and later versions

VWorks 14.0 and later versions are available as VWorks Plus and VWorks Standard editions. Both editions consist of Agilent OpenLab components and VWorks software. VWorks Plus includes features that support compliance with Part 11 of Title 21 of the Code of Federal Regulations (21 CFR Part 11). You use the VWorks software to control your automation devices.

OpenLab components

- **Control Panel** and **Shared Services**. Control Panel is the user interface for Shared Services, which are set of administrative services. An administrator uses Control Panel to configure VWorks user access, software licenses, and storage.

- **Storage types**. Shared Services uses a different storage type for each VWorks edition:
  - **VWorks Plus**. Uses **Content Management** to store VWorks files, records of interest, and audit trails. The files are stored in a predefined VWorks Project folder in the Content Management repository. A system administrator can use the **Content Browser** to view and edit the project structure and contents.
  - **VWorks Standard**. Uses the local file system. Shared Services stores the files in a predefined VWorks Project folder. `/VWorks Projects/VWorks`

*Note:* Unlike earlier versions, the Windows Registry is not used for storing records, such as labware definitions and device profiles.

VWorks software

You use the VWorks software to do the following:

- **VWorks Plus only**. Log audit trails and manage record states
- Define labware, liquid classes, and pipetting techniques
- Manage labware inventory (storage devices only)
- Track experiments, if applicable
- Set up devices
- Create protocols and forms, and run the protocols
BenchCel ActiveX control

You can use the BenchCel ActiveX control instead of the VWorks software to control the BenchCel Microplate Handler. The BenchCel ActiveX control enables the BenchCel device to interact with a third-party lab automation system.

BenchCel Diagnostics software

Accessed through the VWorks software or the BenchCel ActiveX control, Diagnostics enables you to do the following:

- *Create and manage profiles.* The software uses the information in the profile to communicate between the BenchCel device and the controlling computer. You create profiles using the Profiles tab in BenchCel Diagnostics when you set up the BenchCel Microplate Handler.
2 Introduction
Software description

Note: In VWorks v14.0 and later versions, BenchCel Diagnostics includes an activity log for the current session in a box at the bottom of the window. The Profiles tab also includes a table that displays variables that were modified since the last was last saved. The VWorks software records these events and stores the information in the Main log. For details on the logs, see the VWorks Automation Control User Guide.

- Set and edit teachpoints. Teachpoints are locations that the BenchCel robot will go to and from during a protocol run. You set teachpoints using the Diagnostics Controls tab when you set up the BenchCel Microplate Handler.
• **Diagnose problems.** You can use the Jog/Teach tab on the Diagnostics Controls page to move and adjust individual hardware components. These controls are useful for diagnosing and troubleshooting problems.

![BenchCel Diagnostics Jog/Teach tab](image)

While testing new or troubleshooting labware definitions, you can change parameters to refine the labware definition. Diagnostics includes a Labware tab on the Controls page, which enables you to adjust the labware definitions. Alternatively, you can use the Labware Editor to update the labware definitions.

![BenchCel Diagnostics Labware tab](image)
• Change general device settings. After diagnosing problems, you can change some of the device settings to repair problems or to optimize operation.

**Figure** BenchCel Diagnostics General Settings tab

![BenchCel Diagnostics General Settings tab](image)

**Related information**

<table>
<thead>
<tr>
<th>For more information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating and running protocols in VWorks</td>
<td><a href="#">VWorks Automation Control User Guide</a></td>
</tr>
<tr>
<td>VWorks setup instructions</td>
<td><a href="#">VWorks Automation Control Setup Guide</a></td>
</tr>
<tr>
<td>Setting up profiles and teachpoints</td>
<td>“Setup workflow” on page 64</td>
</tr>
<tr>
<td>Using Diagnostics to troubleshoot problems</td>
<td>“Diagnostic tools” on page 146</td>
</tr>
<tr>
<td>BenchCel ActiveX control</td>
<td><a href="#">BenchCel ActiveX User Guide</a></td>
</tr>
</tbody>
</table>
3 Installing BenchCel Microplate Handler

This chapter contains the following topics:

- "Installation workflow" on page 36
- "Verifying laboratory requirements" on page 37
- "Unpacking BenchCel Microplate Handler" on page 42
- "Mounting the robot" on page 44
- "About integrating devices in a BenchCel Workstation" on page 47
- "Connecting the power source" on page 50
- "Connecting the pendant directly to the BenchCel device" on page 51
- "Connecting the pendant through the Robot Disable Hub" on page 53
- "Connecting and disconnecting the air source" on page 55
- "Connecting the computer" on page 57
- "Installing the shield" on page 61
# Installation workflow

## About this topic.

This topic presents the sequence of installation procedures for the BenchCel Microplate Handler. Typically, an integrated BenchCel Workstation will be installed for you.

**WARNING**

Changing the configuration or components of the installed workstation might invalidate the safety compliance and lead to personal injury or equipment damage.

## Workflow

<table>
<thead>
<tr>
<th>Step</th>
<th>For this task...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Verify that the installation location meets the site requirements.</td>
<td>&quot;Verifying laboratory requirements&quot; on page 37</td>
</tr>
<tr>
<td>2</td>
<td>Unpack the computer and connect the monitor, power, mouse, and keyboard.</td>
<td>Manufacturer's instructions</td>
</tr>
</tbody>
</table>
| 3    | Install the VWorks software. | • *VWorks Automation Control Installation Guide* (VWorks 14.0 and later)  
• Software release notes (VWorks 13.1.x) |
| 4    | Unpack the BenchCel device. | "Unpacking BenchCel Microplate Handler" on page 42 |
| 5    | Install the BenchCel risers, if applicable. | Agilent Technical Support |
| 6    | Mount the robot head on the BenchCel device. | "Mounting the robot" on page 44 |
| 7    | Integrate external devices. | "About integrating devices in a BenchCel Workstation" on page 47 |
| 8    | Connect the BenchCel Microplate Handler:  
  Power | "Connecting the power source" on page 50  
  Pendant | • "Connecting the pendant directly to the BenchCel device" on page 51  
  • "Connecting the pendant through the Robot Disable Hub" on page 53 |
  Air supply | "Connecting and disconnecting the air source" on page 55 |
  Computer | "Connecting the computer" on page 57 |
### Verifying laboratory requirements

#### Laboratory space

**Laboratory table or bench requirements**

Make sure the table for the BenchCel Microplate Handler has the following:

- Proximity to power and air sources
- Enough space to accommodate the complete configuration of the BenchCel Microplate Handler, computer, monitor, pendant, and integrated devices.
- Enough strength to support the weight of the BenchCel Microplate Handler and integrated devices without excessive shaking or movement.
- Be fixed in place, for example, casters that lock.
- Sufficient clearance on the back side of the BenchCel Microplate Handler to access power, communication, and air tubing connections and for maintenance tasks.
- Proper height for any operator to comfortably operate the BenchCel Microplate Handler

The table must be level in the direction of the width and the depth of the platform. Using a traditional bubble level, the table should be leveled such that the bubble is centered between the two limit lines of the level.

The table surface must have a thickness relative to the material that will prevent warping when the BenchCel Microplate Handler and computer are set upon the table.

### Related information

<table>
<thead>
<tr>
<th>For information about…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installing external devices</td>
<td>External device user documentation</td>
</tr>
<tr>
<td>Setting up the BenchCel Microplate Handler</td>
<td>“Setting up the BenchCel device” on page 63</td>
</tr>
<tr>
<td>Defining labware and writing protocols</td>
<td>VWorks Automation Control Setup Guide</td>
</tr>
</tbody>
</table>

### Steps for installation

<table>
<thead>
<tr>
<th>Step</th>
<th>For this task…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>Install the safety shield.</td>
<td>“Installing the shield” on page 61</td>
</tr>
<tr>
<td>10</td>
<td>Install the labware racks.</td>
<td>“Installing and uninstalling the labware racks” on page 123</td>
</tr>
<tr>
<td>11</td>
<td>Install the integrated devices.</td>
<td>Installation guide for the device.</td>
</tr>
<tr>
<td>12</td>
<td>Set up the BenchCel device profile and set the teachpoints.</td>
<td>“Setup workflow” on page 64</td>
</tr>
</tbody>
</table>
The table surface must be attached to the table frame.
The table frame must have:
• A leveling mechanism in the feet or casters.
• Dimensions that enable support of the table surface without overhang.

**Space requirements**
The minimum space requirements for your BenchCel Microplate Handler depends on its configuration and labware rack size. The following table lists dimensions for a BenchCel Microplate Handler in a two-, four-, or six-stack configuration.

<table>
<thead>
<tr>
<th>Dimension</th>
<th>Two stacks</th>
<th>Four stacks</th>
<th>Six stacks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Height, device without Risers</td>
<td>46.3 cm</td>
<td>46.3 cm</td>
<td>46.3 cm</td>
</tr>
<tr>
<td>Height, device with Risers (146-mm)</td>
<td>60.8 cm</td>
<td>60.8 cm</td>
<td>60.8 cm</td>
</tr>
<tr>
<td>Labware rack height* (250-mm, 660-mm, 860-mm)</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Width</td>
<td>43.2 cm</td>
<td>86.4 cm</td>
<td>129.5 cm</td>
</tr>
<tr>
<td>Depth</td>
<td>20.3 cm</td>
<td>20.3 cm</td>
<td>20.3 cm</td>
</tr>
<tr>
<td>Weight, approximate**</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>without rack</td>
<td>28 kg</td>
<td>39.5 kg</td>
<td>51 kg</td>
</tr>
<tr>
<td>with rack (660 mm, front-loading)</td>
<td>32.5 kg</td>
<td>48.6 kg</td>
<td>64.6 kg</td>
</tr>
</tbody>
</table>

*Approximately 30-mm of the rack height sits down inside the BenchCel stacker head. The overall height of a BenchCel device on risers with racks installed is as follows:
82.8 cm (250-mm rack)
126.0 cm (660-mm rack)
1438 cm (860-mm rack)
See the following figure.

**The rack weight is for the front-loading style rack and does not include liquid-filled microplates. The weight differs slightly between the top-loading and front-loading rack types.
Addition of devices

If you are integrating an Agilent device or third-party device with your BenchCel Microplate Handler, make sure you include adequate space to accommodate these devices. See the device user documentation for space requirement information.

Electrical requirements

The BenchCel Microplate Handler has the following power requirements. For power requirements of other devices in an integrated workstation, see the applicable device user documentation.

<table>
<thead>
<tr>
<th>Utility</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrical</td>
<td>100–240 V~, 50/60 Hz</td>
</tr>
<tr>
<td>Operating AC current</td>
<td>5 A at 120 V~, 2.5 A at 240 V~</td>
</tr>
<tr>
<td>Fuse</td>
<td>5 A, 250 V, 5 × 20 mm, fast acting</td>
</tr>
</tbody>
</table>

Compressed air requirements

The BenchCel Microplate Handler requires the use of clean, dry, compressed air to move pneumatic components inside the device. The compressed air can be from the following sources:

- Centralized source (house)
- Compressed-air cylinders
- Portable pumps
Installing BenchCel Microplate Handler

Verifying laboratory requirements

**CAUTION**

Using oil compressors can cause oil to leak into the BenchCel Microplate Handler and void your warranty.

**CAUTION**

Air pressure greater than 0.69 MPa (100 psi) can damage the BenchCel Microplate Handler.

To maintain the desired air supply in the device, the BenchCel Microplate Handler requires a source of air as follows:

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quality</td>
<td>Clean, dry, compressed</td>
</tr>
<tr>
<td>Flow rate</td>
<td>34.0 Lpm (1.2 cfm)</td>
</tr>
<tr>
<td>Pressure</td>
<td>0.65–0.69 MPa (95–100 psi)</td>
</tr>
</tbody>
</table>

**Environmental requirements**

The lab must meet the following environmental requirements.

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ambient temperature</td>
<td>5–40 °C</td>
</tr>
<tr>
<td>Humidity condition</td>
<td>10–90% RH, non-condensing</td>
</tr>
<tr>
<td>Elevation</td>
<td>1–2000 m</td>
</tr>
</tbody>
</table>

Make sure the BenchCel Microplate Handler is located away from the following:
- Heat and air conditioning ducts.
- Direct sunlight.

**Computer requirements**

The requirements of the controlling computer depend on the lab automation software you are using.
- VWorks 14.0 or later, see the installation guide for the software.
- VWorks 13.1.x, see the software release notes.
For third-party automation software, see the user documentation supplied with the product.

**Networking considerations**

The supplied computer comes with a serial port and two Ethernet ports. You can connect the computer to the BenchCel Microplate Handler using either the serial port or one of the Ethernet ports. You can use the second Ethernet port to connect the
computer to your local area network (LAN). You must provide an Ethernet cable for the
LAN connection and make sure the lab has the proper network hookups for the
connection.

If you are supplying your own computer, consider whether you will:

- Connect the computer to the BenchCel Microplate Handler using a serial or
  Ethernet connection.
- Connect the computer to your LAN.

**WARNING**

Connecting the BenchCel Microplate Handler to a company or general network can
potentially cause injury. Remote computer operators might accidentally initiate an
operation that causes the robot to move unexpectedly, possibly injuring nearby lab
personnel.

If you plan to connect the computer to the BenchCel Microplate Handler and to your
company’s LAN, the computer might require two Ethernet cards. Two Ethernet cards
allow the BenchCel Microplate Handler to operate on an isolated network.

**Related information**

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lab requirements for external devices</td>
<td>External device user documentation</td>
</tr>
<tr>
<td>Contacting technical support</td>
<td>“Reporting problems” on page 162</td>
</tr>
<tr>
<td>Installing the BenchCel Microplate Handler</td>
<td>“Installation workflow” on page 36</td>
</tr>
</tbody>
</table>
Unpacking BenchCel Microplate Handler

About this topic

This topic describes how to unpack the BenchCel Microplate Handler from the shipping containers.

Shipping containers

The shipping containers include:

- BenchCel crate containing the BenchCel device.
- Peripherals box containing the following packages:
  - BenchCel utility kit
  - Pendant
  - BenchCel robot head
  - Safety shield with hardware
  - Labware racks
- Computer box

Depending on the configuration ordered, additional packages or items can be included.

Before you start

Verify the following:

1. **BenchCel utility kit contents.** At a minimum, the kit contains the following:
   - Power cord
   - Serial and Ethernet cables, and Ethernet switch
   - Tubing for air line
   - Software CD-ROM

2. **Site specifications.** Ensure the installation site meets the requirements. See "Verifying laboratory requirements" on page 37.

   Note the dimensions of the shipping container before moving it to make sure you have adequate clearance through doorways and passages.

3. **Tools and equipment requirements.** Obtain the following:
   - Large screwdriver to open the shipping crate
   - Hex wrenches: 5-mm and 2-mm for mounting the robot head
   - Cart for moving the BenchCel device

4. **Personnel requirements.** Make sure two people are available to lift the BenchCel device from the crate.

**WARNING**

The BenchCel device without labware racks weighs 28 – 51 kg (61.7 – 112.4 lb), depending on the configuration. Attempting to lift or move the BenchCel device without assistance could cause personal injury. Request assistance and use proper lifting techniques when lifting or moving the device.
Procedure

**CAUTION**

The packing materials and shipping container were designed to protect the device. Packing the BenchCel device using other materials might damage the device and void your warranty. Save the packing materials and shipping container in case you are required to move or ship the BenchCel device.

**To unpack the BenchCel Microplate Handler:**

1. Use a large screwdriver to open the BenchCel device shipping container.
2. Lift the contents out of the container and set each item carefully on the lab bench or final location where you want to install the device.
3. Remove the packing foam from the device.
4. Remove components from the plastic bags or other packing material.
5. Inspect the unpacked items.

**About installing risers**

The 146-mm tall risers can be installed to the underside of the BenchCel device at each end to lift the device above the table surface. The risers are required for integrating the BenchCel device with certain devices in a workstation. In you are integrating a BenchCel Microplate Handler on risers, the Agilent installer will install the BenchCel risers before mounting the robot head on the BenchCel device.
Mounting the robot

About this topic

Typically, the BenchCel Microplate Handler will be installed for you. However, this topic provides a reference for how to mount the robot on the BenchCel device.

Procedure

**CAUTION** Do not use the robot arms to lift the robot. Doing so could damage the arms. Ensure that you lift the robot by the base and the head. Dropping or bumping the robot can damage the electronics. Handle the robot carefully.

*Figure* Correct and incorrect lift points on the robot head

To mount the robot on the BenchCel device:

1. Remove the shipping bracket from the BenchCel x-axis carriage as follows:
   a. Refer to the following figure to locate the BenchCel x-axis carriage.
   b. Loosen the two large black bracket screws that prevent the x-axis carriage from moving during shipping.
   c. Use a 5-mm hex wrench to remove the four screws that secure the shipping bracket to the x-axis carriage.
   d. Carefully lift the shipping bracket straight up, ensuring that you do not scratch the electronics.
2 Slide the x-axis carriage into position directly under a stacker head opening.
3 Inspect the x-axis carriage and ensure any cables are recessed.
4 Using the correct lift points, grasp the robot head and, carefully, lower it onto the x-axis carriage, aligning the two holes on the robot z-column bottom with the dowel pins on the x-axis carriage.
5 Gently slide the robot downwards. When the robot is in position, push down on it to ensure the electronics are fully connected.
6 Gently rotate the robot arms to one side to expose the two screw holes on the robot base. Insert the two 35-mm M6 screws and tighten to secure the robot to the base.

*Figure* BenchCel robot with rotated arms to expose screw holes in the base

7 Lift the robot head from the base to expose the remaining two screw holes in the base. While firmly supporting the robot head, install the two 45-mm M6 screws to finish securing the robot base to the x-axis carriage.
3 Installing BenchCel Microplate Handler

Mounting the robot

**Figure** BenchCel robot head in up position: (1) mounting screw holes and (2) front panel

---

**WARNING**

The robot head may not remain in the up position. The robot head can drop, potentially pinching your fingers. Ensure that you support the weight of the robot head while it is in the up position.

---

8 Gently lower the robot head onto the base.
9 To secure the front panel to the robot base, use a 2-mm hex wrench to install the two screws.

Related information

<table>
<thead>
<tr>
<th>For more information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation requirements</td>
<td>“Verifying laboratory requirements” on page 37</td>
</tr>
<tr>
<td>Installing the BenchCel Microplate Handler</td>
<td>“Installation workflow” on page 36</td>
</tr>
</tbody>
</table>
About integrating devices in a BenchCel Workstation

About this topic

Typically, the BenchCel Microplate Handler, any supplied devices, and the safety equipment in a workstation will be installed for you.

This topic provides basic integration concepts: how integration plates are used and how to adjust device positions. The workstation layout and the device integration procedures can vary, depending on the combination of devices you are integrating and the desired configuration.

Before you start

**WARNING**
Changing the configuration or components of the installed workstation might invalidate the safety compliance and lead to personal injury or equipment damage.

**IMPORTANT**
Contact Agilent Technical Support if you want to install the BenchCel device on risers or integrate a new device.

Make sure you have the following:
- The external devices you want to integrate
- Two integration plates for the BenchCel device
- Integration plate for each external device
- 4-mm hex wrench
- 3-mm hex wrench

Installing the BenchCel device integration plate

The BenchCel device integration plates have locking mechanisms that keep the BenchCel device and any external device in position during a run. The integration plates must be installed under the BenchCel device.

**To install the BenchCel device integration plate:**
1. Position the integration plates on the benchtop.
2. If risers are required in the integration, install the risers on the integration plates.
3. Place the BenchCel device on the integration plates or risers.
4. Tighten the screws to secure the device on the integration plates.

Installing the external device integration plate

You can integrate an external device on the left or right side of the BenchCel device. For each external device, you must install the integration plate that is specific to that device.
To install the external device and integration plate:

1. Depending on whether you are integrating a device to the left or right of the BenchCel device, loosen the left or right clamp screw using the 3-mm hex wrench. See the following figure. As you loosen the screw, the left or right clamp opens.

   **Figure**  Clamp screw (left side) on BenchCel device

2. Mount the external device on its integration plate. Tighten the bolts or screws to secure the device on the integration plate.

3. Place the external device and integration plate next to the BenchCel device.

   **Figure**  External device and integration plate next to the BenchCel device
4 Use the 3-mm hex wrench to slightly tighten the BenchCel device integration plate clamp screw. You will not tighten the screw all the way until the devices are correctly aligned.

*Figure* Integration plate clamp screw

5 Visually inspect the position of the integrated device relative to the BenchCel device. The two devices should be aligned along the y-axis (front-to-back direction) so that the BenchCel robot can place a microplate on the plate stage accurately. If the devices are not properly aligned, slide the devices along the y-axis until they appear to be correctly aligned.

*Note:* You will verify and refine the alignment when you set up the teachpoints for the external devices.

6 Repeat the procedure for each external device.

**Related information**

<table>
<thead>
<tr>
<th>For more information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integration options</td>
<td>“Integration options for workstations” on page 25</td>
</tr>
<tr>
<td>BenchCel Microplate Handler installation requirements</td>
<td>“Verifying laboratory requirements” on page 37</td>
</tr>
<tr>
<td>External device installation requirements</td>
<td>External device user documentation</td>
</tr>
<tr>
<td>Installing the BenchCel Microplate Handler</td>
<td>“Installation workflow” on page 36</td>
</tr>
<tr>
<td>Setting up the BenchCel Microplate Handler</td>
<td>“Setup workflow” on page 64</td>
</tr>
</tbody>
</table>
About this topic

This topic explains how to connect the BenchCel Microplate Handler to a grounded power source.

Before you start

Make sure you have the supplied power cord.

WARNING

Ensure that the power cords are in good condition and are not frayed. Use of frayed or damaged power cords can cause injury. Use of incorrect power cords can cause damage to the device.

Connecting the power source

To connect the BenchCel device to a grounded power source:

1. Plug one end of the power cord into the AC power entry located on the back of the BenchCel Microplate Handler.

2. Plug the other end of the cord into an AC outlet with grounded circuit.

Related information

<table>
<thead>
<tr>
<th>For more information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrical requirements</td>
<td>“Verifying laboratory requirements” on page 37</td>
</tr>
<tr>
<td>Installing the BenchCel Microplate Handler</td>
<td>“Installation workflow” on page 36</td>
</tr>
</tbody>
</table>
Connecting the pendant directly to the BenchCel device

About this topic

If you are integrating the BenchCel Microplate Handler with devices that are not equipped with safety interlock circuitry, for example, the PlateLoc Sealer or the Microplate Labeler, use the procedure in this topic to connect the emergency-stop pendant.

*Figure* Emergency-stop pendant

The pendant must be connected to close the safety interlock circuit. The circuit must be closed for the device to operate.

**IMPORTANT**

If the BenchCel Microplate Handler is integrated with devices that are equipped with safety interlock circuitry, such as the Bravo Platform, you connect the pendant through a main emergency-stop control, such as the Robot Disable Hub. See "Connecting the pendant through the Robot Disable Hub" on page 53.
Connecting the pendant directly to the BenchCel device

Procedure

To connect the pendant directly to the BenchCel device:
Connect the pendant cable to the pendant port on the back of the BenchCel device.

Related information

<table>
<thead>
<tr>
<th>For more information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stopping in an emergency</td>
<td>“Emergency stops” on page 5</td>
</tr>
<tr>
<td>Safety interlock circuit</td>
<td>“Safety interlock circuit” on page 9</td>
</tr>
<tr>
<td>Installing the BenchCel Microplate Handler</td>
<td>“Installation workflow” on page 36</td>
</tr>
</tbody>
</table>
About this topic

Read this topic if you are integrating the BenchCel Microplate Handler with other devices that are equipped with safety interlock circuitry, such as the Bravo Platform. This topic describes how to connect the emergency-stop pendants for the integrated devices through the Robot Disable Hub, which provides a main emergency-stop control for the workstation.

Figure  Emergency-stop pendant

Robot Disable Hub overview

The Robot Disable Hub can connect the interlock circuits of up to three devices and a light curtain. Pressing the red button on a pendant connected through the Robot Disable Hub will trip the interlock circuit, causing all the devices on the circuit to stop. The Robot Disable Hub has the following connectors, controls, and indicators:

Figure  Robot Disable Hub connections (front and back views)

- **Pendants** connectors accommodate the BenchCel pendant and up to two additional pendants.
- **Devices** connectors accommodate the BenchCel device and up to two other devices with interlock circuits.
- **Light Curtain** connectors connect to the corresponding light curtain receiver (Rx) and transceiver (Tx) cables.
- **Power** status indicator lights green when the unit is connected to power.
• **Power** entry port connects to the supplied 24W power adapter, which in turn connects to the power cord.

• **Light Curtain Enable/Bypass** switch enables or disables the light curtain. You set the switch to Bypass during the installation. After installing the light curtain and connecting all the devices, you set the switch to Enable.

**IMPORTANT**

Any unused Pendants connectors require E-stop jumpers to close the interlock circuit.

**Example of connections using Robot Disable Hub**

The following figure and table provide an example of connecting the BenchCel device and the Bravo Platform through the Robot Disable Hub.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Connects from</th>
<th>Connects to Robot Disable Hub</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Extension cable</td>
<td>Bravo pendant port</td>
<td>Devices connector</td>
</tr>
<tr>
<td>2</td>
<td>Pendant cable</td>
<td>Pendant 1</td>
<td>Pendants connector</td>
</tr>
<tr>
<td>3</td>
<td>Pendant cable</td>
<td>Pendant 2</td>
<td>Pendants connector</td>
</tr>
<tr>
<td>4</td>
<td>Extension cable</td>
<td>BenchCel pendant port</td>
<td>Devices connector</td>
</tr>
<tr>
<td>5</td>
<td>Jumper</td>
<td>Jumper</td>
<td>Pendants connector</td>
</tr>
</tbody>
</table>
Related information

For more information about… | See…
--- | ---
Stopping in an emergency | “Emergency stops” on page 5
Safety interlock circuit | “Safety interlock circuit” on page 9
Installing the BenchCel Microplate Handler | “Installation workflow” on page 36

Connecting and disconnecting the air source

About this topic

Compressed air is used to move parts inside the BenchCel Microplate Handler. This topic explains how to connect the BenchCel Microplate Handler to the air source and check the connections for leaks before use.

Before you start

Make sure you have the supplied air tubing.

**WARNING** Working with open, charged air lines can result in injury. Turn off the compressed air line when disconnecting or reconnecting devices that use compressed air. Contact your facilities department or Agilent Technical Support with questions about setting up the air line.

Connecting the air source

*To connect the BenchCel device to the air source:*

1. Turn off the air at the source (house, cylinder, or pump).
2. Connect one end of the air tubing to the air source (house, cylinder, or pump), and then connect the free end of the tubing to the quick disconnect fitting at the air-input port.

   To connect the tubing, push the end of the tubing into the quick disconnect fitting at the air source and on the back of the BenchCel Microplate Handler.
Checking the air connections

To check the air connections:
1. With the air source turned off, gently tug the air tubing at each connection. If you feel resistance at the connection, the tubing has been properly installed.
2. Turn on the air at the source (house, cylinder, or pump).
3. Listen near each connection for hissing sounds that might indicate a leak. If you hear hissing sounds, turn off the air at the source, check and tighten the connections, and then turn on the air again. If the problem persists, contact your facilities department or Agilent Technical Support.

Disconnecting the air source

Before moving or shipping the BenchCel Microplate Handler and before performing maintenance or cleaning, disconnect the air tubing.

CAUTION
Do not pull the tubing out of the orange quick-disconnect fitting. Doing so can damage the fitting.

To disconnect the air tubing from the BenchCel device
1. Turn off the air at the source (house, cylinder, or pump).
2. Push and hold the locking collar against the fitting, and then gently pull the air tubing out.

Note: Alternatively, you can use the SMC Pneumatics tool (TG-2) to aid in this task. See the manufacturer’s documentation for use instructions. Contact your local SMC parts supplier for ordering details.
Connecting the computer

About this topic

This topic explains how to connect the controlling computer to the BenchCel Microplate Handler.

Before you start

Make sure you have the following:

- Ethernet cable (supplied) or RS-232 DB9 serial cable
- Ethernet switch (supplied) for Ethernet connections only

Connecting the controlling computer

You can connect the computer to the BenchCel Microplate Handler in one of the following ways:

- **Serial connection.** You can use the supplied RS-232 DB9 serial cable to connect the computer to the BenchCel Microplate Handler.
• *Ethernet connection.* You can use the supplied Ethernet cable to connect the computer to the BenchCel Microplate Handler. The Agilent configured computer has two Ethernet ports. You can use one port to connect to the BenchCel Microplate Handler and the other to connect to your company network.

**To connect the controlling computer to the BenchCel device:**

1. Turn off the computer.

2. *Serial connection only.* Do the following:
   
   a. Connect the female end of the serial cable to a COM port on the controlling computer. Note the number of the COM port. You will provide this number in the software.
   
   b. Connect the male end of the serial cable to the serial port on the back of the BenchCel Microplate Handler.

   **Figure** Serial connector on the BenchCel Microplate Handler (back view)

3. *Ethernet connection only.* Do the following:
   
   a. Connect one end of the Ethernet cable to the back of the BenchCel device.
   
   b. Connect the free end of the Ethernet cable to any available port on the Ethernet switch.
Configuring the computer network card (Ethernet connection only)

The computer configured by Agilent Technologies is already set up to communicate with the BenchCel Microplate Handler. No change to the network card IP address is required.

If you are using a computer that was not configured by Agilent Technologies, make sure the value of the network card IP address and subnet mask are as follows:

- IP address: 192.168.0.1
- Subnet mask: 255.255.255.0

**WARNING**

Connecting the BenchCel Microplate Handler to a company or general network can potentially cause injury. Remote computer operators might accidentally initiate an operation that causes the robot to move unexpectedly, possibly injuring nearby lab personnel.

If your computer will be connected to your LAN, make sure the computer has a second network card. The second network card can have a dynamic IP address.

Connecting the computer to external devices (Ethernet connection only)

*To connect the external devices to the controlling computer:*

1. Connect one end of the Ethernet cable to the Ethernet port on the external device. See the device user documentation for details.
2. Connect the free end of the Ethernet cable to any available port on the Ethernet switch.
## Related information

<table>
<thead>
<tr>
<th>For more information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>The controlling computer requirements</td>
<td>“Verifying laboratory requirements” on page 37</td>
</tr>
<tr>
<td>The Ethernet switch</td>
<td>The Ethernet switch user documentation</td>
</tr>
<tr>
<td>IP addresses</td>
<td>The Microsoft Windows user documentation</td>
</tr>
<tr>
<td>Installing the BenchCel Microplate Handler</td>
<td>“Installation workflow” on page 36</td>
</tr>
<tr>
<td>Setting up the BenchCel Microplate Handler</td>
<td>“Setup workflow” on page 64</td>
</tr>
<tr>
<td>Operating the BenchCel Microplate Handler</td>
<td>“Workflow for operating the BenchCel Microplate Handler” on page 116</td>
</tr>
</tbody>
</table>
Installing the shield

About this topic

This topic explains how to install the safety shield on the front of the BenchCel Microplate Handler. Additional shields may be required depending on the workstation configuration. Typically, the BenchCel Microplate Handler and workstation safety equipment will be installed for you.

**WARNING**

Changing the configuration or components of the installed workstation might invalidate the safety compliance and lead to personal injury or equipment damage.

Before you start

Make sure you have the following:

- 3-mm hex wrench
- Low-head M5 screws (supplied)
- 1 shield for each pair of stackers

For example, a BenchCel Microplate Handler with six stackers requires three shields, as the following figure shows.
Procedure

To install the safety shield:

1. Place the safety shield on the front of the BenchCel Microplate Handler centered between the pair of stackers. The ledge of the shield should sit on the top of the device.

2. Insert the four M5 screws into the shield.

Figure  Safety shield on BenchCel Microplate Handler with two stackers (top view)

3. Tighten the screws using the M3 hex wrench.

4. Repeat steps 1 to 3 for each pair of stackers on the BenchCel Microplate Handler.

Related information

<table>
<thead>
<tr>
<th>For more information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Safety shield description</td>
<td>“Hardware overview” on page 15</td>
</tr>
<tr>
<td>Safety information</td>
<td>“Safety guidelines” on page 1</td>
</tr>
<tr>
<td>Installing the BenchCel Microplate Handler</td>
<td>“Installation workflow” on page 36</td>
</tr>
<tr>
<td>Setting up the BenchCel Microplate Handler</td>
<td>“Setup workflow” on page 64</td>
</tr>
<tr>
<td>Operating the BenchCel Microplate Handler</td>
<td>“Workflow for operating the BenchCel Microplate Handler” on page 116</td>
</tr>
</tbody>
</table>
4 Setting up the BenchCel device

This chapter explains how to set up the BenchCel Microplate Handler for operation. This chapter contains the following topics:

- “Setup workflow” on page 64
- “Starting up and shutting down” on page 66
- “Creating BenchCel device in the VWorks software” on page 68
- “Opening BenchCel Diagnostics” on page 73
- “Creating profiles” on page 76
- “Initializing the device” on page 82
- “Setting and managing teachpoints” on page 84
Setup workflow

About this topic

This topic presents the workflow for setting up the BenchCel Microplate Handler for operation.

Before you start

Before setting up the BenchCel Microplate Handler, you should already have definitions for the labware you want to use. For instructions on how to define labware in the VWorks software, see the VWorks Automation Control Setup Guide.

Before setting teachpoints (step 7 in the setup workflow), you should also adjust the BenchCel sensor thresholds for each type of labware that you use. For details, see “Setting sensor thresholds” on page 99.

Workflow

The following table presents the steps for setting up the BenchCel Microplate Handler. After setting up the BenchCel Microplate Handler for the first time, you will not likely change any of the settings in the procedure unless you add a device, replace a device, or move the BenchCel Microplate Handler.
## Setup workflow

<table>
<thead>
<tr>
<th>Step</th>
<th>For this task...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Start up the workstation.</td>
<td>“Starting up and shutting down” on page 66</td>
</tr>
<tr>
<td>2</td>
<td>Create a device file and add the BenchCel device in VWorks.</td>
<td>“Creating BenchCel device in the VWorks software” on page 68</td>
</tr>
<tr>
<td>3</td>
<td>Create a profile.</td>
<td>“Creating profiles” on page 76</td>
</tr>
<tr>
<td>4</td>
<td>Add external devices to the device file.</td>
<td>User documentation for the devices</td>
</tr>
<tr>
<td>5</td>
<td>Create a profile for each external device.</td>
<td>User documentation for the devices</td>
</tr>
<tr>
<td>6</td>
<td>Set the sensor thresholds for your labware.</td>
<td>“Setting sensor thresholds” on page 99</td>
</tr>
<tr>
<td>7</td>
<td>Set and edit teachpoints for external devices.</td>
<td>“Setting and managing teachpoints” on page 84</td>
</tr>
<tr>
<td>8</td>
<td>Write protocols.</td>
<td>VWorks Automation Control User Guide</td>
</tr>
</tbody>
</table>

### Related information

<table>
<thead>
<tr>
<th>For more information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation procedures</td>
<td>“Installation workflow” on page 36</td>
</tr>
<tr>
<td>Operating the BenchCel Microplate Handler</td>
<td>“Workflow for operating the BenchCel Microplate Handler” on page 116</td>
</tr>
<tr>
<td>Troubleshooting problems</td>
<td>“Maintenance and troubleshooting” on page 129</td>
</tr>
</tbody>
</table>
Starting up and shutting down

About this topic
This topic explains how to start up and shutdown the BenchCel Microplate Handler.

Starting up the device

**WARNING**
To avoid potential injury do not touch the BenchCel Microplate Handler as you start the software. The robot head moves when the device initializes.

**IMPORTANT**
The BenchCel safety interlock circuit must be closed for the device to operate.

**To start up the BenchCel Microplate Handler:**
1. On the back of the BenchCel Microplate Handler, press the power switch to the on (I) position.

   *Figure*  Power switch on the BenchCel Microplate Handler (back)

   Every time you turn on the BenchCel Microplate Handler, the robot homes (the robot is sent to the factory-defined home position for each axis of motion). If the BenchCel robot does not home, make sure power to the robot has been restored. (See "Recovering from an emergency stop" on page 6 to reset the emergency-stop button.) If the button has been reset and the robot still does not home, turn off the device, check the connections, and turn it on again.

2. Turn on all other devices integrated with the BenchCel Microplate Handler. See the device user documentation for instructions.

3. Turn on the compressed air supply to the BenchCel Microplate Handler.
4 Turn on the controlling computer. See the user documentation from the computer manufacturer.

5 To start the VWorks software, do one of the following:

• Double-click the shortcut icon on the Windows desktop

• Go to the Windows start menu ( ) > All Apps > Agilent Technologies > VWorks.

**Shutting down the BenchCel Microplate Handler**

Shut down the BenchCel Microplate Handler if you intend to:

• Leave it unused for a long period of time.
• Service the device.
• Move it to another location.

**To shut down the BenchCel Microplate Handler:**

1 Follow the post-run clean-up procedure after the last protocol run. See "Cleaning up after a protocol run" on page 132.

2 Exit the VWorks software.

3 If you use devices that require a vacuum pump, turn off power at the pump if the pump module has an on/off switch.

4 Turn off the compressed air to the BenchCel Microplate Handler and other devices.

5 Turn off the BenchCel Microplate Handler. To do this, on the back of the device, press the power switch to the off (O) position.

**Figure**  Power switch on the BenchCel Microplate Handler (back)

6 Turn off other devices in the BenchCel Microplate Handler.
Creating BenchCel device in the VWorks software

About this topic

Read this topic if you are an administrator responsible for managing Agilent devices that are controlled by the VWorks software. This topic describes how to add and delete new BenchCel devices in the VWorks software.

The VWorks software uses the information in a device file to communicate with and operate devices within the lab automation system.

- If your computer was configured by Agilent Technologies. The correct device configuration is already set up for communication with the BenchCel Microplate Handler. You are not required to create a new BenchCel device in the software unless you want to reference different profiles, integrate additional devices with the workstation, or change the rack size. To establish communication, you must initialize the device.

- If you configured your own computer. You must add a device in the VWorks software for the BenchCel Microplate Handler. You must also add devices in the software for any devices that are physically integrated with the workstation.

For detailed information about device files and associations with profiles, teachpoints, and labware definitions, see the VWorks Automation Control User Guide. For instructions on how to add third-party devices, see the Device Driver User Guide.

Devices and device files defined

A device is an item in your lab automation system that has an entry in a VWorks device file. A device can be a robot, an instrument, or a location in a lab automation system that can hold a piece of labware.

The device file (*.dev) stores information for all the devices in an integrated system, including:

- Type of device (for example, BenchCel device)
- Device configuration information (for example, approach height, allowed or prohibited labware, and so on)
- Profile to use
Creating a device file

If you are setting up the BenchCel Microplate Handler for the first time, you will create a device file. You add the BenchCel device and the external devices to the device file.

To create a device file:
1. Log in to the VWorks software as an Administrator.
2. In the VWorks window, choose File > New > Device.
   A Device File tab appears in the VWorks window.
3. Choose File > Save. In the Save File As dialog box, type a file name (*.dev), select the storage location, and click Save.

   4. **VWorks Plus only.** If an audit trail is being logged for records in the development state, the Audit Comment dialog box opens. Select or type the audit comment, and then click OK.

Adding the device to a device file

Before you begin:
- Ensure that any devices are physically networked to the computer.
- Turn on the devices.

To add devices to a device file:
1. In the VWorks window, verify that the correct device file is open.
   To open a device file, choose File > Open > Device. In the Open File dialog box, locate and select your device file (*.dev), and then click Open.
2. In the Available Devices area, double-click the BenchCel icon. Or, drag the BenchCel icon to the Device File tab.
4 Setting up the BenchCel device
Creating BenchCel device in the VWorks software

Note: To show or hide the list of available devices, choose **View > Available Devices**.

1

2

3 In the **Device File** tab, select the BenchCel-n icon.

4 Under BenchCel **Properties**, type a **Name** for the device. By default, the software assigns BenchCel-n, and increments the number for each BenchCel device that you add.

   To identify the specific BenchCel, the device name should include the device serial number.

5 In the **Profile** list, select a profile for the device.

   If the **Profile** list is empty, open BenchCel Diagnostics and create a profile. Then return to the **Profile** list under BenchCel **Properties** and select the new profile.

**IMPORTANT**

To use different configurations of the same device in different protocols, you can save time by creating a different device file for each configuration. For example, if you change a pipette head on a pipettor, you can simply open the device file that contains the device with the appropriate profile instead of editing the profile selection in the device file.

6 On the **Device File** tab, expand the BenchCel device icon to show the list of stackers, and then click the **Stacker 1** icon. The corresponding stacker properties appear.
4 Setting up the BenchCel device
Creating BenchCel device in the VWorks software

Set the desired values for the following properties. Use the default values for the remaining properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allowed/prohibited labware</td>
<td>Optional. Click if you want to specify labware restrictions for this location. The Allowed/prohibited labware dialog box appears. For details on the labware classes, see the VWorks Automation Control Setup Guide.</td>
</tr>
<tr>
<td>Note:</td>
<td>If the button is not visible, click the empty field.</td>
</tr>
<tr>
<td>Stack Height</td>
<td>Type the maximum height (mm) of the rack you are using at this location. For example, type 660 if you are using a 660-mm tall rack.</td>
</tr>
</tbody>
</table>

Do not change the default value of the Teachpoint for robot BenchCel property. For example, the stacker 1 teachpoint identity is 1, the identity of stacker 2 is 2, and so forth.

Repeat this step for each stacker.

7 Select **File > Save**.

If you are creating a new device file, the Save File As dialog box appears so that you can specify a name and location for your device file (*.dev).

Alternatively, you can select **File > Save All** to save the device file and the current protocol file at the same time.

8 **VWorks Plus only**. If an audit trail is being logged, the Audit Comment dialog box opens. Select or type the audit comment, and then click **OK**.
Specifying BenchCel accessibility at other devices

For any device in the workstation that the BenchCel robot will access, use the following procedure to set the Teachpoint for robot Agilent BenchCel property in the device file after you set the BenchCel teachpoint at the given device.

To set the Teachpoint for robot Agilent BenchCel property at a device:

1. In the VWorks window, open the device file that contains the BenchCel robot.

2. In the Devices area, click the location in the device that the BenchCel robot will access.

   For example, if the device file contains the BenchCel and Bravo devices, click the Bravo deck location that the BenchCel robot will access.

3. In the Location Properties for the selected location, click the setting for the Teachpoint for robot Agilent BenchCel property.

   In the following example, the BenchCel robot will transfer labware to and from Bravo deck location 3. In the Bravo Location Properties for deck location 3, the Bravo 3 teachpoint is selected. The teachpoint name, Bravo 3, is assigned when this teachpoint is set in BenchCel Diagnostics.

4. Select File > Save to save the change to the device file.

5. VWorks Plus only. If an audit trail is being logged, the Audit Comment dialog box opens. Select or type the audit comment, and then click OK.
Related information

<table>
<thead>
<tr>
<th>For information about…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>VWorks software</td>
<td>VWorks Automation Control User Guide</td>
</tr>
<tr>
<td>Setting up BenchCel Microplate Handler</td>
<td>“Setup workflow” on page 64</td>
</tr>
<tr>
<td>Profiles</td>
<td>“Creating profiles” on page 76</td>
</tr>
<tr>
<td>Teachpoints</td>
<td>“Setting and managing teachpoints” on page 84</td>
</tr>
</tbody>
</table>

Opening BenchCel Diagnostics

About this topic

To establish communication between the host computer and the device, you initialize the device. You can initialize the device in the following ways:

- **Diagnostics.** To control the device using the Diagnostics software.
- **VWorks window.** To use VWorks to control the device, for example, to run a protocol, you initialize the devices in the VWorks window.

This topic describes what happens during initialization.

Procedure

*To open Diagnostics:*

1. In the VWorks window, ensure that the correct device file is open.
   
   To open a device file, choose **File > Open > Device**, and then select the appropriate device file (* .dev) in the **Open File** dialog box.

2. In the Devices area of the opened device file tab, highlight the device icon, and then click **Device diagnostics**.
   
   Alternatively, you can double-click the device icon.
The device's diagnostics dialog box opens.

*Figure* BenchCel Diagnostics window with Profiles page displayed

Note: For VWorks 14.0 and later versions, the Profiles page contains log areas.
### Related information

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>VWorks software</td>
<td>VWorks Automation Control User Guide</td>
</tr>
<tr>
<td>Setting up BenchCel Microplate Handler</td>
<td>“Setup workflow” on page 64</td>
</tr>
<tr>
<td>Profiles</td>
<td>“Creating profiles” on page 76</td>
</tr>
<tr>
<td>Teachpoints</td>
<td>“Setting and managing teachpoints” on page 84</td>
</tr>
<tr>
<td>BenchCel Diagnostics features</td>
<td>“Diagnostic tools” on page 146</td>
</tr>
</tbody>
</table>
Creating profiles

About this topic

The computer configured by Agilent Technologies already has the correct profile to communicate with the BenchCel Microplate Handler. A new BenchCel profile is not required unless you want to set up unique communication settings or use a different teachpoint file.

If you are using a computer other than one configured by Agilent Technologies, you must create a BenchCel profile. This topic describes how to create BenchCel profiles.

You must also create profiles for devices that are integrated with the BenchCel Microplate Handler. For instructions on how to create the profiles for other Agilent devices, see the corresponding device user documentation. For instructions on how to create profiles for a third-party device, see the applicable device driver user guide.

Profiles

Each BenchCel Microplate Handler you install requires a unique profile, which enables unique communication settings.

A profile is a collection of settings that manages how you connect to devices. The software stores each profile in a device profile file (.xml).

Note: VWorks software version 13.1.x and earlier versions use the Windows Registry to store the device profile.

A BenchCel profile does the following:

- Specifies the port used to establish communication between the BenchCel Microplate Handler and the controlling computer.
- References a teachpoint file. For a description of teachpoint files, see "Setting and managing teachpoints" on page 84.
- Specifies the number of stackers for the BenchCel Microplate Handler.

You use the BenchCel Diagnostics software to create and manage profiles.

Note: The profile is referenced by a device file. For information about device files, see "Creating BenchCel device in the VWorks software" on page 68. For a detailed description of the relationships between the device file, profile, and teachpoint file, see the VWorks Automation Control User Guide.

Creating BenchCel profiles

CAUTION

Each profile can be used by multiple protocols. Deleting, renaming, or changing the parameters for a profile based on one protocol can invalidate other protocols that use the same profile.

Note: Unless you login to the VWorks software as an Administrator or Technician, only the Profile list and the Initialize this profile button are available in the Profile Management area of the Profiles page.
**To create a BenchCel profile:**

1. Open BenchCel Diagnostics.
2. On the Profiles page, click **Create a new profile**.

3. In the Create Profile dialog box, type a name, and click **OK**. Use a profile name that identifies the specific configuration, for example, you can use the device serial number.

   The change appears in the log area at the bottom of the page. For a description of this area, see “About the profile logs” on page 80.

   **VWorks Plus only.** If an audit trail is being logged for records in the development state, the Audit Comment dialog box opens. Select or type the audit comment, and then click **OK**.

4. In the Settings area, select one of the following:
   - **Ethemet connection.** Select **This BenchCel is connected via ethernet**, and proceed to step 5.
   - **Serial connection.** Select **This BenchCel is connected via serial**, and go to step 6.

5. **Ethernet connection only.** Click **Find available device** to select the device to associate with the profile. In the Discovered BioNet Devices dialog box that opens:
   a. Select the correct Ethernet adapter for the device connection. A list of devices appear.
   b. In the list of devices that appear, select the BenchCel device. If you have multiple BenchCel devices on the network, use the **MAC Address** to identify the BenchCel device you want. To successfully communicate with the BenchCel device, the **Status** column must display **New** or **Matched** for the device.
4 Setting up the BenchCel device
Creating profiles

Note: To determine the MAC address, you can turn off all other BenchCel devices so that only one appears in the Discovered BioNet Devices dialog box.

a. Click OK.

6 Serial connection only.

a. Select the COM port number on the controlling computer.

b. Select Use flow control to stop the flow of data from the computer before it overruns the device communication buffer. This option helps to optimize communication over the serial connection.

7 If you want to create a profile for a BenchCel Microplate Handler that has a different number of stacks than the one connected to the controlling computer, set the Number of stacks value.

IMPORTANT During initialization, the software automatically detects the actual number of stacks on the BenchCel Microplate Handler. If this number differs from the number specified by the profile, an error message appears and gives you the option to Abort, Retry, or Ignore. If you click Ignore, the software overwrites the Number of stacks value with the actual number of stacks.

8 Make a backup copy of the teachpoint file. If the original teachpoint file becomes lost or damaged, you can use the backup copy instead of resetting all the teachpoints and creating a new file.

a. In the Teachpoint File area, click New.

b. In the Save the Teachpoint File dialog box (VWorks 14.0 or later) or the Save As dialog box (VWorks 13.1.x), locate the teachpoint file for your profile.
4 Setting up the BenchCel device

Creating profiles

**Note:** The default teachpoint file name is Teachpoints_<profilename>.xml, where `<profilename>` is the name of the profile.

**c** Append the teachpoint file name with the word `backup`, and then click `Save`.

**Note:** The Teachpoint File area displays the file storage location.

**VWorks Plus only.** If an audit trail is being logged for records in the development state, the Audit Comment dialog box opens. Select or type the audit comment, and then click `OK`.

9 In the Teachpoint File area, click `...`, and in the **Select a Teachpoint File** dialog box, locate and select your original teachpoint file, and then click `Open`.

You will edit the teachpoints in this file in another procedure.

**CAUTION**

If the teachpoint file was copied from another computer, you must verify the teachpoints for the new profile before using the profile.
10 Click **Update this profile** to save the changes. *VWorks Plus only.* If an audit trail is being logged, the Audit Comment dialog box opens. Select or type the audit comment, and then click **OK**.

![Image of the Agilent BenchCel Diagnostics software interface](image)

11 To establish communication with the BenchCel Microplate Handler, click **Initialize this profile**.

**CAUTION**  
To prevent a potential hardware collision, make sure you have verified the teachpoints before using a profile.

If you are setting up the BenchCel Microplate Handler for the first time, return to “Creating BenchCel device in the VWorks software” on page 68 and select the profile name (step 5).

**About the profile logs**

*VWorks 14.0 and later versions only.* The Profiles page contains two log areas:

- Table of variables that have been modified since the last time the profile was updated. The table lists the old and new values for each setting you change. The software clears the table when you click Update this profile, and logs the information in the text box at the bottom of the page.

- Text box that contains a running log of updates to profiles for the current diagnostics session. This profile log activity is included in the VWorks Main Log. For details on the Main Log, see the *VWorks Automation Control User Guide*. 

**Related information**

For information about

- Adding a device in VWorks software
- Setting teachpoints

See...

- "Creating BenchCel device in the VWorks software" on page 68
- "Setting and managing teachpoints" on page 84
Initializing the device

About this topic

To establish communication between the computer and the BenchCel Microplate Handler, you initialize the BenchCel device. You can initialize the BenchCel Microplate Handler in the following ways:

- **BenchCel Diagnostics.** To control the BenchCel Microplate Handler using BenchCel Diagnostics, initialize the profile in BenchCel Diagnostics.
- **VWorks window.** To control the BenchCel Microplate Handler from the VWorks window, for example, to run a protocol, initialize the device in the VWorks window.

Before you start

Ensure that you have added the BenchCel device to a VWorks device file and that you have a valid BenchCel profile.

Initializing the device in Diagnostics

To initialize a profile in BenchCel Diagnostics:

1. In the VWorks window, open the device file for the profile that you want to initialize. To open a device file, choose File > Open > Device. In the Open File dialog box, select the file, and then click Open.
2. Click No if the Would you like to initialize devices now? message appears.
3. In the device file tab, select the device, and then click Device diagnostics to open the BenchCel Diagnostics dialog box.
In the Profiles tab, ensure that the correct profile is selected in the Profile name list, and then click Initialize this profile to start initializing the selected profile.

Initializing the device in the VWorks software

To initialize the device from the VWorks window:

1. In the VWorks window, open the device file. To open a device file, choose File > Open > Device. In the Open File dialog box, select the file, and then click Open.

2. In the Devices area, highlight the device that you want to establish communication with, and verify that the correct profile is selected in the BenchCel Properties area.

3. Click Initialize selected devices or Initialize all devices.
Related information

<table>
<thead>
<tr>
<th>For information about</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding a device in VWorks software</td>
<td>“Creating BenchCel device in the VWorks software” on page 68</td>
</tr>
<tr>
<td>Creating a profile</td>
<td>“Creating profiles” on page 76</td>
</tr>
</tbody>
</table>

Setting and managing teachpoints

About this topic

This topic describes teachpoints and how to set them.

Teachpoints defined

A teachpoint is a set of coordinates that define where the robot can pick up or place labware. The location can be on an external device or a platepad. You set, edit, and save teachpoints in BenchCel Diagnostics. The teachpoints are displayed as plus signs (+) in the graphical display area in the BenchCel Diagnostics dialog box.

Note: The graphical display area also shows teachpoints (+) at the stacks. These teachpoints are preset at the factory and should not be changed.

Figure  Example teachpoints for labware pickup and placement location at integrated devices

Teachpoint files

The teachpoints you set are saved in the XML format in a teachpoint file. The default teachpoint file name is Teachpoints_<profilename>.xml, where <profilename> is the name of the profile. The Teachpoint File area in the Profiles page displays the file path.
4 Setting up the BenchCel device
Setting and managing teachpoints

You must use one teachpoint file for each BenchCel device. If you integrate a new device with the BenchCel Microplate Handler, you can add the new teachpoints to the existing file. If you have multiple BenchCel devices in a workstation, you must create a teachpoint file for each BenchCel device in the workstation.

The teachpoint file is referenced by a profile. For information about profiles, see “Creating profiles” on page 76.

Workflow for setting teachpoints

<table>
<thead>
<tr>
<th>Step</th>
<th>For this task…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>“Determining the teachpoint coordinates” on page 86</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>“Locking the device positions” on page 90</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>“Recording the teachpoint coordinates” on page 91</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>“Verifying the teachpoints” on page 96</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>“Editing existing teachpoints” on page 97</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Set the Teachpoint for robot Agilent BenchCel property in the device file. “Specifying BenchCel accessibility at other devices” on page 72</td>
<td></td>
</tr>
</tbody>
</table>

Before you start

**IMPORTANT** Before you start changing teachpoints, ensure that you have a backup copy of the teachpoint file. If the original teachpoint file becomes lost or damaged, you can use the backup copy instead of resetting all the teachpoints and creating a new file.

- Verify that the labware you want to use has a corresponding labware entry in the software. To view the labware entries, click Tools > Labware Editor in the VWorks window.
- Initialize the correct profile in BenchCel Diagnostics. For details, see “Initializing the device” on page 82.
Determining the teachpoint coordinates

**WARNING**
To prevent potential injury, make sure no one else can issue commands at the controlling computer while you are manually determining the teachpoint coordinates.

**To determine the coordinates of the pickup and placement location:**

1. Place two or three spare microplates in a labware rack, and then install the rack on the BenchCel Microplate Handler. For instructions, see “Filling and emptying the labware racks” on page 119 and “Installing and uninstalling the labware racks” on page 123.

2. Open BenchCel Diagnostics for the BenchCel device that you are setting up.

3. On the Profiles page, look in the Teachpoint File area to make sure the correct teachpoint file is loaded. You will be adding new teachpoints to this file.

4. In the Controls tab, select the labware definition from the Labware list.
5 In the graphical display area, click Stacker at the top of the rack that contains the spare microplates. In the menu that appears, click Load plates.

![Diagram showing Stacker and Load plates options]

The BenchCel device moves the stack down and holds the stack in the stacker grippers, or supports the stack on the stacker shelf, as specified in the labware definition.

6 In the graphical display area, click the plus sign (➕) at the stacker head that contains the spare microplates. In the menu that appears, click Downstack from Stacker.

![Diagram showing Downstack from Stacker option]

The robot head moves under the stacker and holds the first spare microplate in its grippers.

7 On the Controls page, click the Jog/Teach tab.
8 Click **Go Home**. The robot head moves to its home position at the center of the BenchCel Microplate Handler.

*Note: The microplate is still in the robot grippers from step 6.*

![Image of Go Home](image)

9 In the **Motors Enabled** area, clear the check boxes for **X** and **Theta** to disable the \( x \)-axis and \( \theta \)-axis motors. The \( z \)-axis motor is still enabled (the Z box is selected).

![Image of Motors Enabled](image)

10 With the robot grippers holding the spare microplate, gently push or pull the robot head and arms close to the teachpoint location. Position the robot head and arms so that the microplate rests in the target microplate location.
11 To fine-tune the teachpoint until you are able to place the microplate in the target location, use the following methods:

- Visually inspect the position of the microplate relative to the plate stage. If the robot is not aligned with the plate stage along the y-axis (front-to-back direction), move the robot into the safe zone, physically slide the external device and its integration plate along the y-axis, move the robot back and see if the robot arms are aligned with the plate stage. You might have to loosen the clamp screw to slide the device (see “About integrating devices in a BenchCel Workstation” on page 47).

- To move the robot head up or down in small, precise increments, open BenchCel Diagnostics. On the Controls page Jog/Teach tab, select the jog increment from the corresponding list, and then click Up (↑) or Down (↓).

- With the x-axis and theta-axis motors disabled, gently push or pull the robot side to side so that the robot arms are able to place the microplate on the plate stage.

The microplate should sit level on the target location. In addition, the robot arms should not come in contact with any part of the target platepad, plate stage, or other surfaces.

12 Visually inspect the position of the microplate on the target location. It should be centered on the location. If it is not, ensure that the x-axis and theta-axis motors are disabled on the Jog/Teach tab, and then manually move the robot head to the microplate at the location.
Locking the device positions

**CAUTION** Tightening the clamp screw can cause the teachpoint to shift. Make sure you verify the teachpoint coordinates after locking the device position.

Before you record the teachpoint, lock the devices in their positions.

*To lock the devices in their positions:*

1. Tighten the BenchCel integration plate clamp screw using the 3-mm hex wrench.
2. Check the teachpoint coordinates again. See "Determining the teachpoint coordinates" on page 86.
Recording the teachpoint coordinates

To record the teachpoint coordinates in BenchCel Diagnostics:

1. Ensure the robot is holding the microplate at the teachpoint location.
2. On the Controls page Jog/Teach tab, click New teachpoint.
3. In the Teachpoint Details dialog box, click Use current positions. The robot’s current coordinates fill the Theta, X, and Z boxes.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Theta</td>
<td>The angle that the robot arms are from their home position, in degrees. A positive value moves the arms counterclockwise from the home position. A negative value moves the arms are clockwise from the home position. The range of movement is from -115° to 115°.</td>
</tr>
<tr>
<td>X</td>
<td>The horizontal distance (mm) from the home position. A positive value moves the robot head to the right of the home position. A negative value moves the robot head to the left of the home position. The range of movement depends on the number of stacker heads. For two stacker heads, the range is from –145 mm to 145 mm.</td>
</tr>
<tr>
<td>Z</td>
<td>The vertical distance (mm) from the home or lowest z-axis position. A positive value moves the robot head up from the home position. A negative value moves the head down from the home position. The range of movement is from -1.5 mm to 104 mm.</td>
</tr>
</tbody>
</table>

**IMPORTANT** Ensure the Z value is greater than -1.5 mm. If it is not, jog the z-axis up to obtain a value that is larger. Otherwise, the software will issue a z-position out-of-bounds error if a plate with a smaller Robot gripper offset is used.
4 Set the remaining teachpoint parameters and options in the Teachpoint Details dialog box:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type a one-word name for the teachpoint. For example, if the teachpoint is on an integrated Microplate Labeler, you might want to name the teachpoint <em>Labeler</em>. This name appears in the graphical display area in the BenchCel Diagnostics dialog box.</td>
</tr>
<tr>
<td>Approach height</td>
<td>Type the height clearance (mm) the robot must maintain above the teachpoint as it moves towards or away from the teachpoint location. The valid range is from 0 mm to 40 mm. Use this setting to prevent the robot from colliding with raised tabs or walls at the teachpoint location. You can start with an approach height of 20 mm (default). However, if there is an obstruction above the teachpoint, a smaller approach height might be required to prevent a collision. Note: This value applies when the robot is holding a microplate. When it is not holding a microplate, the robot will approach the teachpoint at the height of the teachpoint, unless you select the Respect approach height when not holding a plate option.</td>
</tr>
</tbody>
</table>
## Setting up the BenchCel device

### Setting and managing teachpoints

<table>
<thead>
<tr>
<th>Setting</th>
<th>Comment</th>
</tr>
</thead>
</table>
| Cavity depth                         | This setting is not commonly used and should be set at 0 mm for most applications.  
You can use this setting to account for teachpoints that have a depth (or negative height). To do this, type the depth (mm) as an offset to the Robot gripper offset. A positive value causes the grippers to grab higher on the plate by the specified amount. A negative value causes the grippers to grab lower on the plate.  
For example, suppose the Robot gripper offset is 5 mm and the platepad you want to use has depth of 9 mm. When the microplate sits in the platepad, the robot grippers cannot reach the offset height, as the following diagram shows. To account for this depth, you can set the Cavity depth at – 9 mm. The robot grippers will grip the microplate 9 mm above the 5 mm offset (at 14 mm). |
| Gripper open limit                   | Type the maximum distance (mm) the robot grippers are allowed to open as they prepare to grip the microplate at the teachpoint. The maximum value you set is less than or equal to the Robot Gripper Open Position value set in the BenchCel Diagnostics Controls Labware tab.  
Use this setting if the teachpoint area is narrower than the robot grippers open position. (To see this value, click **Save and exit**, and then click the Labware tab in the BenchCel Diagnostics Control tab.)  
*Note*: This value is used only at the teachpoint and not during other operations. |
| Respect approach height when not holding a plate | Select the check box to use the approach height even when the robot is not holding labware.  
**CAUTION** Before you clear this check box, ensure that the grippers will not run into the locating feet of the stage. Otherwise, clearing this check box can result in a crash. |
## Setting up the BenchCel device

### Setting and managing teachpoints

<table>
<thead>
<tr>
<th>Setting</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Something is above this point</td>
<td>Select the option to limit the robot’s movements within the robot safe zone. With this selection, the robot will move only along the theta-axis as long as all of its parts (head, arms, grippers, and labware) are within the safe zone when approaching or moving away from the teachpoint.</td>
</tr>
</tbody>
</table>

![Diagram of BenchCel robot with dashed line indicating safe zone]

Clear the check box to allow the robot to use the full workspace. The robot’s theta-axis movements are not limited when approaching and moving away from the teachpoint.

![Diagram of BenchCel robot with dotted line indicating full workspace]

Use this option to limit the robot’s movements to prevent collision when approaching a teachpoint. For example, when moving labware to and from a multi-shelf device such as the Vertical Pipetting Station, this option prevents the robot from colliding with the shelf above the target teachpoint.

![Diagram of BenchCel robot with dashed line indicating safe zone above teachpoint]

5 Click **Save and Exit** to save the teachpoint in the teachpoint file and close the Teachpoint Details dialog box. On the **Controls** page in BenchCel Diagnostics, the new teachpoint appears in the graphical display area as a plus sign (➕).
6. Gently push or pull the robot into the safe zone.
7. On the Jog/Teach tab, click Go Home. The software prompts you to enable all the motors. After the motors are enabled, the robot head moves to the center of the BenchCel device, and the robot arms are perpendicular to the x-axis. The robot grippers are still holding the spare microplate you used to set the teachpoint.

8. On the Controls page, click the plus sign (+) of the stacker that is holding the spare microplates, and then choose Upstack to Stacker. The robot moves the microplate back into the stack.

9. Save the device file.
10. VWorks Plus only. If an audit trail is being logged, the Audit Comment dialog box opens. Select or type the audit comment, and then click OK.
Verifying the teachpoints

To verify a teachpoint:

1. Load two to three spare microplates in the labware rack and load the rack on the BenchCel device. For instructions, see “Filling and emptying the labware racks” on page 119 and “Installing and uninstalling the labware racks” on page 123.

2. In BenchCel Diagnostics, click the Controls tab, and select the desired labware definition from the Labware list.

3. In the graphical display area, click the plus sign (⁺) at both of the following locations:
   - The stack that contains the spare microplates
   - The teachpoint you want to verify

   The selected teachpoints should be highlighted in red circles (⁺).

4. In the Speed list, select Slow.
   Note: You can set the Slow speed as a percentage of the factory-set maximum speed. To do this, see “Changing the robot speed” on page 149.

5. In the graphical display area, click the stacker that contains the spare microplates. In the command menu that appears, click Transfer to <teachpoint name>, where <teachpoint name> is the name of the teachpoint you are verifying. The robot picks up the first microplate in the stack and moves it to the selected teachpoint.
   - If the robot did not move the microplate to the correct location, proceed to “Editing existing teachpoints” on page 97 to refine the teachpoint.
   - If the robot correctly placed the microplate at the new teachpoint, move the microplate back to the stack as follows:

     In the graphical display area, click the plus sign (⁺) at the new teachpoint, and then choose Transfer to Stack. The robot moves the microplate from the teachpoint back to the stack.
Editing existing teachpoints

When you set a teachpoint for the first time, you will likely set, verify, and edit the teachpoint a number of times to ensure that the teachpoint is correct. After the teachpoint is correct, no further teachpoint adjustment is required unless you do the following:

- Move the BenchCel Microplate Handler
- Move or replace one of the devices in the workstation
- Adjust settings on the devices

To edit an existing teachpoint:

1. In BenchCel Diagnostics, click the Profiles tab, and verify that the correct teachpoint file is loaded.

2. Click the Controls tab. In the graphical display area, double-click the plus sign (+) of the teachpoint you want to edit.

The Teachpoint Details dialog box opens and displays the current coordinates and settings for the selected teachpoint.

3. Do one of the following:
   - Follow the instructions in "Determining the teachpoint coordinates" on page 86 to manually move the robot head to a new teachpoint position and set the teachpoint.
   - Type new coordinate values or change any of the existing settings.

4. Click Save and Exit to save the revised teachpoint in the teachpoint file.

5. VWorks Plus only. If an audit trail is being logged, the Audit Comment dialog box opens. Select or type the audit comment, and then click OK.
Deleting teachpoints

To delete a teachpoint:

1. In BenchCel Diagnostics, click the Profiles tab, and verify that the correct teachpoint file is loaded.

2. In the graphical display area, double-click the plus sign (➕) of the teachpoint you want to delete.

3. In the Teachpoint Details dialog box, click Delete. The current teachpoint file will automatically be updated when you delete a teachpoint.

4. Save the device file.

5. VWorks Plus only. If an audit trail is being logged, the Audit Comment dialog box opens. Select or type the audit comment, and then click OK.

Related information

<table>
<thead>
<tr>
<th>For information about</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setup procedure</td>
<td>“Setup workflow” on page 64</td>
</tr>
<tr>
<td>Integrating external devices</td>
<td>“About integrating devices in a BenchCel Workstation” on page 47</td>
</tr>
<tr>
<td>Moving between teachpoints</td>
<td>“Diagnostic tools” on page 146</td>
</tr>
</tbody>
</table>
5 Setting sensor thresholds

This chapter describes how to set the sensor thresholds correctly for the specific type of labware you are using.

This chapter contains the following topics:
- “Overview for setting sensor thresholds” on page 100
- “Calculating the Plate presence threshold” on page 102
- “Determining the optimum Orientation sensor offset” on page 107
- “Calculating the Orientation threshold” on page 111
- “Worksheet for setting sensor thresholds” on page 113
Overview for setting sensor thresholds

About this topic

You must set the Plate-presence and Orientation thresholds correctly for the specific type of labware you are using to ensure proper operation. For example, the thresholds must be accurate to ensure proper upstacking and downstacking of the labware. You must set the thresholds for the labware type before using the labware in a BenchCel protocol run.

This topic explains how the plate-orientation sensors work and the workflow for setting the sensor thresholds.

How the plate-orientation sensors work

Four plate-orientation sensors on the inside wall of the stacker head detect the presence of microplate notches when the microplate is downstacked. Each sensor contains a light emitter that transmits light, and a receiver that reads the amount of light reflected by the surface of the microplate.

If the light beam bounces off of a wall that is perpendicular to its path, most of the light will reflect back. The resulting reading is relatively high. If the light beam bounces off of a wall that is not perpendicular to the light path, the light will be deflected. The resulting reading is significantly lower.

Figure  Emitted light path on the notched and unnotched corners of a plate

The amount of light that the sensor receives is displayed in BenchCel Diagnostics on the Controls page Jog/Teach tab. The microplate corners that have notches should have much lower readings than the corners that do not have notches. In the following example, the sensors detect a notch in the upper right and lower left corners of the microplate.
The following factors can affect the reading of the notch sensor and might require that you adjust the sensor light intensity:

- **Microplate position.** For optimum results, the sensor light should bounce off of the microplate at halfway between the top of the microplate and the top of the plate skirt.
- **Microplate color.** Darker microplate color might require higher light intensity.
- **Microplate material.** Shiny or reflective microplates might require lower light intensity.
- **Microplate condition.** Cracks, chips, scratches, or defects in the area where the sensor light contacts the microplate can affect sensor reading.
- **Ambient light.** Brighter rooms might require lower light intensity.

**Workflow for setting sensor thresholds**

**Before you start**

Make sure you have three spare microplates for each BenchCel stacker head. For example, if the BenchCel Microplate Handler has six stacker heads, you should have 18 microplates.

Make a copy of the provided "Worksheet for setting sensor thresholds" on page 113. You can use it to record sensor readings and facilitate threshold calculations.

**Workflow**

<table>
<thead>
<tr>
<th>Step</th>
<th>For this task…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Calculate the Plate-presence threshold.</td>
<td>“Calculating the Plate presence threshold” on page 102</td>
</tr>
<tr>
<td>2</td>
<td>Determine the optimum sensor offset at each stack.</td>
<td>“Determining the optimum Orientation sensor offset” on page 107</td>
</tr>
<tr>
<td>3</td>
<td>Calculate the Orientation threshold based on the observed Notch Sensors readings.</td>
<td>“Calculating the Orientation threshold” on page 111</td>
</tr>
</tbody>
</table>
Calculating the Plate presence threshold

About this topic

You must calculate the Plate presence threshold for the specific type of labware you are using.

Before you start, see “Overview for setting sensor thresholds” on page 100.

Workflow for calculating the Plate-presence threshold

Use the following workflow to calculate the Plate presence threshold.

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Determine the highest Plate-presence reading among all the stacks when no microplate is loaded ((P_{\text{unloaded}})).</td>
</tr>
<tr>
<td>2</td>
<td>Determine the lowest Plate-presence reading among all the stacks when the first microplate is loaded in each stack ((P_{\text{loaded}})).</td>
</tr>
<tr>
<td>3</td>
<td>Use the results from steps 1 and 2 to calculate the threshold.</td>
</tr>
</tbody>
</table>

Determining the Plate presence reading when no microplates are loaded

To determine the highest Plate presence reading when no microplates are loaded:

1. Install a labware rack at each stacker head, and place three microplates in each labware rack. The microplates should rest on top of the stacker grippers. (See “Filling and emptying the labware racks” on page 119.)

   IMPORTANT

   Do not click Load All in BenchCel Diagnostics.
2. In BenchCel Diagnostics on the Controls page, click the Labware tab. In the Sensors area, set the initial values as follows:
   - **Plate presence threshold** at 225 units.
   - **Intensity** at 100%.
   Click **Apply and save labware parameters**.

### VWorks Plus only
If an audit trail is being logged, the Audit Comment dialog box opens. Select or type the audit comment, and then click **OK**.

3. Click the Jog/Teach tab. In the Stacker Sensors area:
   a. Select stack 1 from the list.
   b. Record the **Plate presence** reading.
   c. Repeat steps a and b for each of the remaining stacks.
   d. In the list, select the number of the stack that has the highest Plate presence reading.

![Diagram of Jog/Teach tab]

4. On the Labware tab, adjust the **Intensity** value so that the highest **Plate presence** reading (Jog/Teach tab) is less than or equal to 175. Click **Apply and save labware parameters**.

### VWorks Plus only
If an audit trail is being logged, the Audit Comment dialog box opens. Select or type the audit comment, and then click **OK**.

Use the following guidelines when adjusting the Intensity value:
- For the most reliable sensor function, use the highest Intensity value possible while keeping the Plate presence reading no greater than 175.
- If the Plate presence reading is greater than 175, decrease the Intensity value incrementally so that the Plate presence reading is reduced to 175.

For example, if a light-colored microplate has a Plate presence reading of 200, decreasing the Intensity value to 20 reduces the reading to 175.
5 Setting sensor thresholds
Calculating the Plate presence threshold

On the Jog/Teach tab, find the highest Plate presence reading ($P_{\text{unloaded}}$) among all the stacks as follows:

- Select stack 1 from the list.
- Record the Plate presence reading.
- Repeat steps a and b for each of the remaining stacks.
- Assign the highest Plate presence reading to $P_{\text{unloaded}}$, the highest Plate presence threshold when no microplate is loaded. The value will be used to calculate the Plate presence threshold.

In the following example, the highest Plate presence reading is 51 (stack 2).

<table>
<thead>
<tr>
<th>Stack 1</th>
<th>Stack 2</th>
<th>Stack 3</th>
<th>Stack 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>48</td>
<td>51</td>
<td>50</td>
<td>45</td>
</tr>
</tbody>
</table>

Determining the Plate presence reading when microplates are loaded

To determine the lowest Plate presence reading when a microplate is loaded in each stack:

**IMPORTANT**

The Plate presence reading can vary depending on the Stack Holding Method, which is specified in the Labware Editor. For greater precision, use the stacker grippers for the Stack Holding Method.

1 On the Controls page, click Load All.
Setting sensor thresholds

Calculating the Plate presence threshold

On the Jog/Teach tab:

a. Select stack 1.
b. Record the Plate presence reading.
c. Repeat steps a and b for each of the remaining stacks.
d. Assign the lowest Plate presence reading to $P_{\text{loaded}}$, the lowest Plate presence threshold when microplates are loaded. The value will be used to calculate the Plate presence threshold.

In the following example, the lowest Plate presence reading is 131 (stack 1).

<table>
<thead>
<tr>
<th>Stack 1</th>
<th>Stack 2</th>
<th>Stack 3</th>
<th>Stack 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>131</td>
<td>139</td>
<td>140</td>
<td>135</td>
</tr>
</tbody>
</table>

Calculating the threshold

To calculate the Plate presence threshold:

1. Calculate the threshold using the following formula:
   Plate presence threshold = ($P_{\text{unloaded}}$ + $P_{\text{loaded}}$)/2

In the following example, the calculated threshold is 91.

<table>
<thead>
<tr>
<th>$P_{\text{unloaded}}$</th>
<th>$P_{\text{loaded}}$</th>
<th>Plate presence threshold</th>
</tr>
</thead>
<tbody>
<tr>
<td>51</td>
<td>131</td>
<td>91</td>
</tr>
</tbody>
</table>

2. On the Jog/Teach tab, type the calculated Plate presence threshold, and then click Apply & save.
VWorks Plus only. If an audit trail is being logged, the Audit Comment dialog box opens. Select or type the audit comment, and then click OK.

Related information

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflow for setting sensor thresholds</td>
<td>&quot;Overview for setting sensor thresholds&quot; on page 100</td>
</tr>
<tr>
<td>Next steps in this workflow</td>
<td>• “Determining the optimum Orientation sensor offset” on page 107</td>
</tr>
<tr>
<td></td>
<td>• “Calculating the Orientation threshold” on page 111</td>
</tr>
<tr>
<td>Worksheet for sensor thresholds</td>
<td>“Worksheet for setting sensor thresholds” on page 113</td>
</tr>
<tr>
<td>Labware definitions and the Labware Editor</td>
<td>VWorks Automation Control Setup Guide</td>
</tr>
<tr>
<td>Filling and emptying the labware racks</td>
<td>“Filling and emptying the labware racks” on page 119</td>
</tr>
</tbody>
</table>
Determining the optimum Orientation sensor offset

About this topic

Before starting this procedure, make sure you are familiar with the workflow in “Overview for setting sensor thresholds” on page 100.

Procedure

To determine the optimum Orientation sensor offset:

1. On the Controls page at Stacker 1, click Downstack from Stacker.

2. On the Labware tab, verify that the Orientation sensor offset box contains the initial offset value you want to use for the selected labware.

   If you have not already done so, follow these steps to determine the initial value for the Orientation sensor offset:
   
   a. Determine the midpoint height (mm) of the microplate. To do this, measure from the top of the microplate skirt to the top of the microplate and divide by 2.
   
   b. Measure the height (mm) of the microplate skirt.
   
   c. Add the values from step a and step b.
5 Setting sensor thresholds
Determining the optimum Orientation sensor offset

3 On the Controls page at Stacker 1, click Move to sensor. The robot moves the first microplate into the line of notch sensors.

4 On the Jog/Teach tab, make sure the Notch Sensors readings are appropriate. The notches should have much lower readings than the corners. In addition, the difference between the notch readings and corner readings should be at a maximum.

In the following example, the Notch Sensors values indicate that the microplate has two notches (3 and 7) and two corners (76 and 63).
To find the maximum difference between the notch readings and corner readings:

a. On the **Controls** page, locate the initial z-axis position (\(Z_{\text{initial}}\)) in the upper left corner. Record the value.

b. Use the controls on the **Jog/Teach** tab to jog the robot up or down, and then check the **Notch Sensors** readings. You can repeat this step until you find the maximum difference between the notch readings and the corner readings.

c. Record the adjusted z-axis position (\(Z_{\text{adjusted}}\)).

6. Calculate the jog distance:

\[
\text{Jog distance} = Z_{\text{initial}} - Z_{\text{adjusted}}
\]

In the following example, the jog distance is –5.00 mm.

---

**BenchCel Diagnostics v1.7.0.3**

<table>
<thead>
<tr>
<th>Controls</th>
<th>General Settings</th>
<th>Profile</th>
</tr>
</thead>
<tbody>
<tr>
<td>X: 0.00 mm</td>
<td>Z: 55.27 mm</td>
<td>Theta: 0.83°</td>
</tr>
<tr>
<td>Grip: 7.83 mm</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Z_{\text{initial}}</th>
<th>50.27 mm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Z_{\text{adjusted}}</td>
<td>55.27 mm</td>
</tr>
<tr>
<td>Jog distance</td>
<td>–5.00 mm</td>
</tr>
</tbody>
</table>

7. Calculate the adjusted Orientation sensor offset using the following formula:

\[
\text{Adjusted Orientation sensor offset} = Z_{\text{initial}} - Z_{\text{adjusted}}
\]

In the following example, the adjusted orientation sensor offset is 3.80 mm.

---

Initial Orientation sensor offset

<table>
<thead>
<tr>
<th>Jog distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>–5.00 mm</td>
</tr>
</tbody>
</table>

Adjusted Orientation sensor offset

| 3.80 mm |

---

8. On the **Labware** tab, type the adjusted **Orientation sensor offset**.

9. On the **Control** page at the next stacker, click **Downstack from Stacker**, and then click **Move to sensor**. Check the **Notch Sensors** readings on the **Jog/Teach** tab. The notches should have much lower readings than the corners. In addition, the difference between the notch readings and corner readings should be at a maximum.
5 Setting sensor thresholds
Determining the optimum Orientation sensor offset

10 Repeat step 9 for the remaining stackers.

Related information

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflow for setting sensor thresholds</td>
<td>“Overview for setting sensor thresholds” on page 100</td>
</tr>
<tr>
<td>Worksheet for sensor thresholds</td>
<td>“Worksheet for setting sensor thresholds” on page 113</td>
</tr>
<tr>
<td>Previous step in this workflow</td>
<td>“Calculating the Plate presence threshold” on page 102</td>
</tr>
<tr>
<td>Next step in this workflow</td>
<td>“Calculating the Orientation threshold” on page 111</td>
</tr>
</tbody>
</table>
Calculating the Orientation threshold

**About this topic**

Before you start this procedure, make sure you are familiar with the workflow in “Overview for setting sensor thresholds” on page 100.

**Procedure**

To calculate the Orientation threshold:

1. At each stacker, determine the highest reading for the notch and lowest reading for the corner as follows:
   
   - **a** In BenchCel Diagnostics, click the **Controls** tab. In the graphical display area click **Stacker 1**, and then click **Move to sensors**.
   
   - **b** On the **Jog/Teach** tab in the **Stacker Sensors** area, select stack 1 from the list.
   
   - **c** In the **Notch Sensors** area, find the highest reading for the notch and lowest reading for the corner, and then record these readings. (In the example below, the highest notch reading is 7, and the lowest corner reading is 62.)
   
   - **d** Repeat step **a** to step **c** for the remaining stacks.

   ![Diagram](image)

2. Find the highest notch reading ($Notch_{\text{highest}}$) among all the stacks. In the following example, the highest reading is 35 (stack 3).

<table>
<thead>
<tr>
<th>Stack 1</th>
<th>Stack 2</th>
<th>Stack 3</th>
<th>Stack 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>25</td>
<td>35</td>
<td>15</td>
</tr>
</tbody>
</table>

3. Find the lowest corner reading ($Corner_{\text{lowest}}$) among all the stacks. In the following example, the lowest reading is 235 (stack 4).

<table>
<thead>
<tr>
<th>Stack 1</th>
<th>Stack 2</th>
<th>Stack 3</th>
<th>Stack 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>244</td>
<td>238</td>
<td>245</td>
<td>235</td>
</tr>
</tbody>
</table>
4 Calculate the Orientation threshold as follows:
   Orientation threshold = (Notch\text{highest} + \text{Corner}\text{lowest})/2

In the following example, the calculated threshold is 135.

| Highest notch reading among all stacks | 35 |
| Lowest corner reading among all stacks | 235 |
| Orientation threshold (midpoint) | 135 |

5 On the Jog/Teach tab, type the calculated Orientation threshold.

After you finish setting the sensor thresholds for the specific type of labware, you can use the labware in a protocol.

Related information

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overall workflow for setting sensor thresholds</td>
<td>“Overview for setting sensor thresholds” on page 100</td>
</tr>
</tbody>
</table>
| Previous steps in this workflow | • “Calculating the Plate presence threshold” on page 102  
• “Determining the optimum Orientation sensor offset” on page 107 |
| Worksheet for sensor thresholds | “Worksheet for setting sensor thresholds” on page 113 |
Worksheet for setting sensor thresholds

About this worksheet

Use this worksheet to record sensor readings and facilitate your threshold calculations. See "Overview for setting sensor thresholds" on page 100 for the procedures to calculate the thresholds.

Plate-presence threshold

Determine the Plate presence readings when microplates are unloaded

Set the initial values as follows:

- Plate presence threshold = 225 units
- Intensity = 100%

Record the Plate presence reading for each stack.

<table>
<thead>
<tr>
<th>Stack 1</th>
<th>Stack 2</th>
<th>Stack 3</th>
<th>Stack 4</th>
<th>Stack 5</th>
<th>Stack 6</th>
</tr>
</thead>
</table>

Adjust the Intensity value so that the highest Plate presence reading is less than or equal to 175, and then record the Plate presence readings for each stack.

<table>
<thead>
<tr>
<th>Stack 1</th>
<th>Stack 2</th>
<th>Stack 3</th>
<th>Stack 4</th>
<th>Stack 5</th>
<th>Stack 6</th>
</tr>
</thead>
</table>

Highest reading among all the stacks (P_{unloaded}): ________________

Determine the Plate presence readings when the microplates are loaded

After loading the microplates at each stack (Load All in BenchCel Diagnostics), record the Plate presence readings for each stack.

<table>
<thead>
<tr>
<th>Stack 1</th>
<th>Stack 2</th>
<th>Stack 3</th>
<th>Stack 4</th>
<th>Stack 5</th>
<th>Stack 6</th>
</tr>
</thead>
</table>

Lowest reading among all the stacks (P_{loaded}): ________________

Calculate the Plate presence threshold

Plate presence threshold = (P_{unloaded} + P_{loaded})/2 = ______
Optimum Orientation sensor offset

Initial Orientation sensor offset
Measure A and B of your microplate.

Initial Orientation sensor offset = \( \frac{A}{2} + B \) = _________ mm

Jog distance
Jog distance = \( Z_{\text{initial}} - Z_{\text{adjusted}} \) = _________ mm

Adjusted Orientation sensor offset
Adjusted Orientation sensor offset =
Initial Orientation sensor offset + Jog distance = _____________ mm

Orientation threshold

In graphical display area on the Controls page, click Stacker, and then choose Move to Sensor. On the Jog/Teach tab, find the highest notch reading in the Notch Sensors area. Repeat this step for each stack.

Note: Notches have lower readings than corners.

Highest Notch Sensors readings
Record the highest notch reading for each stack.

<table>
<thead>
<tr>
<th>Stack 1</th>
<th>Stack 2</th>
<th>Stack 3</th>
<th>Stack 4</th>
<th>Stack 5</th>
<th>Stack 6</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Highest reading among all stacks (Notch_{\text{highest}}): __________.

Lowest Corner readings
Record the lowest corner reading for each stack.

<table>
<thead>
<tr>
<th>Stack 1</th>
<th>Stack 2</th>
<th>Stack 3</th>
<th>Stack 4</th>
<th>Stack 5</th>
<th>Stack 6</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Lowest reading among all stacks (Corner_{\text{lowest}}): __________.

Orientation threshold
Orientation threshold = \( \frac{\text{Notch}_{\text{highest}} + \text{Corner}_{\text{lowest}}}{2} \) = __________.
6 Preparing for a run

This chapter describes how to prepare for a protocol run on the BenchCel Microplate Handler. All of the procedures in this chapter can be performed by someone with operator privileges.

This chapter contains the following topics:

- “Workflow for operating the BenchCel Microplate Handler” on page 116
- “Handling the labware racks” on page 117
- “Filling and emptying the labware racks” on page 119
- “Installing and uninstalling the labware racks” on page 123
- “Performing pre-run checks” on page 128
Workflow for operating the BenchCel Microplate Handler

About this topic

This topic presents the workflow for operating the BenchCel Microplate Handler.

Before you start

Make sure that you have:

- Initialized the correct profile. See “Creating profiles” on page 76.
- Verified the teachpoints per “Verifying the teachpoints” on page 96.
- Set the Plate-presence and Orientation thresholds for the type of microplate you are using. See “Setting sensor thresholds” on page 99.

Workflow

<table>
<thead>
<tr>
<th>Step</th>
<th>For this task...</th>
<th>See...</th>
</tr>
</thead>
</table>
| 1    | Place the labware into the rack and mount the rack on the device. | • “Handling the labware racks” on page 117  
• “Filling and emptying the labware racks” on page 119  
• “Installing and uninstalling the labware racks” on page 123 |
| 2    | Perform pre-run checks. | “Performing pre-run checks” on page 128 |
| 3    | Prepare devices and accessories. | Device user documentation |
| 4    | Open a protocol in the VWorks software. | VWorks Automation Control User Guide |
| 5    | Start and monitor a protocol run. | VWorks Automation Control User Guide |
| 6    | Clean up after the run. | “Cleaning up after a protocol run” on page 132 |

Related information

For information about...  
Defining the labware  
See...  
- “Changing labware parameters” on page 154  
- “Setting sensor thresholds” on page 99  
- VWorks Automation Control Setup Guide
Handling the labware racks

About this topic

The labware racks store the stacks of labware (microplates, tip boxes, and tube racks) that are processed during a protocol run. This topic describes how to carry labware racks safely.

Carrying the labware racks

**WARNING**

Do not hold a rack by the interior edges. The interior edges might have sharp surfaces that could cause cuts if handled improperly.

**CAUTION**

A rack that is fully loaded with labware can be heavy. Grasp the rack handle firmly to prevent the rack from slipping or tilting.

To carry a rack, firmly grasp the rack by the handle as the following figure shows.

*Figure*  Carrying a front-load rack
## Related information

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filling and emptying the labware racks</td>
<td>“Filling and emptying the labware racks” on page 119</td>
</tr>
<tr>
<td>Mounting the labware racks onto the device and removing the racks from the device</td>
<td>“Installing and uninstalling the labware racks” on page 123</td>
</tr>
<tr>
<td>Labware definitions and the Labware Editor</td>
<td>VWorks Automation Control Setup Guide</td>
</tr>
</tbody>
</table>
Filling and emptying the labware racks

About this topic

The labware racks store the stacks of labware (microplates, tip boxes, and tube racks) that are processed during a protocol run. This topic describes how to fill the racks with fresh labware and how to remove the used labware from the racks.

Before you start

**WARNING**

To prevent potential injury, make sure you understand how to handle the racks safely.

See “Handling the labware racks” on page 117 for guidelines on how to handle the racks safely.

**CAUTION**

Before you place labware into a rack that is mounted on the BenchCel Microplate Handler, the clamps in the BenchCel stacker head must be closed (extended). If the clamps are open the stacker grippers will not prevent the stack of labware from dropping. To close the clamps, open BenchCel Diagnostics. On the Controls page, click Stacker at the top of the rack that you want to remove, and then choose Close Stacker Grippers.

Before filling or emptying a labware rack:

- Depending on the rack model, the procedure can vary:
  - *Standard or top-load racks*. Place the rack on a flat, level surface. Although it is possible to fill or empty a mounted rack, the top of a mounted rack can be difficult to access safely.
  - *Front-load racks*. The rack can be mounted on the BenchCel Microplate Handler or placed on a flat, level surface.

For details on how to mount the racks or remove the racks from the BenchCel Microplate Handler, see “Installing and uninstalling the labware racks” on page 123.

- Position the rack so that the opening is facing you.
- Determine how the microplates should be oriented in the rack.

For example, if the BenchCel orientation-sensing feature is enabled, make sure the A1 wells are oriented in the rack as specified.
Filling the standard and top-load racks

**WARNING**

To avoid potential injury, use care to avoid sliding your hand on the rack’s interior edges. The edges might have sharp surfaces.

The following figure shows how to slide a stack of labware into a standard rack.

*Figure*  Filling a standard rack: A) Sliding the stack down through the top, B) Supporting the stack through the bottom slot

To put labware into a standard or top-load rack:

1. Place the rack on a flat, level surface.
2. Using both hands, carefully slide a small stack of labware down through the top of the rack. You can use one hand to support underneath the labware stack, while the other hand holds the top of the labware to keep it level. See figure.
3. *Standard racks only.* When you reach the bottom of the open slot, transfer your hand positions so that you continue supporting the labware through the bottom slot.
4. Ensure that the bottom labware in the stack rests on the rack stacker grippers.

To remove labware from a standard or top-load rack:

1. If possible, remove the rack from the device, and place the rack on a flat, level surface.
If you are removing labware from a mounted rack, ensure that the stack is unloaded. To unload the stack, open BenchCel Diagnostics. On the Control page, click Stacker in the graphical display area, and then choose Unload Plates. Alternatively, you can click Unload All to unload all the stacks.

2 Carefully slide the labware in small stacks, up and out of the top of the rack.

Filling a front-load rack

The doors on the front-load rack provide easy access for placing labware into the front of a rack that is mounted on a device.

*Figure* Door mechanism on the front-load rack

To place labware into a front-load rack:

1 If the rack is mounted on the BenchCel device, verify that the stack is in the unloaded state.

   To unload the stack, open BenchCel Diagnostics. On the Control page, click Stacker, and then choose Unload Plates. Alternatively, you can click Unload All to unload all the stacks.

2 On each side of the rack, slide the Door-release (black) buttons forward, while pushing outward on the thumb tabs. The rack doors open.

*Figure* Opening the front-load rack
3 Place the labware directly through the open rack doors so that the bottom labware rests on the rack stacker grippers. Ensure the labware is level in the rack.

4 To close the doors, press the thumb tabs inward until the doors snap shut.

**To remove labware from a front-load rack:**

1 If the rack is mounted on the BenchCel device, verify that the stack is in the unloaded state.
   To unload the stack, open BenchCel Diagnostics. On the **Control** page, click **Stacker**, and then choose **Unload Plates**. Alternatively, you can click **Unload All** to unload all the stacks.

2 To open the rack doors, slide the black Door-release buttons forward on each side of the rack, while pressing outward on the thumb tabs.

3 Carefully, lift the labware out through the front of the rack.

### Related information

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mounting the rack on the BenchCel Microplate Handler or removing the rack from the device</td>
<td>“Installing and uninstalling the labware racks” on page 123</td>
</tr>
<tr>
<td>How to handle the racks safely</td>
<td>“Handling the labware racks” on page 117</td>
</tr>
<tr>
<td>Automation-ready labware</td>
<td>“Labware considerations” on page 27</td>
</tr>
</tbody>
</table>
| Changing labware parameters | • “Changing labware parameters” on page 154  
• *VWorks Automation Control Setup Guide* |
Installing and uninstalling the labware racks

About this topic
This topic explains how to install the labware racks on the BenchCel Microplate Handler and how to uninstall the racks.

Figure  BenchCel Microplate Handler (front) with two front-load labware racks

Before you start

IMPORTANT  Make sure the BenchCel power and compressed air are turned on before you install or uninstall a labware rack.

When lifting the labware rack onto and off of the stacker head, use both hands to grasp the rack securely around the four corners near the base.

WARNING  To prevent potential injury, avoid touching the interior edges of a rack when lifting the rack. The interior edges might have sharp surfaces.
The rack-release button at the top of the stacker head on the BenchCel device is sensitive to static electricity. Static electricity can cause a potential loss of motor control and loss of communication with the BenchCel device. Ensure that you discharge any potential static electricity before touching the rack-release button. To discharge static electricity, you can touch the white painted or metal surface of the BenchCel device before touching the rack-release button.

Installing labware racks on the BenchCel Microplate Handler

To install a labware rack:

1. At the BenchCel Microplate Handler, verify that the clamps are closed (extended) in the stacker head.

   Note: To close the clamps, open BenchCel Diagnostics. On the Controls page, click Stacker at the top of the rack that you want to remove, and then choose Close Stacker Grippers.

   When you install the rack, the prongs in the labware rack tabs will be inserted into the slots in the clamps. If the clamps are open, the slots will be hidden, and you cannot install the rack.
Preparing for a run
Installing and uninstalling the labware racks

Figure  Stacker head with closed (extended) clamps

2 With the rack’s open side facing the front, lower the rack onto the stacker head. Make sure the prongs at the bottom of the rack tabs insert into the slots in the extended clamps. The rack is automatically locked into position.

Figure  Installing a labware rack on the stacker head (closeup view without labware)

Uninstalling labware racks

Before you can remove a mounted rack, you must first unlock the rack. When you unlock the rack, two pins in the stacker head retract, as the following figure shows.
To uninstall a rack from the BenchCel Microplate Handler:

1. At the BenchCel Microplate Handler, verify that the stack is unloaded. To unload the stack, open BenchCel Diagnostics. On the Controls page in the graphical display area, click Stacker at the top of the rack that you want to remove, and then choose Unload Plates.

2. Unlock the rack by doing one of the following:
   - Press the green rack-release button at the top of the stacker head. The green status light flashes for 5 seconds to indicate that the rack is ready for removal. A click sounds as the locks retract. If the green light stops flashing, press the button again.
• In BenchCel Diagnostics, click the **Controls** tab. In the graphical display area, at the top of the rack that you want to unlock, click **Stacker**, and then choose **Unlock rack**. A click sounds as the locks retract.

3 Carefully lift the labware rack from the stacker head.

**Related information**

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turning on the power and air</td>
<td>“Starting up and shuttting down” on page 66</td>
</tr>
<tr>
<td>Automation-ready labware</td>
<td>“Labware considerations” on page 27</td>
</tr>
<tr>
<td>Labware definitions and the Labware Editor</td>
<td><em>VWorks Automation Control Setup Guide</em></td>
</tr>
<tr>
<td>How to handle the racks safely</td>
<td>“Handling the labware racks” on page 117</td>
</tr>
<tr>
<td>Placing labware into the labware racks and removing labware from the racks</td>
<td>“Filling and emptying the labware racks” on page 119</td>
</tr>
</tbody>
</table>
Performing pre-run checks

About this topic

Before you start a protocol run, you should check the BenchCel Microplate Handler to ensure optimum operation. Perform the following procedure before each protocol run.

Procedure

To check that the BenchCel and integrated devices are ready for a run:

1. Ensure the labware racks are filled with the correct labware.
2. Make sure there are no stray microplates in robot-accessible locations, including platepads or plate stages on integrated devices.
3. Remove any obstacle in the robot's pathways. Consider the path of the robot head and arms.
4. For the devices that require compressed air, make sure the air pressure meets the operating requirements.
   To check the BenchCel internal air pressure, see “Adjusting the stacker gripper pressure” on page 158.
5. Make sure all devices and accessories are set up correctly and prepared for the run. For instructions, see the user documentation for the device or accessory.

Related information

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>BenchCel air source requirements</td>
<td>“Verifying laboratory requirements” on page 37</td>
</tr>
<tr>
<td>Integrated device air source</td>
<td>External device user documentation</td>
</tr>
<tr>
<td>requirements</td>
<td></td>
</tr>
<tr>
<td>Diagnosing air pressure problems</td>
<td>“Maintenance and troubleshooting” on page 129</td>
</tr>
</tbody>
</table>
7 Maintenance and troubleshooting

This chapter describes how to maintain the BenchCel Microplate Handler and provides troubleshooting information.

This chapter contains the following topics:

- “Routine maintenance” on page 130
- “Cleaning up after a protocol run” on page 132
- “Replacing the fuse” on page 134
- “Hardware problems” on page 137
- “Software error messages” on page 139
- “Diagnostic tools” on page 146
- “Adjusting the stacker gripper pressure” on page 158
- “Reporting problems” on page 162
Routine maintenance

About this topic

This topic provides recommendations for maintaining the BenchCel Microplate Handler.

Cleaning up spills and periodic cleaning

In general, practice good housekeeping by cleaning up spills and routinely cleaning after using the BenchCel Microplate Handler.

Use a clean soft cloth or laboratory wipes to clean up spills on any part of the device immediately after a protocol run.

Clean the BenchCel device weekly or as needed. Use standard laboratory wipes and a mild detergent or isopropyl alcohol to clean the exterior painted white surfaces and the metal surfaces of dust, grime, chemical deposits, and other debris.

Also see “Cleaning up after a protocol run” on page 132.

Monthly inspection and maintenance

Every month, check the following:

- Robot gripper pins. Make sure they are not too dull to grip the microplates. If the pins have become dull, contact Agilent Technical Support to replace them.

Figure Robot head (side view)

Check the pins on each robot gripper.
• *Moving parts.* Ensure they are not rubbing against each other. Look for rub marks or noises that might indicate rubbing. If you see rub marks, contact Agilent Technical Support.

• *Air-supply tubing.* Verify that the tubing is in good shape and there are no leaks. Replace the broken tubing if necessary.

• *Stacker gripper pressure.* Make sure the pressure is set correctly. On the **Controls** page in BenchCel Diagnostics, click the **Jog/Teach** tab, and check the **Air** reading.

---

**Integrated device**

For routine maintenance of the devices integrated with the BenchCel device, see the user documentation for the corresponding device.
Cleaning up after a protocol run

About this topic
This topic describes the tasks you should perform when you have finished a protocol run.

Procedure

CAUTION
Make sure you clean up spilled liquids immediately. Do not use harsh abrasives, corrosive cleaning agents, or metal brushes to clean any BenchCel component or accessory.

To clean up after a run:
1. Follow the VWorks prompts for post-run software procedures, such as unloading the microplates. See the VWorks Automation Control User Guide for detailed instructions.
2. Unload used sample microplates from the labware racks. See “Filling and emptying the labware racks” on page 119.
3. Remove the labware racks from the BenchCel Microplate Handler. See “Installing and uninstalling the labware racks” on page 123.

IMPORTANT
Make sure the power and compressed air are turned on when removing the racks.

4. Remove manually placed microplates from platepads and external devices.
5. Use a clean soft cloth or laboratory wipes to clean up spills on any part of the BenchCel device immediately after a protocol run.
   If necessary, use standard laboratory wipes and a mild detergent or isopropyl alcohol to clean the exterior painted white surfaces and the metal surfaces of dust, grime, chemical deposits, and other debris.
6. Make sure the x-axis tracks are free of debris.

For information about... | See...
--- | ---
Cleanup procedure after every protocol run | “Cleaning up after a protocol run” on page 132
Air source requirements | “Compressed air requirements” on page 39
Checking and adjusting the stacker gripper pressure (internal air pressure) | “Adjusting the stacker gripper pressure” on page 158
7  Clean the integrated devices. See the device user documentation for cleanup instructions.

8  Check run logs for errors.

9  If you have administrator or technician privileges and you have modified the protocol, save the protocol.

10 Log out of the operating software. See the *VWorks Automation Control User Guide* for instructions.

### Related information

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>VWorks software run logs and protocols</td>
<td><em>VWorks Automation Control User Guide</em></td>
</tr>
<tr>
<td>Logging in and out of the VWorks software</td>
<td><em>VWorks Automation Control User Guide</em></td>
</tr>
<tr>
<td>Shutting down the BenchCel Microplate Handler</td>
<td>“Shutting down the BenchCel Microplate Handler” on page 67</td>
</tr>
</tbody>
</table>
Replacing the fuse

About this topic

If the main fuse is bad, the BenchCel Microplate Handler will not turn on. This topic describes how to replace the main fuse in the device.

Before you start

CAUTION
A blown fuse can indicate more serious problems. If the new fuse blows after replacement, contact Agilent Technical Support.

CAUTION
Using an incorrect fuse can damage the BenchCel Microplate Handler.

Use only the specified fuse type: 5 A, 250 V, 5 mm x 20 mm, fast acting. You can order fuses from Agilent Technologies. On the BenchCel control panel, verify the power rating (120 V or 230 V) for your region matches the display on the fuse enclosure.

Procedure

To replace the fuse in the power switch:

1. Shut down the BenchCel Microplate Handler, and unplug the power cable from the rear panel connector.

2. At the rear panel power switch enclosure, use a small flat-head screwdriver (2.5 mm) to pry open the tab on the fuse enclosure and open the enclosure cover.
3 At the top of the enclosure, insert the screwdriver head in the notch to dislodge the red fuse cartridge. Slide the fuse cartridge all the way out of the enclosure.

![Opened fuse enclosure](image)

4 Inspect the fuses on each side of the cartridge, and then replace the suspect fuse or fuses for the type of system you are using (120 V or 230 V power).

![Fuse cartridge](image)

**IMPORTANT**

Ensure the fuse is installed correctly in the cartridge. Otherwise, the device might not turn on.

5 Slide the fuse cartridge back into the fuse enclosure.
6 Ensure that the cartridge is pushed in all the way, and press the enclosure cover securely into the closed position.

7 Plug in the power cable at the rear panel connector, and then start up the BenchCel Microplate Handler.

Related information

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware components</td>
<td>“Hardware overview” on page 15</td>
</tr>
<tr>
<td>Safety</td>
<td>“Safety guidelines” on page 1</td>
</tr>
<tr>
<td>Starting up and shutting down the BenchCel Microplate Handler</td>
<td>“Starting up and shutting down” on page 66</td>
</tr>
<tr>
<td>How to report a problem</td>
<td>“Reporting problems” on page 162</td>
</tr>
</tbody>
</table>
## Hardware problems

### About this topic

This topic lists possible hardware problems, the causes of the problems, and ways to resolve the problems. If you are still experiencing problems with the BenchCel Microplate Handler after trying the solutions, contact Agilent Technical Support.

### Hardware problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The BenchCel Microplate Handler does not turn on.</td>
<td>Your lab does not meet the electrical requirements.</td>
<td>Make sure your lab meets the electrical requirements. See “Verifying laboratory requirements” on page 37.</td>
</tr>
<tr>
<td>The BenchCel Microplate Handler is not connected to the power source.</td>
<td></td>
<td>Connect the BenchCel Microplate Handler to the power source. See “Connecting the power source” on page 50.</td>
</tr>
<tr>
<td>The fuse is blown.</td>
<td></td>
<td>See “Replacing the fuse” on page 134. A bad fuse could be indicative of other problems. If the fuse blows again, contact Agilent Technical Support.</td>
</tr>
<tr>
<td>A hissing sound can be heard.</td>
<td>A leak is present in the air connection or inside the device.</td>
<td>Check the air connections at the back of the device and at the source (house, cylinder, or pump). If the connections look fine, the leak might be inside the device. Contact Agilent Technical Support.</td>
</tr>
<tr>
<td>Oil is present in the stacker head.</td>
<td>The compressed air is not from an oil-free compressor and oil has leaked into the BenchCel Microplate Handler.</td>
<td>Contact Agilent Technical Support.</td>
</tr>
<tr>
<td>The microplate drops from the robot grippers.</td>
<td>The labware definition for the microplate type might contain incorrect information.</td>
<td>Check the following in the labware definition: Stacker gripper offset, Robot gripper offset, Stacking thickness, Plate thickness, Sensor intensity, and the Plate presence threshold. To check or correct these values, open BenchCel Diagnostics. On the Controls page, click the Labware tab. Note: In the Plate offsets (mm) area, type 8 in the Robot gripper offset and the Stacker gripper offset boxes. The recommended offset for most labware is 8 mm. If the problem persists, contact Agilent Technical Support.</td>
</tr>
</tbody>
</table>
## Maintenance and troubleshooting

### Hardware problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The microplate drops or is held loosely by the stacker grippers.</td>
<td>The stacker gripper pressure is too low so that the grippers are holding the microplate too loosely.</td>
<td>Increase the stacker gripper pressure. See “Adjusting the stacker gripper pressure” on page 158.</td>
</tr>
<tr>
<td>The microplate bends when held by the stacker grippers.</td>
<td>The stacker gripper pressure is too high so that the grippers are holding the microplate too tightly.</td>
<td>Decrease the stacker gripper pressure. See “Adjusting the stacker gripper pressure” on page 158.</td>
</tr>
</tbody>
</table>
| The BenchCel Microplate Handler is unable to place a microplate on the target location correctly. | • The teachpoint is incorrect.  
• The robot and the platepad are not aligned along the y-axis (front-to-back direction), see “Integrating external devices” on page 38 to adjust the device positions.  
• The robot grippers and the robot arms are not properly aligned.  
• The robot homing offsets require adjustment. | Verify and edit the teachpoint. See Verifying the teachpoints and “Editing existing teachpoints” on page 97.  
If you suspect that one of the other factors is responsible for improper microplate placement, contact Agilent Technical Support. |
| A high-pitched sound can be heard when the robot moves up or down. | The z-axis lacks lubrication. | Contact Agilent Technical Support. |
| The rack-release button does not turn green and the labware rack cannot be removed. | The stack of microplates are still loaded. | In BenchCel Diagnostics, click the Controls tab. In the graphical display area at the top of the rack, click Stack, and then choose Unload plates. |
| More than one microplate was downstacked. | The Plate present reading is below the Plate presence threshold. | Use the procedure in “Setting sensor thresholds” on page 99 to adjust the threshold values. |
| The stack of microplates is dropped onto the shelf during the downstacking procedure. | In the shelf stack-holding method, the stacker gripper offset is too low. So the distance between the grippers and shelves is large. | Open BenchCel Diagnostics. On the Controls page, click the Labware tab. Increase the Stacker gripper offset. See “Changing labware parameters” on page 154. |

### Related information

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>BenchCel Microplate Handler component names</td>
<td>“Hardware overview” on page 15</td>
</tr>
<tr>
<td>Software error messages</td>
<td>“Software error messages” on page 139</td>
</tr>
</tbody>
</table>
Software error messages

**About this topic**

This topic lists possible software error messages, the causes of the errors, and ways to resolve the errors. If you are still experiencing problems with the BenchCel Microplate Handler after trying the solutions, contact Agilent Technical Support.

**Software error messages**

The following software error messages might appear during a protocol run or when you are using BenchCel Diagnostics. The messages are listed alphabetically.

<table>
<thead>
<tr>
<th>Error message</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
</table>
| Communication timed out     | Communication between the controlling computer and the BenchCel Microplate Handler or external device failed. | Try the following:  
  1. Verify that the device profile has the correct the COM port number (serial) or Ethernet ID.  
  2. Restart the VWorks software.  
  3. Restart the BenchCel Microplate Handler.  
  4. Check the Ethernet or serial cables.  
  5. (Ethernet only) Verify that the Ethernet switch has power.  
If the problem continues, contact Agilent Technical Support. |
## Maintenance and troubleshooting
### Software error messages

<table>
<thead>
<tr>
<th>Error message</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deadlock detected</td>
<td>The microplate is assigned to the wrong labware class.</td>
<td>Check that the labware belongs to the correct labware class in the Labware Editor. Most microplates should belong to the Uses Standard Plate Pad class. If you created a special class for a particular microplate, make sure it belongs to the special class. For more information about setting up labware classes, see the <em>VWorks Automation Control Setup Guide</em>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The protocol run is unable to continue. Some or all of the target locations are unavailable, so the microplates cannot be moved to those locations. Review the protocol and the run log. Run the simulator to determine the reason for the deadlock. In addition, check that the number of simultaneous microplates is not too high. See the <em>VWorks Automation Control User Guide</em>.</td>
</tr>
</tbody>
</table>
| The device was not found      | The BenchCel device is not connected to the controlling computer, or the incorrect profile is used. | **To connect the device:**  
1. Turn off the BenchCel Microplate Handler and exit the VWorks software.  
2. Ensure the BenchCel Microplate Handler is connected to the controlling computer. See “Connecting the computer” on page 57.  
3. Wait 10 seconds, and then turn on the BenchCel Microplate Handler.  
4. Wait for the BenchCel Microplate Handler to finish its homing routine, and then start the VWorks software.  
**To check the profile:**  
1. In BenchCel Diagnostics, click the Profiles tab.  
2. Check or select the correct profile. Verify that the profile uses the correct the COM port number (serial) or Ethernet ID. |
| Flash operation not successful | The robot could not write to its flash memory.                      | In the error message dialog box, click Retry. If clicking Retry does not resolve the problem, restart the BenchCel Microplate Handler. If the problem persists, contact Agilent Technical Support. |
| The gripper positions are too close | The Gripper open position parameter value is less than the Gripper holding plate position parameter value. | In the labware definition, make sure the Gripper open position value is 3 mm or greater than the Gripper holding plate position value. You can change the parameters in the Labware Editor or in BenchCel Diagnostics. |
## Error message | Cause | Solution
--- | --- | ---
No plate in grippers | The Orientation threshold was used to detect microplate presence, and the sensor readings from all four corners are below the threshold. Note: The software always uses the Orientation threshold as a secondary check, even if the Check Orientation option is not selected. | Reduce the Orientation threshold value. 

- The Robot gripper offset parameter value is incorrect. Correct the Robot gripper offset value in the Labware Editor or in BenchCel Diagnostics. An 8-mm offset works for most labware. 
- No microplate is available at the pickup location. Make sure you load or place labware at the target location. 
- The Orientation sensor offset parameter value is incorrect. Adjust the Orientation sensor offset value in BenchCel Diagnostics. See “Setting sensor thresholds” on page 99 for detailed instructions. 
- The sensor intensity and threshold require adjustment. See “Setting sensor thresholds” on page 99 for detailed instructions.

No plate in stack | The plate-presence sensor does not detect a microplate in the stack because of one or more of the following: 
- No microplate is in the stack. 
- Plate presence threshold is not set correctly. 
- The plate-presence sensor is not working properly. | Verify microplates are loaded in the correct stack. 
If the problem persists, contact Agilent Technical Support.

Operation timed out | The robot was unable to execute a command. | In the error message dialog box, click Retry. If clicking Retry does not resolve the problem, restart the BenchCel Microplate Handler. 
If the problem persists, contact Agilent Technical Support.

Plate in grippers | The robot senses a microplate in its grippers, but it does not expect to have the microplate for the specified command or action. | In BenchCel Diagnostics, use commands to move and place the microplate at an available teachpoint. Retry the intended command.
### 7  Maintenance and troubleshooting

#### Software error messages

<table>
<thead>
<tr>
<th>Error message</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plate is rotated</td>
<td>The microplate is loaded in the wrong orientation.</td>
<td>Check the microplate orientation (notch selections) in the Labware Editor or in BenchCel Diagnostics. Make sure you load the microplates in the rack accordingly.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Notch selection is incorrect in the labware definition.</td>
<td>Verify the notch selection in the Labware Editor or in BenchCel Diagnostics.</td>
<td></td>
</tr>
<tr>
<td>The Orientation sensor offset parameter value is incorrect.</td>
<td>Adjust the Orientation sensor offset value in BenchCel Diagnostics. See “Setting sensor thresholds” on page 99 for detailed instructions.</td>
<td></td>
</tr>
<tr>
<td>The sensor intensity and threshold require adjustment.</td>
<td>See “Setting sensor thresholds” on page 99 for detailed instructions.</td>
<td></td>
</tr>
<tr>
<td>Position error on grippers</td>
<td>The robot grippers failed to move to the commanded position. For example, something is blocking the robot.</td>
<td>In the error message dialog box, click Retry. If clicking Retry does not resolve the problem, home the robot and retry the intended command. If the problem persists, contact Agilent Technical Support.</td>
</tr>
<tr>
<td>Position error on the Theta axis</td>
<td>The robot failed to move to the commanded position. For example, something is blocking the robot.</td>
<td>In the error message dialog box, click Retry. If clicking Retry does not resolve the problem, home the robot and retry the intended command. If the problem persists, contact Agilent Technical Support.</td>
</tr>
<tr>
<td>Position error on x axis</td>
<td>The robot failed to move to the commanded position. For example, something is blocking the robot.</td>
<td>In the error message dialog box, click Retry. If clicking Retry does not resolve the problem, home the robot and retry the intended command. If the problem persists, contact Agilent Technical Support.</td>
</tr>
<tr>
<td>Position error on z axis</td>
<td>The robot failed to move to the commanded position. For example, something is blocking the robot.</td>
<td>In the error message dialog box, click Retry. If clicking Retry does not resolve the problem, home the robot and retry the intended command. If the problem persists, contact Agilent Technical Support.</td>
</tr>
<tr>
<td>Error message</td>
<td>Cause</td>
<td>Solution</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Rack not present</td>
<td>The labware rack is not installed on the BenchCel Microplate Handler.</td>
<td>Install the labware rack. See &quot;Installing and uninstalling the labware racks&quot; on page 123 for the procedure.</td>
</tr>
<tr>
<td></td>
<td>The rack-presence sensor is not able to detect the rack because one of the following:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The rack sensor threshold is too high.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The rack-presence sensor is not working.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>In the BenchCel Diagnostics, click the General Settings tab, and adjust the value in the Rack sensor threshold box.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If the problem persists, contact Agilent Technical Support.</td>
<td></td>
</tr>
<tr>
<td>Stack not loaded</td>
<td>The stacker may or may not contain microplates. However, the stacker grippers are open or the shelves are extended when they should not be.</td>
<td>Unload the microplates, if any, from the stacker. If a microplate is held by the stacker grippers, use BenchCel Diagnostics commands to open the stacker grippers to release the microplate.</td>
</tr>
<tr>
<td></td>
<td>In BenchCel Diagnostics, use commands to retract the shelves or open the stacker grippers. Reload the microplates and retry the intended commands.</td>
<td></td>
</tr>
<tr>
<td>Stacker shelf not extended</td>
<td>The BenchCel Microplate Handler expected the shelves to be extended but they are not.</td>
<td>In BenchCel Diagnostics, click the Controls tab. In the graphical display area, click Extend Shelf at the desired stacker.</td>
</tr>
<tr>
<td>Stacker shelf not retracted</td>
<td>The BenchCel Microplate Handler expected the shelves to be retracted but they are not.</td>
<td>In BenchCel Diagnostics, click the Controls tab. In the graphical display area, click Retract Shelf at the desired stacker.</td>
</tr>
<tr>
<td>Stacker shelf position error</td>
<td>The BenchCel Microplate Handler is trying to extend or retract the shelves but was unable to do so.</td>
<td>Check for obstacles in the stacker head that might be blocking the shelves.</td>
</tr>
<tr>
<td></td>
<td>In BenchCel Diagnostics, click the Controls tab. In the graphical display area, click Extend Shelf or Retract Shelf at the desired stack.</td>
<td></td>
</tr>
<tr>
<td>Thermal cutoff active for theta-axis</td>
<td>The theta motor is overheated.</td>
<td>Shut down the BenchCel Microplate Handler and wait for the robot head to cool down before retrying the intended protocol run or commands.</td>
</tr>
<tr>
<td></td>
<td><strong>WARNING</strong> To avoid a potential burn, do not touch the robot head.</td>
<td></td>
</tr>
<tr>
<td>Theta position out of bounds</td>
<td>The robot is commanded to move out of its range on the theta-axis.</td>
<td>Check the teachpoint theta-axis value to make sure it is not beyond the factory-set limits.</td>
</tr>
<tr>
<td></td>
<td>If the problem persists, contact Agilent Technical Support.</td>
<td></td>
</tr>
</tbody>
</table>
## Software error messages

<table>
<thead>
<tr>
<th>Error message</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timeout on grippers</td>
<td>The motor’s controller did not respond as expected.</td>
<td>Home the robot, and then move the robot in the same axis. If the robot moves, continue on. If the robot does not move, quit the VWorks software and restart the BenchCel Microplate Handler. If the problem persists, contact Agilent Technical Support.</td>
</tr>
<tr>
<td>Timeout on theta-axis</td>
<td>The motor’s controller did not respond as expected.</td>
<td>Home the robot, and then move the robot in the same axis. If the robot moves, continue on. If the robot does not move, quit the operating software and restart the BenchCel Microplate Handler. If the problem persists, contact Agilent Technical Support.</td>
</tr>
<tr>
<td>Timeout on x-axis</td>
<td>The motor’s controller did not respond as expected.</td>
<td>Home the robot, and then move the robot in the same axis. If the robot moves, continue on. If the robot does not move, quit the operating software and restart the BenchCel Microplate Handler. If the problem persists, contact Agilent Technical Support.</td>
</tr>
<tr>
<td>Timeout on z-axis</td>
<td>The motor’s controller did not respond as expected.</td>
<td>Home the robot, and then move the robot in the same axis. If the robot moves, continue on. If the robot does not move, quit the operating software and restart the BenchCel Microplate Handler. If the problem persists, contact Agilent Technical Support.</td>
</tr>
</tbody>
</table>
### Maintenance and troubleshooting

#### Software error messages

<table>
<thead>
<tr>
<th>Error message</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wrong plate type</td>
<td>The microplate in the stack is different from the labware selected in the software.</td>
<td>Check the labware selected in the Labware Editor or in the BenchCel Diagnostics Controls tab.</td>
</tr>
<tr>
<td></td>
<td>The microplate is loaded in the wrong orientation.</td>
<td>Check the microplate orientation (notch selections) in the labware definition and make sure you load the microplates in the rack accordingly.</td>
</tr>
<tr>
<td></td>
<td>The plate-orientation sensors are not able to detect the microplate notches correctly because of one of the following:</td>
<td>See “Setting sensor thresholds” on page 99.</td>
</tr>
<tr>
<td></td>
<td>• The microplate is not in the correct position to be detected by the sensors.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The sensor intensity and threshold settings need adjustments.</td>
<td></td>
</tr>
<tr>
<td>X position out of bounds</td>
<td>The robot is commanded to move out of its range in the x-axis.</td>
<td>Check the teachpoint x-axis value to make sure it is not beyond the factory-set limits.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the problem persists, contact Agilent Technical Support.</td>
</tr>
<tr>
<td>Z position out of bounds</td>
<td>The robot is commanded to move out of its range in the y-axis.</td>
<td>Check the teachpoint z-axis value to make sure it is not beyond the factory-set limits.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the problem persists, contact Agilent Technical Support.</td>
</tr>
</tbody>
</table>

#### Related information

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>BenchCel Microplate Handler</td>
<td>“Hardware overview” on page 15</td>
</tr>
<tr>
<td>component names</td>
<td></td>
</tr>
<tr>
<td>Opening BenchCel Diagnostics</td>
<td>“Opening BenchCel Diagnostics” on page 73</td>
</tr>
<tr>
<td>Hardware problems</td>
<td>“Hardware problems” on page 137</td>
</tr>
<tr>
<td>Checking and adjusting the</td>
<td>“Adjusting the stacker gripper pressure” on page 158</td>
</tr>
<tr>
<td>stacker gripper pressure</td>
<td></td>
</tr>
<tr>
<td>(internal air pressure)</td>
<td></td>
</tr>
<tr>
<td>Reporting problems to Agilent</td>
<td>“Reporting problems” on page 162</td>
</tr>
<tr>
<td>Technologies</td>
<td></td>
</tr>
</tbody>
</table>
Diagnostic tools

About this topic

The BenchCel Diagnostics software has three tabbed pages: Controls, General Settings, and Profile. You use the commands and parameters available in the Controls and General Settings tabs when troubleshooting problems.

This topic explains how to use the commands and parameters in the Controls and General Settings tabs to do the following:

- “Sending the robot to the home position” on page 146
- “Homing the robot” on page 146
- “Disabling and enabling the robot motors” on page 147
- “Jogging the robot” on page 148
- “Changing the robot speed” on page 149
- “Moving plates between teachpoints” on page 151
- “Opening and closing clamps” on page 152
- “Extending and retracting shelves” on page 153
- “Changing labware parameters” on page 154
- “Changing the general settings” on page 156

See “Quick reference” on page 165 for the complete list of available commands.

Sending the robot to the home position

The home position is where the robot head is at the center of the BenchCel Microplate Handler and the robot arms are perpendicular to the x-axis. You send the robot to the home position if you want the robot out of the way in a safe position.

To send the robot to the home position:

1. On the BenchCel Diagnostics Controls page, click the Jog/Teach tab.
2. Click Go Home.

Homing the robot

Homing the robot sends the robot to the factory-defined home position for each axis of motion. The homing process recalibrates the robot position along each axis. Home the robot if you notice that the robot is not accurately picking up or placing plates. You might also want to home the robot after recovering from an emergency stop.
Note: If a labware definition is selected when you click Home motors, the robot grippers return to the Gripper open position defined for the selected labware.

To home the robot:
1. On the BenchCel Diagnostics Controls page, click the Jog/Teach tab.
2. Click Home motors.

Disabling and enabling the robot motors

Disabling the robot motors allows you to move the robot by hand, making it easier to set and edit teachpoints.

To disable or enable the robot motors:
1. On the BenchCel Diagnostics Controls page, click the Jog/Teach tab.
2. In the Motors Enabled area, select or click the following:

<table>
<thead>
<tr>
<th>Option or command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>Select the option to enable the x-axis motor. Clear the check box to disable the x-axis motor.</td>
</tr>
<tr>
<td>Z</td>
<td>Select the option to enable the z-axis motor. Clear the check box to disable the z-axis motor.</td>
</tr>
<tr>
<td>Theta</td>
<td>Select the option to enable the theta-axis motor. Clear the check box to disable the theta-axis motor.</td>
</tr>
<tr>
<td>Enable All</td>
<td>Click to turn on all the motors.</td>
</tr>
<tr>
<td>Disable All</td>
<td>Click to turn off all the motors.</td>
</tr>
</tbody>
</table>
### Jogging the robot

Jogging the robot moves the robot and robot grippers in small, precise increments along one of the axes. You can jog the robot to fine-tune its position when creating and editing teachpoints.

**To jog the robot:**

1. On the **BenchCel Diagnostics Controls** page, click the **Jog/Teach** tab.
2. Enable the robot motors. See "Disabling and enabling the robot motors" on page 147.
3. In the robot movement area, select the jog distance from the corresponding increment list, if applicable.

### Use smaller jog increments than you think you need to ensure that the robot does not bump into obstacles in its path (such as the stacker heads and plate stages).

4. Click the directional button:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="left.png" alt="left" /></td>
<td>Jogs the robot arm counterclockwise from the current position by the specified theta-axis increment.</td>
</tr>
<tr>
<td><img src="right.png" alt="right" /></td>
<td>Jogs the robot arm clockwise from the current position by the specified theta-axis increment.</td>
</tr>
<tr>
<td><img src="up.png" alt="up" /></td>
<td>Jogs the robot head up from the current position by the specified z-axis increment.</td>
</tr>
<tr>
<td><img src="down.png" alt="down" /></td>
<td>Jogs the robot head down from the current position by the specified z-axis increment.</td>
</tr>
<tr>
<td><img src="left.png" alt="left" /></td>
<td>Jogs the robot head left from the current position by the specified x-axis increment.</td>
</tr>
<tr>
<td><img src="right.png" alt="right" /></td>
<td>Jogs the robot head right from the current position by the specified x-axis increment.</td>
</tr>
<tr>
<td><img src="open.png" alt="open" /></td>
<td>Opens the robot grippers by the specified grip increment.</td>
</tr>
<tr>
<td><img src="close.png" alt="close" /></td>
<td>Closes the robot grippers by the specified grip increment.</td>
</tr>
<tr>
<td><strong>Full Open</strong></td>
<td>Opens the robot grippers to the Robot Gripper Open Position value set in the Labware tab.</td>
</tr>
<tr>
<td><strong>Full Close</strong></td>
<td>Closes the robot grippers to the Robot Gripper Holding Stack value set in the Labware tab.</td>
</tr>
</tbody>
</table>
Changing the robot speed

The speed you select in BenchCel Diagnostics applies only to the robot commands in BenchCel Diagnostics (Jog, Move, Transfer, and so on). If the robot is holding a microplate, the slower of the following will be applied: the speed you selected in the Labware Editor or the speed you selected in BenchCel Diagnostics.

You can select the robot speed to accommodate the task you are performing. For example, you can select the Slow speed when you are creating new teachpoints, creating and testing protocols, or diagnosing problems with the system.

You can adjust the speed setting for the x-axis, z-axis, and theta-axis for each speed (high, medium, or slow) as a percentage of the factory-set maximum speed.

To select the robot speed:

1. In BenchCel Diagnostics, click the Controls tab.
2. In the Speed list, select Fast, Medium, or Slow.

Note: During a protocol run, the robot uses the speed selection in the VWorks Tools > Options dialog box. If the robot is holding a microplate, the slower of the following will be applied: the speed in the Labware Editor or the speed in the Tools > Options dialog box. For more information, see the VWorks Automation Control User Guide.
To set the Slow, Medium, and Fast speeds as a percentage of the factory-set maximum speed:

1. On the **General Settings** tab, click **Speed settings**.

2. In the **Speed Settings** dialog box, type the percentage of the factory-set maximum speed for the axis speed setting.

   ![Speed Settings dialog box](image)

   - **Note:** The factory speed settings for all three axes are Slow 20%, Medium 40%, Fast 80%.
   - **Note:** The speed settings apply to the speeds you select in BenchCel Diagnostics, Labware Editor, and the VWorks Options dialog box.

3. Click **OK** to save the changes.
Moving plates between teachpoints

You can move a microplate between teachpoints when you are verifying a teachpoint or to determine whether to home the motors.

**CAUTION**
To prevent collision, remove obstacles in the path of the robot.

To move plates between teachpoints:
1. Manually place a microplate at one of the two teachpoints.
2. In BenchCel Diagnostics, click the Controls tab, and then select the Slow speed.
3. In the graphical display area, click the plus sign (⁺) at either of the following:
   - The teachpoint you want to move to
   - Two teachpoints between which you want to move a plate

The selected teachpoints should be highlighted in red circles (⁺).
4. Rest the pointer on a selected teachpoint. In the command menu that appears, select one of the following:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to &lt;teachpoint&gt;</td>
<td>Moves the robot from its current position to the selected teachpoint. The robot stays at the teachpoint.</td>
</tr>
<tr>
<td>Pick from &lt;teachpoint&gt;</td>
<td>Picks up the microplate from the selected teachpoint and moves the plate to the ready-for-upstack position under the stacker head.</td>
</tr>
<tr>
<td>Place at &lt;teachpoint&gt;</td>
<td>Moves the robot from its current position and places the microplate at the selected teachpoint. After placing the microplate, the robot backs away from the teachpoint into the safe zone.</td>
</tr>
</tbody>
</table>
## Opening and closing clamps

The clamps in the stacker head close and open the grippers at the bottom of the labware rack to hold and release the first plate in position for the robot grippers. Compressed air is used to move the clamps.

The clamps close and open the stacker grippers automatically during the loading, unloading, downstacking, and stacking procedures. When diagnosing problems or after an aborted run, you can use the commands in BenchCel Diagnostics to open or close the clamps (stacker grippers). For example, you might want to open the clamps (stacker grippers) to remove a microplate.

**CAUTION**

Opening the clamps (stacker grippers) might cause the microplate or stack of microplates to drop.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transfer to &lt;teachpoint&gt;</td>
<td>Moves a microplate from the currently selected teachpoint to the other selected teachpoint.</td>
</tr>
<tr>
<td></td>
<td>To transfer a microplate from a stack, you must first click <strong>Load Stacker</strong>. During the transfer, the robot downloads the plate, places it at the other selected teachpoint, and then backs into the safe zone.</td>
</tr>
<tr>
<td></td>
<td>If the robot is transferring a plate from one teachpoint to another, the robot picks up the microplate from the currently selected teachpoint, places the microplate at the other selected teachpoint, and then backs into the safe zone.</td>
</tr>
<tr>
<td>Delid from &lt;teachpoint&gt;</td>
<td><strong>Lidded labware only.</strong> Removes the lid from the labware that is at the selected teachpoint.</td>
</tr>
<tr>
<td>Relid to &lt;teachpoint&gt;</td>
<td><strong>Lidded labware only.</strong> Replaces the lid on the labware that is at the selected teachpoint.</td>
</tr>
</tbody>
</table>
To open or close the clamps (stacker grippers):

1. In BenchCel Diagnostics, click the Controls tab.
2. In the graphical display area at the top of the rack, click Stacker, and then choose Open stacker grippers or Close stacker grippers. A click sounds as the clamps (stacker grippers) open or close.

Extending and retracting shelves

The shelves in the stacker head are used to hold the stack of labware temporarily during the downstacking and upstacking processes. Resting the microplates on the shelves levels the microplates, allowing the robot grippers to accurately hold the microplate at the specified offset position. Compressed air is used to move the shelves.

The shelves extend and retract automatically during the downstacking and upstacking processes. When diagnosing problems or after an aborted run, you can use the commands in BenchCel Diagnostics to extend or retract the shelves.

**CAUTION**

Retracting the shelves might cause the microplate or stack of microplates to drop.
To extend or retract the shelves:
1. In BenchCel Diagnostics, click the Controls tab.
2. In the graphical display area at the top of the desired stacker:
   • Click Stacker > Extend Shelves to extend the shelves.
   • Click Stacker > Retract Shelves to retract the shelves.
A click sounds as the shelves extend or retract.

Changing labware parameters

When testing new or troubleshooting existing labware definitions, you can use BenchCel Diagnostics to make changes to some of the labware parameters without opening the Labware Editor. For example, you can change the stacking thickness, gripper offsets, notch specification, and lid specifications.

Note: Changes you make to the labware parameters in BenchCel Diagnostics are also updated in the Labware Editor.

Before you start
Calculate the values for the labware sensor thresholds. See the procedure in “Setting sensor thresholds” on page 99.
Procedure

To change the labware parameters:

1. On the Controls page, select the labware definition from the Labware list.
2. Click the Labware tab and make your changes to the labware parameters.
   - Plate Dimensions. See “BenchCel Diagnostics - Labware tab” on page 173.
   - Sensors. See “Setting sensor thresholds” on page 99.
   - Plate Offsets. See “BenchCel Diagnostics - Labware tab” on page 173.
   - Robot Gripper Positions. See “BenchCel Diagnostics - Labware tab” on page 173.
3. If you want to check for notches, under Notch Locations, select Check Orientation, and then select one or more of the microplate corners to indicate the notch location.
4. If you plan to process lidded microplates:
   a. Under Lidded Plate Parameters (mm), select the Can have lid? check box.
   b. Under the graphical display area on the Controls page, select the Plates have lids check box.
   c. In the Lidded Plate Parameters (mm) area, type the following values after you verify the measurements. For details on measuring these parameters, see “BenchCel Diagnostics - Labware tab” on page 173.
      - Lidded thickness
      - Lidded stacking thickness
      - Lid gripper offset
      - Lid resting height
      - Lid departure height
      - Gripper holding lid position
5. To make changes to other labware parameters, click Editor. You can make changes in the Labware Editor.
   See the VWorks Automation Control Setup Guide for instructions on using the Labware Editor.
6. Click Apply/Save Labware.
   VWorks Plus only. If an audit trail is being logged, the Audit Comment dialog box opens. Select or type the audit comment, and then click OK.
Changing the general settings

Be careful when changing the general settings. Changes in this tab will affect existing protocols.

The changes are stored in the BenchCel flash memory. The changes you make to the general settings will take affect any time you are using this BenchCel device regardless of profile, protocol file, or device file.

To change general settings:

1. In BenchCel Diagnostics, click the General Settings tab.
2. In the Stack Settings area, type a new value for the parameter you want to change.

3. Select Home robot after protocol run finishes if you want the robot to return to its home position after the protocol run is finished.

Home robot after protocol run finishes applies to all BenchCel devices that are controlled by the same computer running the VWorks software.

4. Optional. To change the speed, click Speed Settings. See "Changing the robot speed" on page 149 for instructions.
5. Click OK to apply and save the new setting values.
6  *VWorks Plus only.* If an audit trail is being logged, the Audit Comment dialog box opens. Select or type the audit comment, and then click **OK.**

**Related information**

<table>
<thead>
<tr>
<th>For more information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to open BenchCel Diagnostics</td>
<td>“Opening BenchCel Diagnostics” on page 73</td>
</tr>
<tr>
<td>How to report a problem</td>
<td>“Reporting problems” on page 162</td>
</tr>
<tr>
<td>Defining labware</td>
<td><em>VWorks Automation Control Setup Guide</em></td>
</tr>
<tr>
<td>Teachpoints</td>
<td>“Setting and managing teachpoints” on page 84</td>
</tr>
<tr>
<td>Installing and removing labware racks</td>
<td>“Installing and uninstalling the labware racks” on page 123</td>
</tr>
</tbody>
</table>
Adjusting the stacker gripper pressure

About this topic

This topic explains how to check the stacker gripper pressure (internal air pressure) and how to adjust it.

Stacker gripper pressure

Compressed air is used to move the clamps that open and close the labware rack grippers and the shelves that level the microplates. See “Hardware overview” on page 15 for the location of these components.

Although the required air pressure from your lab is 0.65 to 0.69 MPa (95 to 100 psi), the BenchCel Microplate Handler down-regulates the pressure inside the device.

Typically, no adjustment is required for the internal air pressure. You might want to adjust the pressure when troubleshooting Load Plate problems or when you want to load different labware on the same BenchCel Microplate Handler.

In general, you can set the internal air pressure within the range of 30 to 50 psi. For plates that are flexible and tend to bend, you should decrease the air pressure. For less flexible plates, you can increase the air pressure.

For each plate type or application, you should run optimization tests to determine the best internal pressure setting.

Note: Each stacker has an air pressure sensor, but the air pressure for each pair of stackers is controlled by one regulator.

Before you start

Make sure you turned on the air supply at the source (house, cylinder, or pump).

Checking the internal air pressure

To check the internal air pressure:

1. In BenchCel Diagnostics, click the Controls tab.
2. Click the Jog/Teach tab.
3. In the Stacker Sensors area, check the air pressure value.
Adjusting the internal air pressure

To adjust the internal air pressure:

1. At the front of the BenchCel Microplate Handler, lift the magnetic circular cover to gain access to the air-pressure regulator.

   Figure  Accessing the BenchCel air-pressure regulator

   ![Lift cover to access the air pressure regulator.]

2. Turn the lock nut counterclockwise to unlock the air pressure regulator knob.

   Figure  Unlocking the air-pressure regulator

   ![Turn counterclockwise to unlock.]

3. Turn the air pressure regulator knob. Turning the knob clockwise increases the internal air pressure. Turning the knob counterclockwise decreases the internal air pressure.
4 On the Jog/Teach tab, check the air pressure value. A valid air pressure value displays only when the stacker grippers are closed.

5 At the front of the BenchCel Microplate Handler, turn the lock nut clockwise to lock the air-pressure regulator knob. This prevents accidental adjustments.

6 At the front of the BenchCel Microplate Handler, place the magnetic cover over the air-pressure regulator opening.
## Related information

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Air pressure requirements</td>
<td>“Compressed air requirements” on page 39</td>
</tr>
<tr>
<td>How to open BenchCel Diagnostics</td>
<td>“Opening BenchCel Diagnostics” on page 73</td>
</tr>
<tr>
<td>How to report a problem</td>
<td>“Reporting problems” on page 162</td>
</tr>
<tr>
<td>Hardware problems</td>
<td>“Hardware problems” on page 137</td>
</tr>
<tr>
<td>Software error messages</td>
<td>“Software error messages” on page 139</td>
</tr>
</tbody>
</table>
Reporting problems

About this topic

If you have a technical problem that you cannot resolve after reading the maintenance and troubleshooting instructions, read the information in this topic for how to report hardware, software, and user guide problems.

Contacting technical support

If you find a problem with the BenchCel Microplate Handler, contact Agilent Technical Support. For contact information, go to https://www.agilent.com/en-us/contact-us/page.

Note: You can also send a software bug report from within the VWorks software.

Reporting hardware problems

When contacting Agilent, make sure you have the serial number of the device or workstation ready. You can locate the serial number on the front and back of the BenchCel device.
Reporting software problems

When you contact Agilent Technical Support, make sure you provide the following:

- Short description of the problem
- Software version number
- Error message text (or screen capture of the error message dialog box)
- Screen capture of the About VWorks software dialog box
- Relevant software files

*To find the VWorks software version number:*  
In the VWorks software, select **Help > About VWorks**.

*To find the Diagnostics software version number:*  
1. Open BenchCel Diagnostics.  
2. Read the version number on the title bar of the diagnostics window.
To send compressed protocol and associated files in VZP format:
In the VWorks software, select **File > Export VZP File** to export and compress the following files:

- Protocol file
- Device file (includes the device profile and teachpoint file)
- Labware definitions
- Liquid classes
- Pipette techniques
- Hit-picking files
- Plate map files
- Barcode files
- Error library
- Log files
- Form file (*.VWForm)

**Reporting user guide problems**

If you find a problem with this user guide or have suggestions for improvement, send your comments using one of the following methods:

- Click the feedback button (✉️) in the online help.
- Send an email to documentation.automation@agilent.com.

**Related information**

<table>
<thead>
<tr>
<th>For more information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolving hardware problems</td>
<td>“Hardware problems” on page 137</td>
</tr>
<tr>
<td>Resolving software errors</td>
<td>“Software error messages” on page 139</td>
</tr>
<tr>
<td>Safety information</td>
<td>“Safety guidelines” on page 1</td>
</tr>
<tr>
<td>Hardware description</td>
<td>“Hardware overview” on page 15</td>
</tr>
</tbody>
</table>
A Quick reference

This appendix provides a quick reference of the following:

- “Rack-release button indicator light” on page 166
- “BenchCel Diagnostics - Controls tab” on page 167
- “BenchCel Diagnostics - Jog/Teach tab” on page 170
- “BenchCel Diagnostics - Labware tab” on page 173
- “BenchCel Diagnostics - General Settings tab” on page 178
- “BenchCel Diagnostics - Profiles tab” on page 179
- “Teachpoint Details dialog box” on page 182
The rack-release button at the top of each stacker head displays different colors to indicate the status of the adjacent labware rack. The following table lists the possible colors and the corresponding status description.

<table>
<thead>
<tr>
<th>Color of indicator light</th>
<th>Meaning</th>
</tr>
</thead>
</table>
| Green                    | The labware rack is installed correctly on the BenchCel Microplate Handler and the stack of microplates are unloaded.  
  • The stack of microplates are ready for processing.  
  • You can unlock and remove the labware rack. |
| Green, flashing          | The labware rack is unlocked and can be removed. |
| Blue                     | A microplate is loaded and the labware rack cannot be removed. |
| Red                      | The clamps are open without a rack installed. Do not install a rack until the clamps are closed. |
BenchCel Diagnostics - Controls tab

The Controls tab contains the following areas:
- “Graphical display area” on page 167
- “BenchCel Diagnostics - Jog/Teach tab” on page 170
- “BenchCel Diagnostics - Labware tab” on page 173

Graphical display area

<table>
<thead>
<tr>
<th>Item</th>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Rack lock/unlock</td>
<td>Blue indicates the stack is loaded and the rack is locked. Green indicates the stack is unloaded, and you can press the rack-release button to unlock and uninstall the labware rack.</td>
</tr>
<tr>
<td>2</td>
<td>Labware present</td>
<td>A green bar indicates that the stacker head plate-preservation sensor detects labware in the rack. No bar appears if the sensors do not detect labware in the rack.</td>
</tr>
<tr>
<td>3</td>
<td>Rack present</td>
<td>A rack image indicates that the stacker head rack-presence sensor detects a rack. An empty stacker image indicates that the rack sensor does not detect a rack.</td>
</tr>
<tr>
<td>4</td>
<td>Teachpoint at device</td>
<td>Indicates a teachpoint location on an integrated device. Clicking the opens the teachpoint menu.</td>
</tr>
<tr>
<td>5</td>
<td>Teachpoint at stacker</td>
<td>Indicates the teachpoint for the stacker head. Clicking the opens the teachpoint menu.</td>
</tr>
</tbody>
</table>
### Table: Control tab controls and commands

<table>
<thead>
<tr>
<th>Control or command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Labware</td>
<td>Specifies the selected labware.</td>
</tr>
<tr>
<td>Editor</td>
<td>Starts the Labware Editor.</td>
</tr>
<tr>
<td>Plates have lids</td>
<td>Indicates that the labware you selected for processing have lids.</td>
</tr>
<tr>
<td>Speed</td>
<td>Specifies the relative speed at which the robot head and arms moves: Fast, Medium, and Slow. “Changing the robot speed” on page 149. This speed control applies only in BenchCel Diagnostics.</td>
</tr>
<tr>
<td>Load All</td>
<td>Places all the stacks of labware on the shelves in preparation for a protocol run. After a stack of labware is loaded, you cannot remove the labware rack.</td>
</tr>
<tr>
<td>Unload All</td>
<td>Places all the stacks of labware on the stacker grippers so that you can remove the labware racks.</td>
</tr>
<tr>
<td>Stacker n - Load plates</td>
<td>Moves a microplate on the shelves at the specified stacker in preparation for a downstack process or protocol run.</td>
</tr>
<tr>
<td>Stacker n - Unload plates</td>
<td>Moves the microplate back on the stacker grippers so that you can remove the labware racks.</td>
</tr>
<tr>
<td>Stacker n - Unlock rack</td>
<td>Retracts the locking pin to allow you to remove the labware rack.</td>
</tr>
<tr>
<td>Stacker n - Open stacker gripper</td>
<td>Opens the clamps that open the stacker grippers in the labware rack.</td>
</tr>
<tr>
<td>Stacker n - Close stacker gripper</td>
<td>Closes the clamps that close the stacker grippers in the labware rack.</td>
</tr>
<tr>
<td>Stacker n - Extend shelf</td>
<td>Extends the shelf at the specified stack.</td>
</tr>
<tr>
<td>Stacker n - Retract shelf</td>
<td>Retracts the shelf at the specified stack.</td>
</tr>
<tr>
<td>Move to Stacker n</td>
<td>Moves the robot into position to grip a microplate in the stack.</td>
</tr>
<tr>
<td>Downstack from Stacker n</td>
<td>Moves the first microplate from the specified labware rack in preparation for a protocol run.</td>
</tr>
<tr>
<td>Upstack to Stacker n</td>
<td>Moves the microplate into the specified labware rack.</td>
</tr>
<tr>
<td>Edit</td>
<td>Opens the Teachpoint Details dialog box. See “Teachpoint Details dialog box” on page 182.</td>
</tr>
<tr>
<td>Move to sensor</td>
<td>Moves the microplate to the sensor offset position.</td>
</tr>
<tr>
<td>Move to &lt;teachpoint&gt;</td>
<td>Moves the robot from its current position to the selected teachpoint.</td>
</tr>
<tr>
<td>Control or command</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Pick from &lt;teachpoint&gt;</td>
<td>Picks up the plate from the selected teachpoint, and then the robot backs away from the teachpoint into the safe zone.</td>
</tr>
<tr>
<td>Place at &lt;teachpoint&gt;</td>
<td>Moves the robot from its current position and places the plate at the selected teachpoint. After placing the plate, the robot backs away from the teachpoint into the safe zone.</td>
</tr>
</tbody>
</table>
| Transfer to <teachpoint> | Moves a plate from the currently selected teachpoint to the other selected teachpoint.  
To transfer a plate from a stack, you must first click Load Stacker. During the transfer, the robot downstacks the plate, places it at the other selected teachpoint, and then backs into the safe zone.  
If the robot is transferring a plate from one teachpoint to another, the robot picks up the plate from the currently selected teachpoint, places the plate at the other selected teachpoint, and then backs into the safe zone. |
| Delid from <teachpoint> | Lidded labware only. Removes the lid from the labware that is at the selected teachpoint.                                               |
| Relid to <teachpoint> | Lidded labware only. Replaces the lid on the labware that is at the selected teachpoint.                                                      |
BenchCel Diagnostics - Jog/Teach tab

You use the Jog/Teach tab for the following procedures:

- "Setting and managing teachpoints" on page 84
- "Setting sensor thresholds" on page 99
- "Sending the robot to the home position" on page 146
- "Homing the robot" on page 146
- "Disabling and enabling the robot motors" on page 147
- "Jogging the robot" on page 148

Stacker Sensors area

<table>
<thead>
<tr>
<th>Setting, status, or command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stacker list</td>
<td>The stacker identifier, numbered from left to right. For example, to select the left-most stacker, select 1.</td>
</tr>
<tr>
<td>Plate presence</td>
<td>The plate-presence sensor reading.</td>
</tr>
<tr>
<td>Air (psi)</td>
<td>The internal air pressure measurement, in psi.</td>
</tr>
<tr>
<td>Notch Sensors</td>
<td>The plate-orientation sensor reading for the specified corner of the microplate.</td>
</tr>
<tr>
<td>A1</td>
<td>The plate-orientation sensor reading for the A1 corner of the microplate.</td>
</tr>
<tr>
<td>Top-right</td>
<td>The plate-orientation sensor reading for the top-right corner of the microplate.</td>
</tr>
<tr>
<td>Bottom-left</td>
<td>The plate-orientation sensor reading for the bottom-left corner of the microplate.</td>
</tr>
<tr>
<td>Bottom-right</td>
<td>The plate-orientation sensor reading for the bottom-right corner of the microplate.</td>
</tr>
<tr>
<td>Orientation threshold</td>
<td>The value that determines the presence of a microplate notch. A notch is present if the value is below this value. If the sensor value is above this threshold, no notch is reported. The default value is 100.</td>
</tr>
</tbody>
</table>

Note: The setting is also available in the Labware tab.
### Plate presence threshold

The value that determines if a microplate is detected. Any value equal to or greater than the threshold means a microplate is present. A lesser value means there is no microplate.

*Note:* The setting is also available in the Labware tab.

### Apply & save

The command that saves the updated settings in the Jog/Teach tab.

### Robot movement area

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CCW</strong></td>
<td>Jogs the robot arm counterclockwise from the current position by the specified ( \theta )-axis increment.</td>
</tr>
<tr>
<td><strong>CW</strong></td>
<td>Jogs the robot arm clockwise from the current position by the specified ( \theta )-axis increment.</td>
</tr>
<tr>
<td><strong>Left</strong></td>
<td>Jogs the robot head left from the current position by the specified ( x )-axis increment.</td>
</tr>
<tr>
<td><strong>Up</strong></td>
<td>Jogs the robot head up from the current position by the specified ( z )-axis increment.</td>
</tr>
<tr>
<td><strong>Right</strong></td>
<td>Jogs the robot head right from the current position by the specified ( x )-axis increment.</td>
</tr>
<tr>
<td><strong>Down</strong></td>
<td>Jogs the robot head down from the current position by the specified ( z )-axis increment.</td>
</tr>
<tr>
<td><strong>Open</strong></td>
<td>Opens the robot grippers by the specified grip increment.</td>
</tr>
<tr>
<td><strong>Close</strong></td>
<td>Closes the robot grippers by the specified grip increment.</td>
</tr>
<tr>
<td><strong>Full open</strong></td>
<td>Opens the robot grippers to the robot Gripper open position set in the Labware tab.</td>
</tr>
<tr>
<td><strong>Full close</strong></td>
<td>Closes the robot grippers to the robot Gripper holding plate position set in the Labware tab.</td>
</tr>
<tr>
<td><strong>Go Home</strong></td>
<td>Moves the robot head to the home position, which is at the center of the BenchCel Microplate Handler, and the robot arms are perpendicular to the ( x )-axis. You send the robot to the home position if you want the robot out of the way in a safe position.</td>
</tr>
</tbody>
</table>
BenchCel Microplate Handler User Guide

A Quick reference
BenchCel Diagnostics - Jog/Teach tab

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home Motors</td>
<td>Sends the robot to the factory-defined home position for each axis of motion. The homing process recalibrates the robot position along each axis. Home the robot if you notice that the robot is not accurately picking up or placing plates. You might also want to home the robot after recovering from an emergency stop. If a labware definition is selected when you click Home motors, the robot grippers return to the Gripper open position defined for the selected labware.</td>
</tr>
</tbody>
</table>

Teachpoint area

<table>
<thead>
<tr>
<th>Selection or command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select teachpoint</td>
<td>Allows you to select from the list of available teachpoint files.</td>
</tr>
<tr>
<td>New teachpoint</td>
<td>Opens the Teachpoint Details dialog box. See “Teachpoint Details dialog box” on page 182.</td>
</tr>
</tbody>
</table>

Motors Enabled area

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>Enables or disables the x-axis motor. Select the check box to enable the motor. Clear the check box to disable the motor.</td>
</tr>
<tr>
<td>Z</td>
<td>Enables or disables the z-axis motor. Select the check box to enable the motor. Clear the check box to disable the motor.</td>
</tr>
<tr>
<td>Theta</td>
<td>Enables or disables the theta-axis motor. Select the check box to enable the motor. Clear the check box to disable the motor.</td>
</tr>
<tr>
<td>Enable all</td>
<td>Enables all of the robot motors simultaneously.</td>
</tr>
<tr>
<td>Disable all</td>
<td>Disables all of the robot motors simultaneously.</td>
</tr>
</tbody>
</table>
BenchCel Diagnostics - Labware tab

You can use the Labware tab to perform the following procedures:

- “Setting sensor thresholds” on page 99
- “Changing labware parameters” on page 154

The settings in the Labware tab are also available in the Labware Editor.

### Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply/Save Labware</td>
<td>Saves the updated settings in the Labware tab.</td>
</tr>
</tbody>
</table>

### Plate Dimensions area

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thickness</td>
<td>The distance (mm) from the bottom surface of the plate to the top surface of the plate. For a tip box, this is the distance from the bottom surface of the tip box to the top of the tips. To increase the number of contact points, measure the distance at the corner of the plate or tip box (using calipers). This method is especially useful if the plate has a lip at the top which could cause the caliper to angle inward, producing inaccurate measurements.</td>
</tr>
</tbody>
</table>
### Stacking thickness

The thickness (mm) of two stacked plates minus the thickness of one plate.

For example:

Thickness of two stacked plates \((x) = 23.14\) mm

Thickness of one plate = 14.14 mm

Stacking thickness: \(23.14\) mm - 14.14 mm = 9.00 mm

### Sensors area

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Orientation threshold</strong></td>
<td>The value that determines the presence of a microplate notch. A notch is present if the value is below this value. If the sensor value is above this threshold, no notch is reported.</td>
</tr>
<tr>
<td><strong>Plate presence threshold</strong></td>
<td>The value that determines if a microplate is detected. Any value equal to or greater than the threshold means a microplate is present. A lesser value means there is no microplate.</td>
</tr>
<tr>
<td><strong>Intensity (all sensors)</strong></td>
<td>The intensity of the emitting sensor light. The value is a percent of the maximum intensity. Default: 50%. Some microplates are more reflective than others. Increase the intensity if microplate sensor readings are too low (not significantly higher than the corresponding threshold value) when either a microplate is present, or a notch is absent.</td>
</tr>
</tbody>
</table>

*Note:* This setting applies to the plate-presence sensor, orientation sensor, and the rack-presence sensor.

Changing this setting affects the sensor readings of the four orientation sensors. Always adjust the intensity and threshold values together. To check the sensors and for adjustment guidelines, see "Setting sensor thresholds" on page 99.
### Plate Offsets (mm) area

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Robot gripper offset</td>
<td>The distance (mm) from the bottom of a microplate to where the robot grippers will hold the microplate.</td>
</tr>
<tr>
<td>Stacker gripper offset</td>
<td>The distance (mm) from the bottom of a microplate to where the stacker grippers will hold the microplate.</td>
</tr>
<tr>
<td>Orientation sensor offset</td>
<td>The distance (mm) from the bottom of a microplate to where the orientation sensors will check for notches. See the procedure in &quot;Determining the optimum Orientation sensor offset&quot; on page 107.</td>
</tr>
</tbody>
</table>

### Robot Gripper Positions (mm) area

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gripper open position</td>
<td>The distance (mm) the grippers move from the home position as the robot releases a microplate. A larger value moves the grippers closer together. A smaller value opens the grippers wider.</td>
</tr>
<tr>
<td>Gripper holding plate position</td>
<td>The distance (mm) that the grippers move inward from their home position when holding a microplate that is not in a stack. A larger value moves the grippers closer together and holds the microplate tighter. A smaller value opens the grippers wider. Note: How tightly the robot grippers should hold a microplate depends on the microplate material and design. You might want to run some tests to optimize the parameter.</td>
</tr>
<tr>
<td>Gripper holding stack position</td>
<td>The distance (mm) the grippers move inward from the home position when holding a microplate that is in a stack. A larger value moves the grippers closer together and holds the microplate tighter. A smaller value opens the grippers wider. Note: Because the weight of the entire stack will be on the robot grippers, you should use a value greater than the Gripper holding plate parameter.</td>
</tr>
</tbody>
</table>

### Notch Locations (mm) area

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check orientation</td>
<td>Turns on or turns off the plate-orientation sensors. Select the check box to turn on the sensors. Clear the check box to turn off the sensors.</td>
</tr>
</tbody>
</table>
### Options

<table>
<thead>
<tr>
<th>Plate check boxes</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td>Indicates that the plate A1 corner has a notch. Clear the check box if the A1 corner does not have a notch.</td>
</tr>
<tr>
<td>Upper right corner</td>
<td>Indicates that the plate upper right corner has a notch. Clear the check box if the upper right corner does not have a notch.</td>
</tr>
<tr>
<td>Lower left corner</td>
<td>Indicates that the plate lower left corner has a notch. Clear the check box if the lower left corner does not have a notch.</td>
</tr>
<tr>
<td>Lower right corner</td>
<td>Indicates that the plate lower right corner has a notch. Clear the check box if the lower right corner does not have a notch.</td>
</tr>
</tbody>
</table>

### Lidded Plate Parameters (mm) area

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can have lid?</td>
<td>The option to include a microplate lid.</td>
</tr>
<tr>
<td></td>
<td>If you select this option and plan to process lidded microplates, make sure you select the Plates have lids check box under the graphical display area.</td>
</tr>
<tr>
<td>Lidded thickness</td>
<td>The thickness (mm) of the plate with a lid in place.</td>
</tr>
<tr>
<td></td>
<td>Available only if Can have lid? is selected.</td>
</tr>
<tr>
<td>Lidded stacking thickness</td>
<td>The stacking thickness (mm) of the plate with the lid in place.</td>
</tr>
<tr>
<td></td>
<td>Available only if Can have lid? is selected.</td>
</tr>
<tr>
<td>Lid gripper offset</td>
<td>The height (mm) above the lid resting height at which to grip the lid.</td>
</tr>
<tr>
<td></td>
<td>(Shown as b below.)</td>
</tr>
</tbody>
</table>

![Diagram showing the lid gripper offset (b) and lid resting height (a)]

<p>| Lid resting height                      | The height (mm) above the bottom of the plate at which the bottom of a plate lid rests. (Shown as a below.) |
|                                        |                                                                                       |</p>
<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lid departure height</td>
<td>The height (mm) above the bottom of the plate to which the lid is lifted.</td>
</tr>
<tr>
<td>Gripper holding lid position</td>
<td>The distance (mm) the grippers move inward from home position when holding a microplate lid. Increasing the value moves the grippers closer together and holds the lid tighter. Decreasing the value opens the grippers wider. In general, type a value that is less than the Gripper holding plate position to open the grippers slightly. Holding the lid too tightly might cause the microplate to be lifted with the lid.</td>
</tr>
</tbody>
</table>
BenchCel Diagnostics - General Settings tab

You use the General Settings tab to adjust various settings. See “Changing the general settings” on page 156.

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stack Settings area</td>
<td></td>
</tr>
<tr>
<td>Rack sensor threshold</td>
<td>Any value at or higher than this means a rack is present. Below this value means there is no rack.</td>
</tr>
<tr>
<td>Low pressure threshold (psi)</td>
<td>The value at or below which the system displays a low-pressure warning.</td>
</tr>
<tr>
<td></td>
<td>Default value: 30 psi</td>
</tr>
<tr>
<td></td>
<td>Note: If this value is too low, the device could drop microplates without generating a low air-pressure warning.</td>
</tr>
<tr>
<td>Home robot after protocol run finishes</td>
<td>The option to return the robot to its home position after the protocol run is finished. This option applies to all BenchCel devices that are controlled by the same computer running the VWorks software.</td>
</tr>
<tr>
<td>Speed settings</td>
<td>The command that opens the Speed Settings dialog box, which enables you to set each speed (Slow, Medium, and Fast) as a percentage of the factory-set maximum speed.</td>
</tr>
<tr>
<td>Show current settings</td>
<td>The command that displays the parameter values that were last saved.</td>
</tr>
<tr>
<td>Write settings to file</td>
<td>The command that allows you to save the Advanced Settings information to a file.</td>
</tr>
</tbody>
</table>
You use the Profiles tab to create and initialize profiles. See “Creating profiles” on page 76. The following figure shows the main areas of in the Profiles tab.

**CAUTION**

Each profile can be used by multiple protocols. Deleting, renaming, or changing the parameters for a profile based on one protocol can invalidate other protocols that use the profile.

- Profile Management (1)
- Settings (2)
- Teachpoint File (3)
- VWorks 14.0 and later only. Log areas (4)
Profile Management area

The Profile Management area contains the following controls.

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile name list</td>
<td>Specifies the active profile. Select the profile that you want to use from the list.</td>
</tr>
<tr>
<td>Create a new profile</td>
<td>Displays the Create Profile dialog box so that you can name the new profile. To add a profile, see “Creating profiles” on page 76.</td>
</tr>
<tr>
<td>Create a copy of this profile</td>
<td>Creates a copy of the profile selected in the Profile list. The new profile name has the prefix, Copy of.</td>
</tr>
<tr>
<td>Rename this profile</td>
<td>Displays the Rename Profile dialog box so that you can rename the profile selected in the Profile list.</td>
</tr>
<tr>
<td>Delete this profile</td>
<td>Confirms the profile to be deleted, and then deletes the selected profile from the Profile list.</td>
</tr>
<tr>
<td>Update this profile</td>
<td>Saves changes to the selected profile.</td>
</tr>
<tr>
<td>Initialize this profile or Reinitialize this profile</td>
<td>Initiates communication with the BenchCel Microplate Handler using the selected profile.</td>
</tr>
</tbody>
</table>

Settings area

<table>
<thead>
<tr>
<th>Selections and commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>This BenchCel is connected via ethernet</td>
<td>Specifies an Ethernet connection for communication between the controlling computer and the device.</td>
</tr>
<tr>
<td>Device ID</td>
<td>Displays the selected device.</td>
</tr>
<tr>
<td>Find available device</td>
<td>Opens the Discovered BioNet Devices dialog box. You select the BenchCel device in the dialog box to establish communication between the controlling computer and the device. Available if you select the Ethernet connection.</td>
</tr>
<tr>
<td>This BenchCel is connected via serial</td>
<td>Specifies a serial connection for communication between the controlling computer and the device.</td>
</tr>
<tr>
<td>Serial port</td>
<td>Specifies which COM port on the computer is connected to the device.</td>
</tr>
<tr>
<td>Use flow control</td>
<td>Allows the BenchCel device to stop the flow of data from the computer before it overruns the device communication buffer. Select this option to optimize communication via the serial connection.</td>
</tr>
</tbody>
</table>
### Selections and commands

<table>
<thead>
<tr>
<th>Selections and commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of stacks</td>
<td>Enables you to create a profile for a BenchCel device that has a different number of stacks than the one connected to the controlling computer.</td>
</tr>
</tbody>
</table>

**IMPORTANT** During initialization, the software automatically detects the actual number of stacks on the BenchCel Microplate Handler. If this number differs from the number specified by the profile, an error message appears and gives you the option to Abort, Retry, or Ignore. If you click Ignore, the software overwrites the Number of stacks value with the actual number of stacks.

---

### Teachpoint file area

<table>
<thead>
<tr>
<th>Commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>...</td>
<td>Allows you to select an existing teachpoint file for the profile.</td>
</tr>
<tr>
<td>New</td>
<td>Allows you to change the teachpoint file name from the default, for example, to create a backup copy. The default teachpoint file name is Teachpoints_&lt;profilename&gt;.xml, where &lt;profilename&gt; is the name of the profile.</td>
</tr>
</tbody>
</table>

---

### Log areas (VWorks 14.0 and later versions)

VWorks 14.0 and later versions include the following log areas.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile update log</td>
<td>Lists the profile settings that have been modified since the last time the profile was updated. The software clears the table when you click Update this profile, and logs the information in the profiles activity log (text box) at the bottom of the page.</td>
</tr>
<tr>
<td>Activity log</td>
<td>Displays a running log of updates for the current diagnostics session. This activity log is recorded in the VWorks Main Log. For details on the Main Log, see the VWorks Automation Control User Guide.</td>
</tr>
</tbody>
</table>
Teachpoint Details dialog box

You can use the Teachpoint Details dialog box to enter a new teachpoint ("Determining the teachpoint coordinates" on page 86) or edit an existing teachpoint.

To open this dialog box:
Do one of the following:

• On the Jog/Teach tab, click New teachpoint.
• In the graphical display area of the Controls page, double-click the plus sign (+) for the teachpoint of interest.

<table>
<thead>
<tr>
<th>Parameter or command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A name for the teachpoint. For example, if the teachpoint is on an integrated Microplate Labeler, you might want to name the teachpoint Labeler. This name appears in the graphical display area on the Controls page.</td>
</tr>
<tr>
<td>Theta</td>
<td>The angle that the robot arms are from their home position, in degrees. A positive value moves the arms counterclockwise from the home position. A negative value moves the arms clockwise from the home position. The range of movement is from -115° to 115°.</td>
</tr>
</tbody>
</table>
A Quick reference

Teachpoint Details dialog box

<table>
<thead>
<tr>
<th>Parameter or command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>The horizontal distance (mm) from the home position. A positive value moves the robot head to the right of the home position. A negative value moves the robot head to the left of the home position. The range of movement depends on the number of stacker heads. For two stacker heads, the range is from -145 mm to 145 mm.</td>
</tr>
<tr>
<td>Z</td>
<td>The vertical distance from the home or lowest z-axis position. A positive value moves the robot head up from the home position. A negative value moves the head down from the home position. The range of movement is from -1.5 mm to 104 mm. <strong>IMPORTANT</strong> Ensure the Z value is greater than -1.5 mm. If it is not, jog the z-axis up to obtain a value that is larger. Otherwise, the software will issue a z-position out-of-bounds error if a plate with a smaller robot gripper offset is used.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use current positions</th>
<th>The command that reads the robot’s current coordinates and writes them in the Theta, X, and Z boxes.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approach height</td>
<td>The height clearance (mm) the robot maintains above the teachpoint as it moves towards or away from the teachpoint location. The valid range is from 0 mm to 40 mm. Use this setting to prevent the robot from colliding with raised tabs or walls at the teachpoint location. You can start with the approach height set to 20 mm (default). However, if there is an obstruction above the teachpoint, a smaller approach height might be required to prevent a collision. <strong>Note:</strong> This value applies when the robot is holding a microplate. When it is not holding a microplate, the robot will approach the teachpoint at the height of the teachpoint, unless you select the Respect approach height when not holding a plate option.</td>
</tr>
</tbody>
</table>
Cavity depth

This setting is not commonly used and should be set at 0 mm for most applications. You can use this setting to account for teachpoints that have a depth (or negative height). To do this, type the depth (mm) as an offset to the Robot gripper offset. A positive value causes the grippers to grab higher on the plate by the specified amount. A negative value causes the grippers to grab lower on the plate.

For example, suppose the Robot gripper offset is 5 mm and the platepad you want to use has depth of 9 mm. When the microplate sits in the platepad, the robot grippers cannot reach the offset height, as the following diagram shows. To account for this depth, you can set the Cavity depth at –9 mm. The robot grippers will grip the microplate 9 mm above the 5 mm offset (at 14 mm).

<table>
<thead>
<tr>
<th>Parameter or command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cavity depth</td>
<td>This setting is not commonly used and should be set at 0 mm for most applications. You can use this setting to account for teachpoints that have a depth (or negative height). To do this, type the depth (mm) as an offset to the Robot gripper offset. A positive value causes the grippers to grab higher on the plate by the specified amount. A negative value causes the grippers to grab lower on the plate. For example, suppose the Robot gripper offset is 5 mm and the platepad you want to use has depth of 9 mm. When the microplate sits in the platepad, the robot grippers cannot reach the offset height, as the following diagram shows. To account for this depth, you can set the Cavity depth at –9 mm. The robot grippers will grip the microplate 9 mm above the 5 mm offset (at 14 mm).</td>
</tr>
<tr>
<td>Gripper open limit</td>
<td>The maximum distance (mm) the robot grippers are allowed to open as they prepare to grip the microplate at the teachpoint. The maximum value you set is less than or equal to the Robot Gripper Open Position value set in the Labware tab. Use this setting if the teachpoint area is narrower than the robot grippers open position. (To see this value, click Save and exit, and then click the Labware tab on the Controls page.) Note: This value is used only at the teachpoint and not during other operations.</td>
</tr>
<tr>
<td>Respect approach height when not holding a plate</td>
<td>Select the check box to use the approach height even when the robot is not holding labware. <strong>CAUTION</strong> If you want to clear this check box, verify that the grippers will not run into the locating tabs of the stage. Otherwise, clearing this check box can result in a crash.</td>
</tr>
</tbody>
</table>
Something is above this point

The option to limit the robot’s movements within the robot safe zone. With this selection, the robot will only move along the theta-axis as long as all of its parts (head, arms, and grippers) are within the safe zone when approaching or moving away from the teachpoint.

Clear the check box to allow the robot to use the workspace. The robot’s theta-axis movements are not limited when approaching and moving away from the teachpoint.

Select the check box to limit the robot’s movements to prevent collision when approaching a teachpoint. For example, when moving labware to and from a multi-shelf device such as the Vertical Pipetting Station, this option prevents the robot from colliding with the shelf above the target teachpoint.
In this guide

This guide describes the BenchCel Microplate Handler R-Series models. This guide covers:

- Safety
- Installation
- Setup and operation
- Troubleshooting and maintenance.